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 مقدمه 1
 MotiveWaveپس پیش از این  هستید،این کتاب را مطالعه  در حالخوش آمدید. اگر  MotiveWave به راهنمای کاربری

را به ثبت  آنیا  را نصب نکرده MotiveWaveآماده هستید و اگر هنوز  آناید و برای استفاده از را در رایانه خود نصب نموده

 .1مطالعه فرماییداز لینک زیر دانلود نموده و افزار را اید، لطفاً پیش از مطالعه این کتاب، راهنمای نصب نرمنرسانده

http://www.MotiveWave.com/guides/MotiveWave_Installation_Guide.pdf 

 MotiveWave یها ماژولها و  نسخه 1.1
افزار را این نرم Ultimateخه کنید، پس به احتمال زیاد نسکار می MotiveWaveاگر در حال حاضر با نسخه آزمایشی 

. را در خود دارد ها Studyو  Partnerهای های ممکن، به جز ماژولها و قابلیتافزار تمامی ویژگیاین نسخه از نرم اید.نصب کرده

توانید با ایمیل زیر دارید، می MotiveWaveافزار ی خاصی از نرمل به استفاده از نسخهیکنید و تمااگر روی نسخه آزمایشی کار می

 @comMotiveWavesales.تماس بگیرید: 

 ها نسخه 1.1.1

ارائه گردیده  MotiveWaveاز  های متعددیگران بازار نسخهگران و تحلیلهای معاملهبا توجه به تفاوت نیازها و بودجه

 مورد مطالعه قرار دهید.زیر توانید در سایت افزار را میمختلف این نرمهای مربوط به نسخ . جزئیات و قابلیتاست

http://www.MotiveWave.com/products/products.htm#elliottwavesoftware 

های شما را برآورده کند. این نسخه تواند نیازای هستید، این نسخه میحرفهگر اگر معامله - Ultimateنسخه  -1

MotiveWave از جمله ابزاری مانند ی لازم را در خود داردهمه ابزار .Elliott Wave ،Gann  یاGartley. 

و  Elliott Wave ،Gannای مانند ای است که از ابزار پیشرفتهگران حرفهمختص معامله - Professionalنسخه  -2

Gartley کنند.استفاده نمی 

پشتیبانی  2استراتژی سازیو بهینه آزمون رو به عقباست که از  Tradeی نسخه گسترش یافته - Strategyنسخه  -3

 کند.می

 اضافه شده است. آنگری به های معاملهاست که قابلیت Chartی نسخه گسترش یافته - Tradeنسخه  -4

 Replay Mode ،Chartهای محبوبی مانند است و ویژگی Chartsتکمیلی ی نسخه – Charts Plusنسخه  -5

Template( مطالعات ،Studies) Multi-Time Frame اضافه شده است. آنهای دیگر به و برخی ویژگی 

ای برای ها و ابزاری پایهStudyی کاملی از ها بوده و شامل مجموعهکاراین نسخه مناسب تازه – Chartsنسخه  -6

 تحلیل است.

                                                           
سازمان  توانید از سایت فراچارت به نشانی زیر دانلود و نصب کنید. نحوه کرک کردن و نیز آموزش انتقال دادهی این نرم افزار را مینسخه کرک شده - 1

 https://farachart.com/6340بورس تهران نیز در لینک زیر موجود است. 
2 - Strategy Back Testing And Optimization 

http://www.motivewave.com/guides/MotiveWave_Installation_Guide.pdf
mailto:sales@motivewave.com
http://www.motivewavetm.com/products/products.htm#elliottwavesoftware
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 ها ماژول 1.1.2

ها در حال اضافه نمود. مجموعه ماژول MotiveWaveها به نسخ مختلف توان به منظور افزایش قابلیتها را میماژول

 MotiveWave در Developersو  Featured ،Third Party Add-Ons ،Signal Services، Educationحاضر تحت عناوین 

Marketplace توانید به نشانی زیر مراجعه کنید:ارائه شده است که برای مطالعه بیشتر در این خصوص می 

https://support.MotiveWave.com/marketplace/ 

 MotiveWaveشروع  1.2
بیابید.  Applicationsیا پوشه  Launch Padدر قسمت توانید را می MotiveWaveاست،  Macاگر سیستم عامل شما 

را روی ماشین ویندوز نصب  MotiveWaveکلیک کنید تا برنامه اجرا شود. اگر  MotiveWaveفقط لازم است روی آیکون 

فته و کلیک کنید. روش دیگر این است که به مسیر زیر ر دوبارقرار دارد  Desktopکه در  MotiveWaveاید، روی آیکون کرده

 برنامه را اجرا کنید:

Start -> All Programs -> MotiveWave -> MotiveWave.exe 

را  1کاریفضاینام دارد. به طور معمول، یک  Startupصفحه خواهید دید،  MotiveWaveاندازی صفحه نخست که در هنگام راه

 Continueخود را از لیست کشویی انتخاب کرده و روی دکمه  کاریفضایبا استفاده از ای صفحه انتخاب کرده و باز خواهید کرد. 

 کلیک کنید.

 
 MotiveWaveنرم افزار  Startupصفحه  -1-1شکل 

ورود ای که اطلاعات مربوط به پنجره با ، ممکن استکنیدمیانتخاب  خود کاریفضایکه برای  ایدادهیا سرویس  2بسته به کارگزاری

(Login) مواجه شوید. برای مثال پنجره پرسد، را میLogin  کاریفضایزیر مربوط به CQG  است. در این حالت باید نام کاربری و

 را باید وارد کنید. CQGکلمه عبور مربوط به حساب 

                                                           
1 - Workspace 

2- Broker 

https://support.motivewave.com/marketplace/
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 مجوز 1.3
شود که حاوی کلید کنید، ایمیلی برای شما ارسال میایجاد می MotiveWaveیک نسخه آزمایشی برای  ،وقتی در سایت

نصب مراجعه کنید(. کلید مجوز به طور منحصر به فرد برای پروفایل  یاست. این کلید از الزمات فرآیند نصب است )به راهنما 1مجوز

 دهید(.افزار را میشما ایجاد شده است و تغییر نخواهد کرد )حتی وقتی که سفارش خرید نرم

به نشانی  MotiveWaveتوانید درخواستی برای کلید جدید به تیم پشتیبانی کنید این کلید پیچیده است، میر میاگر فک

.comMotiveWavesupport@ اید ارسال خواهد شد.استفاده کرده آننام از ارسال کنید. این کلید به ایمیلی که هنگام ثبت 

 تغییر کلید مجوز 1.3.1

ی را انتخاب کرده و روی گزینه Optionsتوانید تغییر دهید. لیست کشویی می Startupکلید مجوز را با استفاده از صفحه 

Licence .کلیک کنید 

 
 تغییر کلید مجوز -2-1شکل 

                                                           
1 Licence key 

mailto:support@motivewave.com
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را برای اعتبار سنجی این کلید و تغیر کلید  Updateوارد کنید. دکمه  Licence Keyکلید مجوز جدید خود را در قسمت 

را از ایمیل خود کپی کرده و در قسمت  آنشود : برای اجتناب از تایپ اشتباه کلید، پیشنهاد مینکته کلیک کنید. MotiveWaveمجوز 

 مربوطه الصاق کنید.

 
 پنجره به روز رسانی مجوز -3-1شکل 

 وضعیت مجوز 1.3.2

ی را که  MotiveWaveهای ، نسخه و ماژولConsoleاز نوار منوی بالای  Help->Aboutتوانید با انتخاب به آسانی می

پشتیبانی را ضای ها و تاریخ انقکلید مجوز، آدرس ایمیل، نسخه، ماژول Aboutاید مشاهده کنید. پنجره به مجوز خود منتسب کرده

 دهد.نمایش می

 
 بررسی اطلاعات مجوز -4-1شکل 

 
 Aboutپنجره  -5-1شکل 

 



 

 

 

 

 

 

 

 

 

 

 کنسول - دومفصل 
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 کنسول 2
 1کنسولکرد،  خواهیدمشاهده  Workspaceای که با باز شدن ، نخستین پنجرهکاریفضایو پیکربندی  MotiveWaveبعد از نصب 

 از قبل پیکربندی شده است. آنفرض پیش 2کند و چیدمانفراهم می MotiveWaveهای است. کنسول دسترسی به تمامی ابزار و قابلیت

 
 کنسولفرض چیدمان پیش -1-2شکل 

و  Professionalهای (. توجه داشته باشید که صفحات فقط در نسخه1-2شکل کنسول در صفحات مختلفی سازماندهی شده است )

Ultimate  در دسترس هستند. برای مشاهده صفحات مختلف، به سادگی روی( برگهTab)  کلیک  کنسولمربوط به هر صفحه در پایین پنجره

 فرض صفحات به شرح زیر هستندکنید. مجموعه پیش

1. Home –  صفحهHome  شامل یک چیدمان ساده است که یک چارت و دو موقعیت در پایین برایWatch List. 

2. Charts –  نمودار. 6چیدمانی ساده از 

3. Account – است. ( و تاریخچه معاملاتهاآنوضعیت سفارشات )باز یا بسته بودن ها، شامل اطلاعاتی درباره حساب، سفارش 

4. Options –  کنند معاملاتی پشتیبانی می هایآپشنهایی که از ن صفحه فقط برای کارگزاریی. ا3های آپشنزنجیرهچیدمانی ساده از

 باشد.موجود می

                                                           
1 - Console 

2 - Layout 

3 Option - شیزمان از پ کیاعمال( در  ایاصابت  متیمشخص )ق متیرا با ق ییفروش دارا ای دی)نه تعهد( خر دهدیم اریاست که به مالک اخت یقرارداد فرع یآپشن نوع 

ساخته شده است. در سطح  تیوال استر شگاهیاست که در آزما یمال دهیچیبا ابزار پ یادهیبه طور معمول ا «یقرارداد فرع»انقضاء( انجام دهد. اصطلاح  خیشده )تار نییتع

بازار محافظت  یهادر نوسان ژهیخود به و یهاشنیتا درآمد کسب کنند، معاملات سوداگرانه انجام داده و از پوز دهندیدر بازار اجازه م درهایبه تر معاملات آپشن ،یفرد

 کنند.
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5. Scan – درون  نی برای استفاده از قابلیت اسکنچیدماMotiveWave باشد.می 

6. Optimize – 3های خودکاراستراتژی 2رو به جلوو آزمایش  سازیبهینه ،رو به عقبآزمایش برای  1استراتژیساز شامل قاب بهینه 

 باشد.می

7. News – ی شما از انتشار اخبار پشتیبانی کند، شما قادر به مشاهده صفحه اخبار خواهید بود.اگر کارگزار یا سرویس داده 

 :دهندفرضی از صفحات موجود در کنسول را نشان میتصاویر زیر مجموعه پیش

 
 Chartsی صفحه -2-2شکل 

                                                           
1 - Strategy optimizer panel 

2 - Walk Forward testing 

3 - Automated strategies 
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 Accountی صفحه -3-2شکل 

 
 Optionsصفحه  -4-2شکل 
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 Scanصفحه  -5-2شکل 

 
 Optimizeصفحه  -6-2شکل 



 PiroozTrader  کنسول –فصل دوم 

 

11 

 
 Newsصفحه -7-2شکل 

2.1 Preferences 
کلیک کنید(، مکانی متمرکز برای پیکربندی  کنسولرا از نوار منوی  Configure ->Preferences)روی گزینه  Preferencesپنجره 

MotiveWave سازماندهی  یمختلف 1هایها و زیربرگهبرگههای پیکربندی است که در است. این پنجره شامل بسیاری از قابرا فراهم ساخته

 .اندشده 

 
 Preferencesمشاهده پنجره  -8-2شکل 

                                                           
1 - Tabs and Sub tabs 



 PiroozTrader  کنسول –فصل دوم 

 

12 

 
 Preferencesپنجره  -9-2شکل 

 یرا بررس MotiveWave یکربندیپ یها نهیگز دیتوان یم لی، در صورت تماپنجره نیموجود در ا یهابرگهریها و زبرگه مراجعه بهبا 

 مختلف این کتاب مطالعه فرمایید. یدر قسمت ها یدتوان یرا م یکربندیخاص پ یها نهیدر مورد گز شتریب اتی. جزئرا تغییر دهید هاآنو  دیکن

 کاری فضاهای 2.2
ای نمونه کاریفضایشود. هر مدیریت می ها Workspaceیا  های داده از طریق فضاهای کاریها و سرویسارتباط میان کارگزاری

به صورت  کاریفضایبین هر  هاتحلیلها، تنظیمات و ه دادهبوده و پایگاه داده محلی مختص خود را دارد. هم MotiveWaveجداگانه از 

 (.1تاریخی هاها و دادهگیرد )به غیر از تمجداگانه ذخیره و مورد استفاده قرار می

و انتخاب  Optionsافزار، با کلیک کردن روی لیست کشویی نرم Startupیا به وسیله صفحه  کنسولتوان از طریق را می کاریفضای

Workspace .مدیریت کرد 

 
 Startupاز صفحه  Workspaceمدیریت  -10-2شکل 

                                                           
1 - Historical Data - شدن، کمترین و بیشترین قیمت است.های بازشدن، بسته ها قیمتمنظور داده پیشین است. به خصوص دادهای تیک پیشین که مهمترین آن 
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 Consoleاز طریق نوار ابزار  Workspaceمدیریت  -11-2شکل 

. حذف کنیدکاری موجود را ویرایش یا جدیدی ایجاد کرده یا فضاهای کاریفضایتوانید می Manage Workspacesدر پنجره 

 کاریفضایتوانید با استفاده از این پنجره تغییر دهید. برای ایجاد یک را نیز می Startupی مربوط به صفحه یرا در لیست کشو هاآنترتیب نمایش 

 کلیک کنید. New Workspaceجدید روی دکمه 

 
 Manage Workspacesپنجره  -12-2شکل 

 Professional/Ultimateهای  نسخه 2.2.1

 کاریفضایهای سرویس داده درون یک به بعد امکان ارتباط با چندین کارگزاری یا اتصال Ultimateو  Professional 4از نسخه 

 فراهم شده است.
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 Workspaceپنجره ایجاد  -13-2شکل 

 ،کنیداضافه  کاریفضایای را که قصد دارید به توانید کارگزاری یا سرویس داده( می14-2شکل ) Connectionبا استفاده از از پنجره 

 ای دارد که انتخاب می کنید.بستگی به کارگزاری یا سرویس داده Connectionانتخاب کنید. اطلاعات مربوط به 

 
 Add Connectionپنچره  -14-2شکل 

 .دهدرا نشان می( TradeStation, OANDA and TD Ameritradeبا سه اتصال ) کاریفضایای از پنجره زیر نمونه
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 کاریفضایسه اتصال در یک  -15-2شکل 

 Single/Brokerهای  نسخه 2.2.2

( امکان ایجاد فقط یک اتصال به یک کارگزاری یا Strategyو  Charts, Charts Plus, Trade) MotiveWaveهای در سایر نسخه

 نامی را برای دهد.ها نمایش میرا برای این نسخه کاریفضایی ایجاد پنجره 16-2شکل وجود دارد.  کاریفضایسرویس داده در داخل یک 

 انتخاب کنید. Servicesو نوع اتصال را از لیست کشویی  کردهتایپ  کاریفضای

 
 های تک کارگزاریدر نسخه کاریفضایایجاد  -16-2شکل 
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 فرض تغییر چیدمان پیش 2.3
صفحاتی را به کنسول  توانمختص خود را داشته و می توانند چیدمانچیدمان کنسول قابلیت تنظیم بالایی دارد. همه صفحات می

 دهد:های موجود را نمایش میناحیه صفحه و بعضی از گزینهتصویر زیر حذف کرد.  صفحات موجود را یااضافه کرده 

 
 Pageناحیه  -17-2شکل 

 ایجاد یک صفحه جدید 2.3.1

نامی را برای صفحه انتخاب (. 17-2شکل تصویر بالاکلیک کنید ) New Pageای جدید به کنسول، روی دکمه برای افزودن صفحه

 شود.داده می کنید روی برگه صفحه نمایشکنید. این نام، هنگامی که صفحه را به کنسول اضافه می

در بالای پنجره خود را انتخاب کنید.  نظرهای مورد متفاوتی برای صفحات وجود دارد. فقط لازم است یکی از چیدمان هایچیدمان

New Page کنید نمایش داده شده ای ایجاد میبندی وجود دارد. آیکونی مطابق با دسته روی برگه صفحه( چندین دسته18-2شکل )تصویر زیر

 کند.تر میها شناسایی نوع دسته را آساناست. این آیکون

 
 New Pageپنجره  -18-2شکل 

 صفحهتغییر یک  2.3.2

واقع در پایین سمت راست  Edit Pageوجود دارد. برای تغییر صفحه جاری روی دکمه  آنامکان تغییر نام صفحه و نیز چیدمان 

  صفحه کلیک کنید.
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 جاریتغییر نام و چیدمان صفحه  -19-2شکل 

ای با عنوان دکمه Edit Pageباز شده و امکان اعمال تغییرات ذکر شده فراهم خواهد شد. در پایین پنجره  Edit Page با این کار پنجره

Reset Layout است. با کلیک روی این دکمه تمام صفحات فرض تعبیه شده. این دکمه برای بازنشانی چیدمان کنسول به تنظیمات پیشقرار دارد

 (.1-2شکل را ایجاد کردید، تغییر خواهد یافت ) کاریفضایبه حالت اولیه خود، زمانی که برای اولین بار  هاآناز جمله چیدمان 

 
 Edit Pageصفحه  -20-2شکل 

 تغییر ترتیب صفحات 2.3.3

 را تغییر دهید. هاآنبر روی برگه صفحات، تریب  ماوستوانید صرفاً با عمل کشیدن و رها کردن در صورت تمایل می

 
 صفحاتتغییر ترتیب  -21-2شکل 
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 ها قابتغییر سایز  2.3.4

ی بین دو قاب تغییر دهید. توجه توانید با کلیک کردن و کشیدن ناحیه( نمایش داده شده در یک صفحه را میPanelهای )اندازه قاب

ی میان ناحیه دتغییر فضای عمو 22-2شکل تصویر زیر. دهدگیرد تغییر شکل میوقتی که روی این ناحیه قرار می ماوسباشید که نشانگر داشته

 دهد:را نشان می Homeدر صفحه  Watch Listنمودار و ناحیه 

 
 ها Panelتغییر اندازه دادن  -22-2شکل 

 جدیدهای  افزودن برگه 2.3.5

شکل ها کلیک کنید. در سمت راست برگه New Tab. برای این کار روی دکمه قاب موجود اضافه کرد ی بههای جدیدتوان برگهمی

. در این مثال، سه نمودار در بالای صفحه در دهندنشان میرا  Homeتوالی افزودن یک نمودار جدید به قاب اصلی موجود در صفحه  ،2-23

 شود )به رنگ سفید(.نمایش داده می 1شدهاند. نمودار فعال به صورت برگه برجستهکنار هم قرار گرفته

 
 افزودن برگه جدید به قاب جاری-23-2شکل 

                                                           
1 - highlighted tab 
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 New Chart Tabپنجره  -24-2 شکل

 
 افزوده شدبرگه جدید  -25-2 شکل

 ایجاد یک چیدمان سفارشی 2.3.6

MotiveWave گذارد. با های درون ساخت را در اختیار شما میکنید، تعدادی از چیدمانای را ایجاد یا ویرایش میهنگامی که صفحه

به هر سو سازماندهی کنید.  آنها و کشیدن ها موجود در صفحه را به شکلی که دوست دارید، با کلیک در اطراف برگهتوانید قاباین حال می

شود. وقتی در حال جابجا کردن برگه هستید، خواهید دید که یک ناحیه برجسته آبی رنگ در مکانی که قصد رها کردن قاب را دارید ایجاد می

گه نموداری را که در مرحله دهد که هر چیدمانی را به هر تعداد قاب ایجاد کنید. دو تصویر زیر جابجایی براین ویژگی به شما این امکان را می

قاب موجود به دو  عمودیجدید با تقسیم  دهد. این جابجایی موجب ایجاد یک ناحیه قاب( ایجاد کرده بودیم را نمایش میMSFTقبلی )نماد 

 شود.ناحیه می

 
 مرحله اول سفارشی سازی چیدمان -26-2 شکل
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 مرحله دوم تغییر چیدمان -27-2 شکل

 Look and Feelتغییر  2.4
MotiveWave  1به منظور تغییرLook and Feel های بسیاری ، رنگ جداول و نمودارها گزینه2دکوراسیون پنجره، چارچوب اتصال

این صفات و بسیاری از صفات دیگر استفاده کنید. این پنجره را با کلیک روی دکمه  برای تغییر Preferencesرا فراهم کرده است. از پنجره 

Preferences  در قسمت پایین سمت راست پنجره کنسول یا انتخابConfigure -> Preferences .در نوار منوی بالا باز کنید 

 
 Preferencesدکمه  -28-2 شکل

های مراجعه کنید. گزینه Dockو زیربرگه  General، به برگه Docking frameworkهای مربوط به به تغییر اولویتدر صورت تمایل 

 اشاره خواهیم کرد: هاآنگیرد. در ادامه به برخی از بسیاری در این پنجره در اختیار شما قرار می

 
 Dock Preferences -29-2 شکل

                                                           
ها مانند رنگ، شکل، چیدمان، سبک حروف و نیز های رابط کاربری دارد که شامل مواردی مانند طراحی الماناشاره به مشخصه Look and Feelدر طراحی نرم افزار،  - 1

 شود.وها و ... میها، منها، جعبه متنها مانند دکمهرفتار پویای سایر آیتم

2 - Docking framework – این قابلیت امکان سازماندهی انواع زیرپنجره( هاsubwindowsرا درون سایر پنجره )های داخلی با انعطاف کند )چارچوبها فراهم می

افزارهای کاربردی به آسانی سازماندهی کند. در حال حاضر بسیاری از نرم ها راتواند آنپذیر بوده و کاربر نهایی میبیشتر(. رابط گرافیکی کاربر در این حالت بسیار انعطاف

 کنند.از این قابلیت پشتیبانی می
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 Buy/Sellدکوراسیون پنجره و نیز رنگ نمودار، جداول و جعبه های  Look and Feelهای متعددی برای تغییر گزینه Themesبرگه 

 تغییر دهید: هاآنهای مرتبط به توانید در برگهرا می Barو  Chartدارد. تغییرات مربوط به تِم 

 
 Themeبرگه  -30-2 شکل

 دهد:ای از این تغییرات را نمایش میتصویر زیر نمونه

 
 Themeای از تغییرات نمونه -31-2 شکل

ها و اندازه آیکون General Font/Icon Sizeی تغییر دهید. با تغییر گزینه Fontsتوانید در برگه میها را ها و آیکوناندازه فونت

 بالا مفید واقع شود. وضوحنمایش با تواند در یک صفحهها تغییر خواهد یافت. این گزینه به طور ویژه میها در تمامی پنجرهفونت
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 هافونت تنظیمات -32-2 شکل

 
 هاتنظیمات آیکون -33-2 شکل

 1مالیابزار 2.5
به موجود  ابزارمالیدارند.  ابزارمالیها و غیره اشاره به ، قراردادهای آتی، شاخصFOREXارزهای سهام، جفت MotiveWaveدر 

ای مجموعه MotiveWaveدر  کاریفضایی اول بعد از ایجاد بستگی دارد. در وهله کاریفضایی انتخابی شما برای کارگزاری یا سرویس داده

اضافه  کاریفضایبه  هاآنتوانید با جستجو یا تغریف را می دیگری ابزارمالیشود. آوری میدر پایگاه داده محلی جمع ابزارمالیفرض از پیش

 کنید.

( مدیریت Configure -> Instruments) Manage Instrumentsتوانید به صورت مرکزی از طریق پنجره را می مالیابزارهایتمامی 

 کنید.

                                                           
1 - Instruments 
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 ها Instrumentمدیریت  -34-2 شکل

با  هاآندهد. امکان فیلتر نمودن تعریف شده در پایگاه داده محلی را نمایش می ابزارهای مالیهمه  Manage Instrumentsپنجره 

 توانید انتخاب کنید.مینیز را  ابزارمالیخاصی از  1صرافینوع یا وجود دارد. ( آنتایپ نماد )یا قسمتی از 

 
 .Manage Instrumentsپنجره  -35-2 شکل

: امکان نکتهبه پایگاه داده محلی اضافه کنید ) Search ،Import ،Defineهای دیگری را با کلیک روی دکمه ابزارمالیتوانید می

 های داده وجود ندارد(.ها یا سرویسبرای همه کارگزاری Importو  Defineهای دسترسی به دکمه

 داده پایگاه به توانید می که جدیدی ابزارهای کشف برایرا  داده سرویسی یا کارگزار هایقابلیت امکان جستجوی Search دکمه

 سازد.، فراهم میکنید اضافه محلی

                                                           
1 - Exchange 
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 ابزارمالیوارد کردن  2.5.1

به داخل پایگاه داده محلی وارد  CSVهای را از فایل ابزارمالیای از تا مجموعه سازدشما را قادر می Importبرای راحتی کار، دکمه 

ذخیره کنید. برای جزئیات بیشتر در این خصوص به لینک زیر مراجعه  CSVتوانید با اکسل تولید کرده و با فرمت فایل د. این فایل را میکنی

 فرمایید:
http://www.MotiveWave.com/data/import_instruments.htm 

 
 Import Instrumentsپنجره  -36-2 شکل

 معاملاتیساعات  2.5.2

Trading Hours  به  تیساعات معاملا ،ابزارمالیکند. در اکثر شود را تعریف میمعامله می ابزارمالیروزها و ساعات روز را که یک

 Trading Hoursفرض از ای پشمجموعه  MotiveWave، کاریفضایدر هنگام ایجاد  شود.شناسایی می MotiveWaveصورت خودکار در 

توانید در پنجره گری را میت معاملهایجاد و ذخیره کنید. ساعاگری مختص خود را توانید ساعت معاملهکند. با این حال میرا ایجاد می

Preferences ر زیر را بپیمایید:کار باید مسیایجاد یا تغییر دهید. برای این 

Configure -> Preferences -> General -> Trading Hours 

 
 Trading Hour Preferences -37-2 شکل

http://www.motivewave.com/data/import_instruments.htm
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 به گفتگو این در شده تعریف ساعات ،شود. اگر ارزی انتخاب شده باشدپدیدار می Trading Hoursی با کلیک روی دکمه )+( پنجره

 .گیرد می قرار استفاده مورد ابزارمالی برای فرضپیش معامله ساعات عنوان

 
 Trading Hours -38-2 شکل

Trading Hours  با مراجعه به برگه توانید را می ابزارمالیبرای یکAdvanced  در پنجرهInstrument دهید. برای دسترسی ، تغییر

یک نمودار )با کلیک راست کردن روی یک نمودار( روی  1محتوی( را طی کنید یا در منوی  Instruments-Configure <به این پنجره مسیر )

 کلیک کنید. Edit Instrumentی گزینه

 
 یک نمودار محتویدر منوی  Edit Instrument دسترسی به -39-2 شکل

                                                           
1 - Context Menu 
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 Edit Instrumentدر پنجره  Trading Hoursویرایش  -40-2 شکل

2.6 Watch List ها 
Watch List سازند. در کنار یکدیگر در یک مکان فراهم می ابزارمالیای مرتبط از ها روشی ساده برای سازماندهی مجموعه

MotiveWave  فرض از ای پیشمجموعه کاریفضایدر هنگام ساختWatch List کند.ها را ایجاد می 

 وجود دارد: Watch Listیک  نمایشدو شیوه برای 

1. Table View –  فرض را های پیشای از ستوندهد. نمای جدول مجموعهرا نمایش می ابزارمالیهر ردیف یک  نمای جدولیدر

توانید این نمای جدول را بر اساس هر بر حسب سلیقه کاربر نمایش داد یا مخفی کرد. در صورت تمایل می هاآنتوان دارد که می

 ها به ترتیب صعودی یا نزولی مرتب کنید.کدام از ستون

2. Buy/Sell View – ه باین نما جعBuy/Sell  و تقاضای جاری  دهد. مقادیر بهترین پیشنهاد عرضهنمایش می ابزارمالیرا برای هر

توان به دهد. سفارشات بازار را میرا نشان می 1اسپردو کمترین و بشترین قیمت روزانه را همراه با آخرین قیمت، آخرین بار، 

 انجام داد. Sellیا  Buyصورت مستقیم با کلیک روی نواحی 

 دهد:را نشان می Homeفرض نمایش داده شده در صفحه های پیش Watch Listتصویر زیر 

 
 فرضهای پیش Watch List -41-2 شکل

                                                           
1 Spread - شودحاصل می کمسیون و اسپرد از درآمدشون هاکارگزاری. شودمی حساب کارگزار درآمد حقیقت در که هست فروش و خرید قیمت تفاوت اسپرد. 
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 Watch Listنوار ابزار  2.6.1

 ها به شرح زیر است:. عملکرد این دکمهدکمه قرار گرفته استچندین  Watch Listدر نوار ابزار بالا سمت راست قاب 

1. Link With Chart باشد )پس زمینه سایه دار( با کلیک روی یک ردیف در  فعال: اگر این دکمهWatch List ،مرتبط با  ابزارمالی

 شود.نمودار فعال روی این صفحه، تنظیم می

2. Table/Buy Sell View نمای :Watch List های را بین دو حالت جدولی و جعبهBuy/Sell  دهد.میتغییر وضعیت 

3. Search/Add Instrument – به  آنو افزودن  ابزارمالیبرای یافتن یک  پنجره جستجو راWatch List کند.باز می 

4. Import Instruments – از یک فایل  ابزارمالیای از برای وارد کردن مجموعهCSV  روی این گزینه کلیک کنید )در همه

 کاری وجود ندارد(.فضاهای

5. Edit Watch List –  امکان ویرایش خصوصیاتWatch List سازد.را فراهم می 

6. Open in Window – Watch List کند.ی جداگانه باز میجاری را در یک پنجره 

7. Maximize -  قابWatch List آورد.را به منظور استفاده از همه فضای موجود در صفحه به حالت ماکزیمم در می 

 دهد.شده را در نوار ابزار نمایش میها تشریحتصویر زیر دکمه

 
 Watch Listنوار ابزار  -42-2 شکل

 سازی مرتب 2.6.2

های تواند در دو حال مرتب شده یا نامرتب باشد. جابجایی بین این دو حالت با کلیک روی سرستونمی Watch Listنمای جدول 

شود. کلیک دوم ترتیب را به حالت نزولی تغییر پذیر است. کلیک اول موجب مرتب سازی صعودی میامکان Watch Listدرون نمای جدولی 

 گرداند.برمی آندهد و سومین کلیک جدول را به حالت نامرتب و به وضعیت معمولی قبلی می

 نمای نامرتب 2.6.2.1

کلیک به مکان مورد نظر جابجا کرد. یا این که روی ردیف مورد نظر  هاآنرا با کلیک و کشیدن  ابزارمالیتوانید در نمادی نامرتب، می

 را تغییر دهید. هاآنمکان  Move Up/Move Downراست کرده و با استفاده از دستورات 

 
 نامرتب Watch List-43-2 شکل
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 Buy/Sellهای  جعبه 2.6.3

 ابزارمالی یک خرید یا فروش سریعِ سفارشرا نشان داده و  ابزارمالیبهترین قیمت عرضه و تقاضای جاری یک  Buy/Sellیک جعبه 

 دهد:را نشان می Buy/Sellشکل زیر عناصر یک جعبه  سازد.را ساده می

 
 Buy/Sellجعبه  -44-2 شکل

دارد(  آنتنظیمات به رنگ آبی )یا سبز که بستگی به  آنکند. اگر قیمت افزایش یابد، برچسب ها تغییر میرنگ جعبه با تغییر قیمت

توانید با مراجعه به پنجره را می Buy/Sellهای جلوه خواهد کرد. اگر قیمت کاهش یابد، برچسب به رنگ قرمز درخواهد آمد. تنظیمات جعبه

Preferences (Configure -> Preferences.تغییر دهید ) 

 

 
 Buy/Sellهای تغییر تنظیمات جعبه -45-2 شکل
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 Watch List ایجاد 2.6.4

 جدید ساخت. Watch Listتوان یک می File -> New -> New Watch Listی با کلیک روی گزینه Consoleدر نوار منوی 

 
 New Watch Listایجاد  -46-2 شکل

 تایپ کنید. Nameفیلد در  Watch Listنامی را برای نمایش ، New Watch Listی ی نخست پنجرهدر صفحه

 
 New Watch List تعیین نام -اول مرحله -47-2 شکل

 Availableرا از فهرست  هاآنها را تعیین کنید. اگر تمایل به افزودن یک یا چند ستون به فهرست دارید، ی بعدی، باید ستوندر صفحه

Columns  از کلید( انتخاب کنیدCtrl  یاCmd و برای انتقال توانید ردیفبسته به نوع سیستم عامل، می )به فهرست  هاآنهای مختلفی را انتخاب کنید

Selected Columns  را به همان ترتیب ذکر شده انتخاب کرده و  هاآنکلیک کنید. اگر بخواهید یک یا چند ستون را حذف کنید،  ’<‘روی دکمه

 کلیک کنید. ’>‘روی دکمه 
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 New Watch List هایانتخاب یا حذف ستون -مرحله دوم -48-2 شکل

تایپ کرده و برای  Choose Symbolاست. نام نماد را در قسمت  Watch List ابزارمالی برای نمایش درمرحله آخر انتخاب مجموعه 

یا این که نام نمادی را از لیست کشویی انتخاب کنید. امکان جستجوی نماد خاصی با کلیک روی دکمه  فشار دهیدرا  Enter کلیدبه لیست  آنافزودن 

Search/Add ای از نمادها را با کلیک روی دکمه توانید مجموعهمهیا است. درصورت پشتیبانی از سوی کارگزاری یا سرویس داده میImport  را

 اضافه کنید. Watch Listبه 

 
 آنو ذخیره نمودن  New Watch Listبرای  ابزارمالیانتخاب  -49-2 شکل

 Watch Listویرایش  2.6.5

باز خواهد شد. در این پنجره،  Edit Watch List، پنجره Watch List)آیکون مداد( در نوار ابزار  Edit Watch Listبا کلیک روی 

 .دادرا تغییر  ابزارمالیهای موجود یا توان نام، ستونمی
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 Configurationبرگه  - Watch Listویرایش و تغییر  -50-2 شکل

 
 Instrumentsبرگه  - Watch Listویرایش و تغییر  -51-2 شکل

را بکشید یا  هاآنتغییر دهید. روی سر ستون کلیک کرده و  Watch Listتوانید به صورت مستقم از طریق برای راحتی کار، ستونها را می

ها مورد استفاده قرار وجود دارد که برای نمایش یا مخفی نمودن ستون ’+‘به شکل  ایرا تغییر دهید. سمت راست سر ستون، دکمه آناین که ترتیب 

 گیرد.می
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 Watch Listهای ویرایش ستون -52-2 شکل

2.7 Quote Sheets 
ها تقسیم شود. بدین منظور، در هنگام تواند به زیرگروهاست که می Watch Listای به خصوص از یک نسخه Quote Sheetیک 

 انتخاب کنید.را  Quote Sheetگزینه  Watch List، در صفحه اول پنجره ایجاد Watch Listایجاد 

 Quoteی ، این نام در برگهWatch Listتایپ کنید. همانند  Quote Sheet، نامی را برای Watch List روی صفحه نخست پنجره

Sheet Panel  نمایش داده خواهد شد. گزینه“Quote Sheet”  زیر قسمتی کهName د در حالت انتخاب باشد.یکنید بارا وارد می 

 
 Quote Sheetای از نمونه -53-2 شکل

2.8 Backup/Restore 
های باز به شکل یک فایل، ها، پنجره و موقعیتها، پویش Watch List، ابزارهای مالی، هاتحلیل برای خروجی گرفتن از تنظیمات،

توانید از این فایل برای برگردان تمامی آنچه که ی شما بیافتد، میاستفاده کنید. اگر اتفاقی برای رایانه Backup/Restore ویژگیتوانید از می

 خود را به کامپیوتری دیگر منتقل کنید. کاریفضایتوانید با استفاده از این ویژگی اید استفاده کنید. یا این که میخروجی گرفته
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 فایل پشتیبانایجاد یک  2.8.1

 Backupکلیک کنید. با کلیک روی این گزینه، پنجره  1را برای ایجاد یک فایل پشتیبان  Backup-File <، گزینه کنسولدر نوار منوی 

Workspace .باز خواهد شد 

 
 Backupایجاد  منوی -54-2 شکل

 
 Backup Workspaceپنجره  -55-2 شکل

 به صورت فایلاین  اید ایجاد خواهد شد.پشتیبان در مسیری که تعیین کرده فایل، یک Createبا کلیک روی دکمه 

 <Workspace Name><Date>.zip  نام گذاری خواهد شد )به جای<Workspace Name>  شما و به جای  کاریفضاینام<Date>  نیز

 کنید. Browseسازی فایل، روی رت تمایل به تغییر مسیر ذخیرهدر صو تاریخ جاری جایگزین خواهد شد(.

را برای استفاده مجدد به کامپیوتر  آن( ذخیره کنید یا Google Driveیا  Drop Boxتوانید در یک فضای امن )مانند این فایل را می

 کنید. 2و بازگردانیدیگری منتقل 

 بازگردانی فایل پشتیبان 2.8.2

 کلیک کنید. کنسولدر نوار منوی  File -> Restoreبرای بازگردانی یک فایل پشتیبان که در قبلاً ایجاد شده است روی 

                                                           
1 - Backup 

2 - Restore 
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 فایل پشتیبان کردن Restore -56-2شکل 

 
 Restore Workspaceپنجره  -57-2شکل 

های زیر برای بازگردانی یک فایل ، فایل پشتیبانی را که در مرحله پیشین ایجاد کردید را انتخاب کنید. گزینهBrowseبا کلیک روی 

 وجود دارد:

1. Restore Console/Windows – گرداند.های باز را از فایل پشتیبان بر میچیدمان و صفحات کنسول و نیز پنجره 

2. Restore Preferences –  تنظیمات موجود در پنجرهPreferences گرداند.را بر می 

3. Restore Watch List –  همهWatch List  ها وQuote Sheet گرداند.ها را بر می 

4. Restore Scans –  گرداند.ذخیره شده در فایل پشتیبان را بر می اسکنمعیارهای 

5. Restore Strategy Analyses –  گرداند.سازی را بر میو بهینه رو به عقبآزمون اقدامات 

6. Delete Existing Analyses –  ،داشتید را حذف خواهد کرد. کاریفضایکه در  هاییهمه تحلیلاگر این گزینه را انتخاب کنید 

. بسته به دخواهد داپیشرفت وضیعت بازگردانی را نشان  نشاگرکلیک کنید. یک  Restoreبرای شروع فرایند بازگردانی روی دکمه 

 تواند بین یک تا دو دقیقه به طول بیانجامد.ی شما و اندازه فایل پشتیبان، این عملیات میرایانه

 تغییر یافته است. zipبه فایل فشرده با پسوند  5: فرمت فایل برای پشتیبان در نسخه نکته

 متفاوت کاری فضایبازگردانی به یک سرویس  2.8.2.1

شود. )یعنی کارگزاری یا سرویس داده( با سرویس موجود در فایل پشتیبان تطبیق داده می کاریفضایبه طور معمول، سرویس 

. هر ممکن است با برخی مشکلات مواجه شویدبازگردانی از فایل پشتیبانی که با یک سرویس متفاوت ایجاده شده است امکان پذیر است ولی 
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ابزارهای مالی را که در فایل پشتیبان  همه سرویس هدفکند داشته و ممکن است می سرویس نمادشناسی متفاوتی برای ابزارهای مالی که پشتبانی

 قرار دارند پشتیبانی نکند.

MotiveWave اگر  سعی خواهد کرد نمادهای سرویس فایل پشتیبان را با سرویس هدف نگاشت کند. با این حالMotiveWave 

 وجود ندارند. هاتحلیلجدید برخی  کاریفضاینتواند نگاشتی را بیابد، ممکن است متوجه شوید که در 

 1مخزن 2.9
MotiveWave کند. ین پایگاه داده دارای اطلاعات زیر است:نگهداری می کاریفضایای برای هر پایگاه داده 

 گری/پیش تنظیمات سفارشساعات معامله/مالیبازارهایمالی/ابزارهای .1

 تنظیمات/کلیدهای میانبر .2

3. Watch List /هاQuote Sheet ها 

 تاریخچه اخبار .4

 هاتحلیل  .5

 هشدارها .6

 الگوهای نمودار .7

 اسکنمعیارهای  .8

 استراتژیتحلیل   .9

 تاریخچه معاملات .10

روی سرورها  بارگذاریها برای کاهش شود. از این دادهذخیره می و روزانه 30، 5، 1 هایمیله ا درهتاریخچه داده –ها تاریخچه داده .11

 شود.و نیز دسترسی در حالت آفلاین استفاده می

فایل ذخیره کنید. اگر بخواهید یک شوند، در ، که به طور معمول در پایگاه داده محلی ذخیره میرا هاداده توانیدمی در صورت تمایل

سازی کنید یا این که به عنوان روشی جایگزین برای ایجاد می دیگری همگا( با رایانهDrop Boxیا  Google Driveها را )با استفاده از این داده

 تواند بسیار مفید باشد.های پشتیبان استفاده کنید، این کار میفایل

 اجرا کنید. مخزنجهت دسترسی به تنطیمات  Configure -> Repositoryدستور  کنسولاز نوار منوی 

 
 Repositoryتنظیمات  -58-2شکل 

                                                           
1 - Repository 
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 Repositoryپنجره  -59-2شکل 

را غیرفعال کنید. سپس نیاز خواهد بود با  Use Local Databaseسازی اطلاعات در سیستم فایل به جای پایگاه داده، گزینه برای ذخیره

 سازی این اطلاعات انتخاب کنید.مسیری را برای ذخیره Browseکلیک روی دکمه 

 ایدارید، مطمئن شوید که مکانی درون پوشه Drop Boxیا  Google Driveده از ااگر تمایل به اشتراک گذاری این اطلاعات با استف

 به اشتراک گذاشته شده را انتخاب کنید.

 های زیر در فایل ذخیره کنید:جعبهتوانید انواع اطلاعات زیر را با تیک زدن در ضمن می

1. Include Preferences –  شامل تنظیماتPreferences .و سایر تنظیمات پیکربندی است 

2. Include Watch List –  شاملWatch List  ها وQuote Sheet .ها است 

3. Include Chart Templates –  ایدتنظیم کردهکه در سیستم خود  1اتیمطالع همه الگوهایشامل. 

4. Include Windows & Layouts – شود.های پنجره باز و نیز چیدمان کنسول را شامل میاطلاعات و مکان 

5. Include Scans –  است. اسکنحاوی معیارهای 

6. Include Global Alerts – رود.این مودر برای هشدارهای قیمت به کار می 

 Drop Boxیا  Google Driveبه اشتراک گذاری با استفاده از  2.9.1

برداری ها با بهرهگذاری این اطلاعات با سایر رایانهپذیری بیشتر برای به اشتراکها درون سیستم فایل موجب انعطافذخیره سازی داده

 شود.می Drop Boxیا  Google Driveاز فضاهای ابری مانند 

                                                           
1 - Study templates 
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تواند ستم فایل محلی شما در تعامل است میشود. هر سرویس مبتنی بر ابر که با سی: این ویژگی محدود به این دو سرویس نمینکته

 گذاری سیستم فایل شما مورد استفاده قرار گیرد.برای به اشتراک

 های زیر مراجعه فرمایید:برای اطلاعات بیشتر در خصوص این دو سرویس به آدرس

1. https://www.dropbox.com 

2. https://drive.google.com 

های اشتراکی مرتبط با فایل Google Driveرفتار وجود دارد که به  Google Drive استفاده از فضای ابری در مورد مسائل: برخی نکته

 شود. برای اطلاعات بیشتر به نشانی زیر مراجعه فرمایید:می

http://www.techrepublic.com/blog/google-in-the-enterprise/steering-around-the-potholes-with-google-drive 

 ساختار پوشه 2.9.2

 نگاهی بیاندازید، دو پوشه خواهید دید: مخزنوط به اگر به پوشه ریشه مرب

1. Analysis –  را بر اساس نوع و نماد  تحلیل ی دیگر است که. این پوشه حاوی چندین زیر پوشههای تحلیلفایلشامل

 است.بندی کردهدسته ابزارمالی

2. Config – های پیکربندی است.حاوی فایل 

 است: FXCM کاریفضایبرای یک  مخزنای از ساختار شکل زیر نمونه

 
 Repositoryساختار پوشه  -60-2شکل 

https://www.dropbox.com/
https://drive.google.com/
http://www.techrepublic.com/blog/google-in-the-enterprise/steering-around-the-potholes-with-google-drive
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2.9.3 Analysis Sources 
Analysis Sources گرانی است که از ای برای به اشتراک گذاری تحلیل های معین برای دسترسی سایر تحلیلشیوهMotiveWave 

شود. برای به اشتراک گذاری و ای که در سیستم فایل محلی شما موجود است تعریف میبه وسیله پوشه Analysis sources کنند.استفاده می

 استفاده کنید. Drop Boxو  Google Driveهای ابری مانند همگام سازی نیاز است که از سرویس

Analysis source در پنجره  هاRepository تعریف می( شوندConfigure -> Repository.) 

 
 Repository – Analysis Sourcesپنجره  -61-2شکل 

گر تضادی و ا داشته باشید Analysis Sourceتوانید چندین کلیک کنید. می Addروی دکمه  Analysis Sourceبرای تعریف یک 

 .را انتخاب کنید Override Repositoryوجود دارد، گزینه  یهای انتخاب Analysis Sourceمحلی شما با  Repositoryمابین 

های  Analysis Sourceاایجاده کرده باشید و یکی از  EUR/USDبرای جفت ارز  ”Wave 3 Intraday“نام  بهبرای مثال، اگر تحلیلی 

 Overrideاهد داشت که تعیین کند کدام یک باید نمایش داده شود. اگر نیاز خو MotiveWaveداشته باشد،  EUR/USDشما همین نام را برای 

Repository  ،انتخاب شده باشدMotiveWave  محلی،  مخزنبه جایAnalysis Source .انتخابی را نمایش خواهد داد 

تواند هر آنچه که دوست به یک نام نیاز دارد. این نام می Analysis Sourceشود. هر پنجره زیر ظاهر می Addبعد از کلیک روی دکمه 

)یکی از شرکای  شده استانتخاب  ”Trading Analysis“ها باشد. در مثال زیر، نام دارید باشد، ولی بهتر است بازگو کننده منبع تحلیل

MotiveWave با کلیک روی دکمه .)Browse ای باشد که با استفاده از شه: پونکتهانتخاب کنید ) منبعای را برای پوشهGoogle Drive/Drop 

Box شود(.همگام سازی می 

منبع مورد نظر فقط قابلیت  خواهیدمیاگر  یا این که را انتخاب کنید Read Onlyصفت  ها فراهم گردد تحلیل اگر قصد دارید امکان تغییر

 را غیر فعال کنید. Read Only زینهمنبع، گبه این  تحلیل به انتشار تمایل در صورت. را از حالت انتخاب خارج کنید آنمشاهده داشته باشد 
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 Add Analysis Sourceپنجره  -62-2شکل 

 ها تحلیل انتشار 2.9.3.1

را  Read Onlyایجاد کرده و گزینه  Analysis Sourceهای خود با دیگر کاربران دارید، باید یک به اشتراک گذاری تحلیل قصداگر 

شوند و نیاز است که به صورت صریح هر شما وجود دارند به صورت خودکار به اشتراک گذاشته نمی مخزنکه در  یهایغیر فعال کنید. تحلیل

 <- File -> Save Toستور منتشر کنید، د Analysis Sourceاگر دوست دارید یک تحلیل را به یک  یل را به این منبع جدید منتشر کنید.لتح

<Analysis Source Name>  را از نوار منویChart اجرا کنید (<Analysis Source Name> است که در پنجره  ینامAdd Analysis 

Source دای¬انتخاب کرده) (در کنسول مسیرنکته :File -> Chart -> Save To -> <Analysis Source Name> .)را طی کنید 

اید ذخیره که پیش از این تعریف کرده Analysis Sourceی ای در پوشهرا )به عنوان یک کپی( در زیر پوشه تحلیل ایناین اقدام 

 خواهد کرد.

 های سایر کاربران خواهد کرد.پوشه با پوشه آنیا غیره( سعی در همگام سازی  Drop Boxافزار همگام سازی )مانند نرم

 MotiveWaveغیر فعال است تا به  Read Only. صفت شده استایجاد  My Groupبا نام  Analysis Sourceدر مثال زیر، یک 

 در دسترس خواهد بود )تصویر زیر را ببینید(. Save Toدر منوی  Analysis Sourceتواند به این مکان منتشر شود. اکنون این می آنبگوید که 

 
 My Groupتنظیمات  -63-2شکل 
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 My Groupانتشار به  -64-2شکل 

 تنظیم ایمیل 2.10
MotiveWave های تولید شده به وسیله مطالعات ها یا سیگنالهای ایمیل به عنوان بخشی از هشدارتوان برای ارسال پیامرا می

انجام دهید.  Preferences)پروتکلی برای انتقال ایمیل( را در پنجره  SMTPپیکربندی کرد. برای فعال سازی این ویژگی نیاز است تنظیمات 

 Preferencesو مشاهده پنجره  Consoleدر نوار منوی  Configure -> Preferencesو با اجرای دستور  Emailبرگه در این تنظیمات را باید 

 انجام دهید.

 
 Email Preferencesپنجره  -65-2شکل 

 را دریافت کنید. SMTPکنید نیاز است که با مدیر شبکه تماس گرفته و تنظیمات مخصوص اگر از ایمیل سازمانی استفاده می

توانید به صورت آنلاین پیدا کنید، فقط نیاز است که در وب جستجویی را انجام های ایمیل را میآدرستنظیمات مربوط به انتشار 

 دهید. بعضی از ارائه کنندگان ایمیل معروف و مفید به شرح زیر هستند:

2.10.1 Gmail 
 توانید در نشانی زیر مطالعه کنید:را می Gmailتنظیمات مربوط به 
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http://email.about.com/od/accessinggmail/f/Gmail_SMTP_Settings.htm 

انی های کاربری نیاز است کلمه عبور به خصوصی برای برنامه کاربردی ایجاد کنید. برای اطلاعات بیشتر به نشدر برخی حساب

?hl=en1173270https://support.google.com/mail/answer/ .مراجعه کنید 

2.10.2 Yahoo Mail 
 را در نشانی زیر مطالعه کنید: Yahooتنظیمات ایمیل 

http://email.about.com/od/accessingyahoomail/f/Yahoo_Mail_SMTP_Settings.htm 

اگر مجبور به تایید دو مرحله برای گذر از سیستم باشید، شاید نیاز به ایجاد کلمه عبور به خصوصی برای برنامه کاربردی  Gmailهمانند 

 لعه بیشتر به نشانی زیر مراجعه کنید:داشته باشید. برای مطا

https://help.yahoo.com/kb/yahoo-account/SLN5013.html?impressions=true 

2.10.3 Windows Live / Hotmail 
 دهد:را توضیح می Hotmailدر سرویس ایمیل  SMTPلینک زیر تنظیمات 

http://email.about.com/od/accessinghotmail/f/Windows_Live_Hotmail_SMTP_Settings.htm 

 وجود دارد. برای مطالعه بیشتر به نشانی زیر مراجعه کنید:ای نیز فرآیند اعتبارسنجی دو مرحله Hotmailبرای 

http://windows.microsoft.com/en-ca/windows/two-step-verification-faq 

 

 

http://email.about.com/od/accessinggmail/f/Gmail_SMTP_Settings.htm
https://support.google.com/mail/answer/1173270?hl=en
http://email.about.com/od/accessingyahoomail/f/Yahoo_Mail_SMTP_Settings.htm
https://help.yahoo.com/kb/yahoo-account/SLN5013.html?impressions=true
http://email.about.com/od/accessinghotmail/f/Windows_Live_Hotmail_SMTP_Settings.htm
http://windows.microsoft.com/en-ca/windows/two-step-verification-faq
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 نمودارها 3
توان به یقین اذعان مختلفی که قابلیت نمایش نمودارهای قیمت با امکانات خاص خود را دارند، می هایبرنامهدر میان 

باشد. در این بخش برخی از صول کار برخوارد میدر این زمینه  ینمودار های قابلیت ترین پیشرفته از یکی MotiveWaveداشت که 

 خواهید آموخت.را  MotiveWaveبا نمودارها در 

و به صورت مستقل با  کردههای جداگانه نمودار را باز کار کنید یا این که پنجره کنسولتوانید با نمودارها در پنجره می

بالا سمت راست قاب  Open Chart Windowترین شیوه برای باز کردن پنجره نمودار کلیک روی دکمه نمودارها کار کنید. ساده

 را اجرا کنید. File -> New -> New Chart Windowنمودار است. یا این که از نوار منو دستور 

 
 باز کردن پنجره نمودار -1-3 شکل

این عمل پنجره نمودار را مشابه با تصویر زیر باز خواهد کرد. صرف نظر از این که کدام حالت را انتخاب کرده باشید )باز کردن 

 های تشریح شده در زیر برای هر دو حالت یکسان هستند:نمودارها در کنسول یا به صورت جداگانه(، ویژگی

 
 پنجره نمودار -2-3 شکل
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 تنظیمات 3.1

 فرض نمودار های پیش تنظیمات و گزینه 3.1.1

( تغییر داد. این تنظیمات Configure -> Preferences) Preferencesتوان در پنجره فرض نمودار را میتنظیمات پیش

 قرار دارند. Chartهای ذیل برگه در برگه

 
 پنجره تنظیمات سراسری نمودار -3-3شکل 

 کنید به شرح زیر است:مشاهده می Chart Settingsهایی که در برگه عملکرد گزینه

1. Default Tool – کند.را تعیین می فرض مورد استفاده روی نمودارابزار پیش 

2. Revert to Default Tool – فرضپیش، نمودار به طور خودکار به ابزار با ابزار انتخاب شده اقدامی لیهنگام تکم 

 )به تصویر فوق نگاه کنید(.گردد  یباز م

3. Bar Type – کند.را تعیین می قیمت نمایش میله فرضپیشکنید، نوع وقتی نموداری را باز می 

4. Bar Scheme – کنند. طرح تعیین می ها راکه رنگ میله ی استهای مختلف1شامل طرحNormal  بر اساس این که

موجود  یها Bar Schemeکند. تعیین می را ها¬لهیرنگ مقیمت بسته شدن کمتر یا بیشتر از قیمت باز شدن است، 

 به شرح زیر هستند:

a. Normal – دهد.تر از قیمت باز شدن نمایش میرنگ متفاوتی را بر اساس قیمت بسته شدن بالاتر/پایین 

                                                           
1 - Scheme 
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b. Inside/Outside – کنند. اگر ها تغییر میتر از قیمت باز شدن باشد رنگنیاگر قیمت بسته شدن بالاتر/پای

یا درونی( و اگر میله یک  insideنسبت به میله قبلی داشته باشد ) lower high/higher lowمیله یک 

higher high/lower low ( نسبت به میله قبلی داشته باشدoutside .خواهد بود )یا بیرونی 

c. Day of Week – کند.براساس ایام هفته تغییر می هارنگ میله 

d. Alternate Day -  است. نسبت به روز دیگر متفاوترنگ میله هر روز 

e. Alternate Hour –  است. نسبت به ساعتی دیگر متفاوترنگ میله هر ساعت 

5. Bar Size – کند.کردن نمودار جدید تعیین میفرض میله را در هنگام باز اندازه پیش 

6. Bar Thickness – پیکسل است(. 1فرض کند )مقدار پیشتعیین می را فرض برای خط بیرونی میلهضخامت پیش 

7. Axis Style – حالت در . کندهای قیمت و زمان را مشخص میسبک محورInside به  رو محور قیمت یهادندانه

های دندانه Simpleدر حالت  .شوندمحور قیمت به سمت بیرون ترسیم میهای دندانه Outsideداخل و درحالت 

 شود.محو می خط عمودی کنار محور قیمت،

8. Shade – کند.داری بر حسب فواصل زمانی )عمودی( یا قیمتی )افقی( بر روی نمودار ترسیم میمناطق سایه 

9. Shift + Click – کلید لیست کشویی، وقتی کاربر  از ءبا انتخاب یک شیShift  را  ماوسرا نگه داشته و دکمه چپ

 شود.انتخابی روی نمودار ترسیم می شیءکند، کلیک می

10. Ctrl + Click – لیست کشویی، وقتی کاربر دکمه  از ءبا انتخاب یک شیCtrl  را  ماوسرا نگه داشته و دکمه چپ

 شود.انتخابی روی نمودار ترسیم می شیءکند، کلیک می

11. Ctrl + Alt + Click –  های از لیست کشویی، هنگامی که کاربر کلید شیءبا انتخاب یکCtrl  وAlt  را نگه داشته و

 شود.انتخابی روی نمودار ترسیم می شیءکند، را کلیک می ماوسدکمه چپ 

12. Line Method – 1ی یک گوهروش محاسباتی برای خطوط تشکیل دهنده. 

13. Fill Area – ه را پر خواهد کرد.اگر انتخاب شده باشد، ناحیه مابین یک گو 

14. Fill Alpha –  مقدارAlpha کند.برای رنگ پر شده را تعیین می 

15. Max Linear Bars – های خطی برای بارگذاری هنگام باز کردن یک نمودار.حداکثر تعداد میله 

16. Max Non Linear Bars – به طور مثال حداکثر تعداد میله( های غیر خطیRange2 ،Renko3 برای بارگذاری )و غیره

 هنگام باز کردن یک نمودار.

17. Minimum Bars – ها برای بارگذاری هنگام باز کردن یک نمودار.حداقل تعداد میله 

18. Bar Width (pixels) – کندها را مشخص میپهنای میله. 

19. Price Axis Spacing – شوند.اعدادی که روی نمودار قیمت نمایش داده میفرض میان فضای پیش 

                                                           
1 - Wedge – باشد )همانند یک مثلث همگرا(.گوه، الگوی قیمتی حاصل از همگرایی خطوط روند روی نمودار قیمت می 
 دامنه قیمت بدون در نظر گرفتن زمان تشکیل آجر.تغییر قیمت در آجر )به جای شمع یا کندل( بر اساس یک  - 2

)به جای  به طور کامل زمان را نادیده می گیرد و فقط به تغییرات قیمت تمرکز می کند. به عنوان مثال، شما می توانید مقدار آجر Renko یک نمودار - 3

بدون در نظر گرفتن زمان، آجر امتیاز یا بیشتر رخ ندهد،  10یک حرکت از  در قیمت ابزارمالی، پیپ تنظیم کنید، و بنابراین نمودار تا زمانی که 10را در کندل( 

 .جدیدی در نمودار تشکیل نخواهد شد
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20. Time Axis Spacing – شوند.هایی که روی محور زمان نمایش داده میفرض میان برچسبفضای پیش 

21. Top Inset (pixels) – بند  1فرض برای اضافه شدن به بالای پلات قیمت، هنگامی که مقیاس خودکارفضای پیش(

 فعال است.همین لیست(  18

22. Bottom Inset (pixels) – به پایین پلات قیمت هنگامی که مقیاس خودکار فعال  نفرض برای اضافه شدفضای پیش

 است.

23. Display Bars – کندها در پلات نمودار را بر حسب درصد مشخص میهنگام باز کردن نمودار میزان نمایش میله 

 ناحیه نمودار را پر کند(. %90)به طول مثال 

24. Study Height (pixels) – مانند اندیکاتور حجم یا  های مطالعهفرض برای پلاتارتفاع پیش(MACD )... و. 

25. Study Layout – افقی یا عمودی(. 2های مطالعه نمایش داده شده در ناحیه راهنماتنظیم چیدمان برای برچسب( 

26. Time Zone – فرض نمودار.زمان پیش 

27. Calendar Days – ( حفظ وزانه، فضا بری روزهای تعطیل )بدون معاملههای راگر فعال باشد، هنگام نمایش میله

 شود(.خواهد شد )به طور معمول این فضا حذف می

 قرار دارند که به شرح زیر هستند: Preferencesدر پنجره  Chartبخش  Optionسایر تنظیمات نمودار در برگه 

 
 های سراسری نمودارگزینه -4-3شکل 

                                                           
1 - Auto scale 

2- Legend area -  اندیکاتورهاست( در قسمت بالا اند )منظور همان های از نمودار شامل نام شرکت، نام نماد، مطالعاتی که به نمودار اضافه شدهمشخصه

 شوند.سمت چپ پنجره نمودار که به ترتیب وقوع آنها در نمودار نمایش داده می
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1. Show Extended Data –  ،بعد از های فرض دادهدر هنگام باز کردن یک نمودار، به طور پیشدر صورت انتخاب

 .)نمایش نمودار در حال تعدیل شده( دهدمینمایش  ساعت کار را

2. Show Instrument Title –  شود.ی بالا سمت چپ نمودار نمایش داده میدر گوشه ابزارمالیعنوان 

3. Snap Open/Close –  به طور خودکار به نقاط حاصل از  ماوساگر فعال باشد ابزارOpen  وClose های قیمت میله

 چسبد.می

4. Show Components Panel – ،دهد.را نمایش می 1هاابزارقاب  فرضبه طور پیش در هنگام باز کردن نمودار جدید 

5. Trade PanelShow  – دهد.را نمایش می 2معاملهقاب  ضفر¬شیبه طور پ، در هنگام باز کردن یک نمودار جدید 

6. Show DOM Panel – دهدرا نمایش می 3فرض قاب عمق بازارکنید به طور پیشوقتی نمودار جدیدی باز می. 

7. Show Grid – دهد.خطوط افقی و عمودی را روی نمودار نمایش می 

8. Show Major Times – دهد.اصلی در نمودار نشان می هایزمان بر رویرا دار خطوط چین 

9. Show Chart Buttons –در  .دهدمینمایش  عمودی و پهنای میلهرا روی نمودار جهت تنظیم فضای هایی دکمه

 رود.های مطالعه به کار میضمن جهت حذف دکمه مطالعه روی پلات

10. Show P/L Ladder - دهدینمودار نشان مروی محور قیمتِ را در  انینردبان سود/ز. 

11. Show Exchange –  روی نمودار. ابزارمالیی از عنوان به عنوان بخش )صرافی( بازارنمایش یا عدم نمایش نام 

12. Show Symbol –  را روی نمودار نمایش دهید. ابزارمالینماد 

13. Show Bar Size – را روی نمودار نمایش دهید. (5)بازه زمانی جاری 4میله هانداز 

14. Show Cross Hair - ماوسنشانگر  به مرکزیت 6متقاطع وطخط نمایش یا عدم نمایش. 

15. Global Cross Hair – ابزارمالیکه  یمتقاطع )که فعال شده است( در چندین نمودار وطدر صورت فعال بودن، خط 

 حرکت خواهند کرد. ماوسبه طور همزمان مشاهده خواهد شد و با حرکت دهند نمایش می در کنار هم ای رامشابه

16. Double Cross Hair – قرار  آنروی  ماوسای است که نشانگر دهد که شامل میلهدو خط عمودی را نمایش می

 دارد )به جای یک تک خط عمودی(.

17. Solid Cross Hair – خطوط ممتد  شکلرا به  هاآن ،به جای نمایش خطوط متقاطع به صورت خط چین روی نمودار

 دهد.می شنمای

18. Auto Scale –  کنیدباز می یوقتی نمودار جدید نمودار فرض مقیاسپیشتنظیمات. 

19. Auto Scale Price Only – شود )به تو رفتگی بالا و پایین نمودار قیمت به صورت خودکار تعیین میScaling  در

Chart settings .)مراجعه کنید 

                                                           
1  - Components panel 

2 - Trade panel 

3 - DOM (Depth of Market) panel 

 منظور بازه زمانی جاری نمودار است. - 4

5 - Time Frame 

6 - Cross hair 
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20. Semi-Log Scale – فرض نمودار در مقیاس نیمه لگاریتمی.نمایش پیش 

21. Lock Scroll – فرض قفل پیمایش )به حالت پیشLock Scroll  قفل کردن نوار پیمایشبا عنوان  3.25بخش در 

 مراجعه کنید(.

22. Lock Studies – فرض قفل مطالعات )به حالت پیشLock Studies  مطالعات کردن قفلبا عنوان  3.24در بخش 

 مراجعه کنید(.

23. Show Info on Select –  ابزارنمایش اطلاعات ویژگی، در هنگام انتخاب یک. 

24. Show Info –  جدید. ابزارنمایش ویژگی در هنگام ایجاد یک 

25. Show Range Outline – های میله ی بعدیِرا روی میله 1خط پیرامونیRange/Renko کند.فعال می 

26. Show Middle Line - ابزار کانال نمایش خط میانی در. 

27. Show Menu Bar – .نمایش نوار منو در پنجره 

28. Show Tool Bar –  نوار ابزار در پنجره.نمایش 

29. Show Status Bar – .نمایش نوار وضعیت در پایین پنجره 

30. Confirm on Close – در هنگام بستن پنجره نمودار. نمایش پیغام هشدار 

31. Link Minimize/Restore – های لینک شده در اگر این گزینه فعال باشد، با کمینه کردن یک پنجره، تمامی پنجره

های داخل گروه نیز به به حالت بیشینه درآید، همه پنجره هاآنشوند و برعکس وقتی یکی از نیز کمینه مییک گروه 

 .دنآیحالت بیشنه در می

32. Expand Status Bar Link – ی کنترل لینک رنگی در نوار وضعیت.حالت توسعه یافته 

33. Show Bar Size Selector – گر انداز میله روی نمودار.فرض انتخابنمایش پیش 

34. Show Bird’s Eye View – فرض نمای چشم پرنده هنگام باز کردن نمودار.ش پیشینما 

35. Show Bird’s Eye Lines – ی روی پلات چشم پرنده.خطوط عمود شنمای 

36. Show Properties on Double Click – باز  شیء آنها، پنجره خصوصیات با دوبار کلیک روی ابزار یا مولفه

 شود.می

37. Resolve Trend Lines –  ،اگر فعال شودMotiveWave  تمام  که ی کندتا حدی بارگذار را هاداده خواهد کردسعی

نقطه شروع خط روند فرض، به طور پیش MotiveWave خطوط روند در یک نمودار به درستی نمایش داده شوند.

ها را با برگشت به عقب و جهت بهبود دقت پلات، همه داده ،گزینهکند. این های موجود برآورد میرا بر اساس داده

: این گزینه باعث بارگذاری حجم زیادی هشدار یابد. ایشافز دقت پلات کند تابارگذاری میبه ابتدای خطوط روند 

 تمایلشود این گزینه را غیر فعال بماند و در صورت شود. پیشنهاد میمیدر رایانه داده از کارگزاری یا سرویس داده 

 کنید(. مطالعهکنید )بخش بعدی را  را در تنظیمات نمودار فعال آن

38. Group Studies – های جداگانه به صورت برگههای مطالعه در کنار یکدیگر در پایین نمودار اگر فعال باشد، پلات

 یابد.در کنار هم قرار گرفته و فضای اشغالی روی پنجره نمودار کاهش می

                                                           
1 - Outline 
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39. Show Study Labels – در راهنما نمودار.های مطالعه نمایش برچسب 

40. Study Bar Updates –  در صورت فعال بودن این گزینه، مطالعات درج شده در نمودار، با هر بار تغییر در قیمت

فعال باشد، زیرا باعث افزایش بار محاسباتی شود این گزینه غیرد کرد. پیشنهاد مینتغییر خواهبسته شدن یک نماد، 

 .شودمیافزارنرم

41. Study Dock Long Name – ای مطالعه در پایین نمودار به صورت کامل مشاهده هدر صورت فعال بودن، نام برگه

 .)فضای بیشتری اشغال خواهد شد( خواهد شد

42. Use Account Position- به  هااستراتژیمربوط به در تنظیمات  آنی معادل در صورت فعال بودن این گزینه، گزینه

 فرض فعال خواهد شد.صورت پیش

43. Show Values in Legend-  ،مقادیر مطالعه اخیر کنار برچسب مطالعه در راهنمای مطالعه نمایش داده اگر فعال باشد

 شود.می

44. Simple Study Title – ی عنوان در ناحیه راهنما.شدهنمایش ساده 

45. Overlay Volume –دهد.نمایش می نمودار درون و زیرجداگانه، در  اطلاعات حجم را به جای یک پلات 

46. Draw Candle Outline – کند.های شمع را ترسیم مینی مستطیلخط پیرامو 

 تنظیمات نموداری خاص 3.1.2

نمودار که فقط در نمودار انتخاب  ماتیتوان به تنظیم Chart Settingsدستور نمودار و انتخاب  یرو راست کیبا کل

توان تنظیمات پیکربندی شده در این حالت را می .یا این که روی نمودار دوبار کلیک کنید کرد دایپ یشود ، دسترس یشده اعمال م

توانید در بخش قبلی زیر را می هایگزینهفرض ذخیره نمود. تشریح به عنوان تنظیمات پیش Save Defaultsبا کلیک روی دکمه 

 مطالعه کنید.

 
 Chart Settingsپنجره  -5-3شکل 
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 اندیکاتورهای قیمت 3.2

دهند. نمایش میو غیره را روی محور قیمت  قیمت ، بیشترینقیمت جاری، کمترین های قیمت، قیمتاندیکاتور

MotiveWave در صورت ) روزانه راقیمت آخرین قیمت، بهترین عرضه، بهترین تقاضا، بیشترین و کمترین  ،فرضبه طور پیش

محور عمودی  را روی Moving Averageمانند اندیکاتورها  توان اطلاعات سایرمیدر صورت تمایل  دهد.نمایش می (وجود

دوبار  آنبه نمایش درآّید فقط لازم است روی کند، همراه با اندیکاتور حرکت میکه خواهید یک خط عمودی نمایش داد. اگر می

 شود(.کلیک کنید )این اقدام منجر به نمایش یا عدم نمایش خط عمودی می

 
 Price Indicators -6-3ل شک

 تغییر دهید. Preferences -> Chart -> Indicatorsتوانید در قسمت اندیکاتورهای قیمت را می

 
 Price Indicatorتنظیمات  -7-3شکل 
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 فضای نمودار 3.3
برای کشیدن  ماوسترین شیوه استفاده از گزینه برای تنظیم فضای افقی و عمودی روی نمودار وجود دارد. سادهچندین 

: به منظور تنظیم فضای عمودی، نیاز است روی فضای مابین نکتهمحور زمان )فضای افقی( یا محور قیمت )فضای عمودی( است. 

 را بکشید )به تصویر زیر نگاه کنید(. آنهای قیمت و ناحیه نمودار کلیک کرده و برچسب

 
 فضای نمودار -8-3شکل 

 اندازه میله 3.4
چندین نوع  MotiveWaveمفید هستند. نمودار براساس زمان، قیمت یا حجم حرکات  حهای میله برای تغییر وضواندازه

 کند:ها را پشتبانی میمختلف از میله

1. Linear  )و غیره(. هفته-2روز،  1، دقیقه-15دقیقه،  1ها )مانند فاصله زمانی براساس میله –)خطی 

2. Range  )شوند.میله براساس میزان حرکت قیمت در یک محدوده خاص ترسیم می –)دامنه 

3. Renko/Hybrid Renko /باشند.ها مینوعی محدوده قیمت بر اساس میله –رنکو ترکیبی(  )رنکو 

4. Tick  )شوند.های قیمت )یا معامله( ترسیم میها براساس تعداد خاصی از تیکاین نوع میله –)تیک 

5. Volume  )کنند.ها حجم معینی را بازگو میاز این میله یک هر –)حجم 

6. Point & Figure )نقطه و شکل( 

در پایین  Bar Size Selectorاز ها وجود دارد. شاید راحترین روش استفاده چندین روش برای تغییر اندازه و نوع میله

توانید اندازه میله را از لیست کشویی موجود در نوار ابزار انتخاب کنید یا با راست کلیک روی نمودار و نمودار است. یا این که می

 را تغییر دهید. آندر منوی آبشاری باز شده،  Bar Sizeانتخاب 
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 انتخاب اندازه میله -9-3شکل 

 های میله سفارشی کردن اندازه 3.4.1

مراجعه  Configure -> Preferencesها را براساس نیاز خود تغییر دهید )به توانید اندازه میلهمی MotiveWaveدر 

 .دیکن جادیا ایلحظه یها لهیم دیتوان یم ،دیداشته باش یدسترس کیت تاریخی یبه داده هابتوانید  نکهیمشروط بر اکنید(. 

 
 میله یسفارشی نمودن اندازه -10-3شکل 
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3.4.2 Bar Size Selector 
Bar Size Selector های معمول میله است. به این منظور فقط لازم است روی یکی روشی آسان برای دسترسی به اندازه

برای فعال یا فرض روی تمامی نمودارها قابل مشاهده است. به طور پیش Bar Size Selectorهای پایین نمودارکلیک کنید. از زبانه

فرض را : رفتار پیشنکتهمراجعه کنید. ) نوار منوی بالادر  View -> Display -> Bar Size Selectorدستور  به آنغیر فعال کردن 

 Preferencesی در پنجره Chartی مربوط به زبانه Optionsی ، در برگهShow Bar Size Selectorی توانید با مراجعه به گزینهمی

 تغییر دهید(.

تغییر  Configureها و انتخاب از برگه یتوانید با کلیک راست روی یکرا می Bar Size Selectorهای موجود در برگه

 باشید.داشته Volume(500)یا مقدار ثابت  Range(3)توانید برای مثال میتوانید قرار دهید. ای را میدهید. هر نوع اندازه

 
 Bar Size Selectorپیکربندی  -11-3شکل 

 
 Bar Size Selectorی دیگر پیکربندی شیوه -12-3شکل 

این  ( کهPreferences)قابل پیکربندی از طریق  خود داردهایی در سمت راست دکمه Bar Size Selectorدر ضمن 

 کنند:ها، به ترتیب از سمت چپ به راست، موارد زیر را تسهیل میدکمه

1. Semi-Log Scale – .فعال یا غیر فعال نمودن مقیاس نیمه لگاریتمی 

2. Study Template-  کند.مطالعه را فراهم می الگویامکان انتخاب 
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3. Birds Eye View – کند.نمایش نمای چشم پرنده را فعال یا غیرفعال می 

4. Time Frame –  کند.را فراهم می بازه زمانیامکان تغییر 

5. Go to Date – سازد.پرش به یک تاریخ خاص را ممکن می 

 
 Bar Size Selectorهای دکمه -13-3شکل 

 1ها وارد کردن داده 3.5
- File) کرد MotiveWaveوارد  بالا یدر نوار منو File -> Import Dataتوان با اجرای دستور های تاریخی را میداده

> Chart -> Import Data شود:واقع در نوار منوی کنسول(. دو نوع فرمت داده پشتیبانی می 

1. CSV (Comma Separated Values )–تاریخی های دادهدر میان سرویسها یکی از عمومی ترین فرمت فایل CSV 

 شود.هایی از این نوع، فرمت فایل داده به طور خودکار شناسایی میهنگام تعیین فایل باشد.می

2. MetaStock™ Database – یخی تار به پایگاه داده هاآنرمالی است که امکان وارد کردن حاوی یک یاچند ابزا

MotiveWave .وجود دارد 

                                                           
1 - Importing Data 
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 Import Dataپنجره  -14-3شکل 

 های زیر است:کنید دارای مشخصهای که در تصویر بالا مشاهده میپنجره

1. Data Files –  یک یا چند فایل داده را با کلیک روی دکمهAdd  فهرستدر سمت چپ Data Files .تعیین کنید 

2. Time Zone –  کند. به توجه به این که لازم است مقادیر میناحیه زمانی را برای فایل ورودی مشخصData/Time 

 باشد.عنصر با اهمیت می ایندر فایل ورودی مشخص باشند، لذا تنظیم تاریخی  ی قیمتبرای هر میله

3. Exchange – تعیین کنید. را ( ورودییها)فایل در  ابزارمالیمورد نظر برای  بازارمالیل یدر صورت تما 

4. Trading Hours-  اگر مقداری برایTrading Hours  ،هنگام ایجاد از طریق این پنجره، به  ،مقدار آنانتخاب شود

 منتسب خواهد شد. ابزارمالی

5. Adjust for Stock Splits – را کشف کرده و  هاآنی تقسیمی نباشد، این قابلیت مقادیر تنظیم شده یاگر فایل حاو

 برای این تقسیمات را تنظیم خواهد کرد. های تاریخیقیمت

6. Automatically Create Instrument (Do Not Prompt) –  اگر ابزارمالی از قبل در پایگاه داده محلی موجود

 ، ابزارمالی به طور خودکار ساخته خواهد شد.یدنباشد و این گزینه را انتخاب کن

7. Replace Existing Data – کند.اند را جایگزین میوجود داشته تاریخیهایی که قبلاً در پایگاه داده داده 

8. Monitor Input File For Changes –  ،در صورت انتخاب این گزینهMotiveWave را در فایل ورودی  1زمانمهر

در  MotiveWave، مهرزمان در همان فایل . در صورت تغییردر آینده شود آنتا متوجه تغییر کند می و ثبت کنترل

                                                           
1 Timestamp- شود، که باشد که در هنگام وقوع یک رویداد مشخص تعیین و ثبت میمهرزمان یک توالی از کاراکترها یا اطلاعات رمزگذاری شده می

 دقیق ایجاد یا تغییر یک فایل. ها یا ثبت زمانهای رسیده یا صادره در شرکتباشد. مانند ثبت تاریخ در نامهشامل تاریخ و زمان وقوع حادثه می معمولاً
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برای این کار فقط لازم  .کردد بارگذاری خواهبه طور خودکار  را های جدیدداده ،نمودار مجدد همان هنگام بارگذاری

 دیگری کلیک کرده و دوباره به روی نمودار باز گردید. بازه زمانیروی  Bar Size Selectorاست در نوار 

 1ها صادر کردن داده 3.6
 را در چندین فرمت مختلف خروجی بگیرید. تاریخی )پیشین(های این امکان فراهم است که داده MotiveWaveدر 

زیر باز خواهد  هایای با مشخصهرا انتخاب کنید. با این کار پنجره File -> Chart -> Export Dataبرای این کار از نوار منوی بالا 

 شد:

1. Symbol – در این قسمت نام ابزارمالی را  فرضپیشدر این قسمت ابزارمالی مودر نظر خود را انتخاب کنید. به طور

 باز است. آنخواهید دید که در حال حاضر نمودار 

2. Bar Size – انتخاب کنید. تاریخیهای اندازه میله را برای داده 

3. Bar Count – هادارید مشخص کنید. برای صادر نمودن تمامی میله را هاآنهایی را که قصد صادر کردن تعداد میله 

 را انتخاب کنید. All Availableی ، گزینهدر پایگاه داده تاریخی

4. Regular Trading Hours (RTH) Data – هایی خواهد بود های خروجی فقط شامل میلهبا انتخاب این گزینه، داده

 های معاملات معمول هستند.که جزئی از نشست

5. Data File – سازی فایل را مشخص کنید.مسیر ذخیره 

6. Export chart data including study values – ها به همراه مقادیر مربوط به مطالعات خروجی گرفتن از داده

 انجام گرفته روی نمودار.

7. Format – :فرمت فایل خروجی را انتخاب کنید که شامل موارد زیر است 

  CSV – yyyyMMdd HHmmss,O,H,L,C,V .أ

  CSV – dd/MM/yyyy HH:mm:ss,O,H,L,C,V .ب

  Ninja Trader – Start Of Bar Time .ت

 Ninja Trader – End Of Bar Time .ث

 
 Export Dataپنجره  -15-3شکل 

                                                           
1 - Exporting Data 
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 نمای چشم پرنده 3.7
آورد. برای فعال سازی این های تاریخی فراهم میی تصویری بزگتر از دادهمشاهده نمای چشم پرنده روشی مناسب برای

 را از نوار منوی بالا کلیک کنید. View -> Display -> Bird’s Eye Viewی ویژگی گزینه

Bird’s Eye View که در حال هایی را آید. ناحیه برجسته شده )منطقه زرد شفاف( دادهدر پایین نمودار به نمایش در می

را به چپ یا راست جابجا کنید  آنتوانید روی این ناحیه کلیک کرده و می دهد.نمایش می را دنشوحاضر روی نمودار مشاهده می

های روی نمودار بستگی دارد. را در ناحیه نمودار مشاهده کنید. عرض منطقه برجسته شده به عرض میله آنهای متناظر با و داده

 را به چپ یا راست بکشید. آنرض را تغییر دهید، روی محوز زمان کلیک کرده و خواهید عاگر می

 
 نمای چشم پرنده -16-3شکل 

 ماوسهای نشانگر  داده 3.8
اشاره دارد. چندین روش برای  ماوسدر موقعیت کنونی نشانگر  هاآنها و مقادیر به نقاط داده 1ماوسهای نشانگر داده

 وجود دارد: ماوسهای نشانگر مشاهده داده

 ماوسهای نشانگر  پنجره داده 3.8.1

Cursor Data Window  دهد. این پنجره در ها را نمایش میداده ماوسیک پنجره جداگانه است که در مکان فعلی

ای از نوار منوی بالا باز کرد. بر View -> Display -> Cursor Dataتوان با انتخاب کند. این پنجره را میسرتاسر نمودارها کار می

 شود.ها نمایش داده میسایر پنجرهراحتی کار این پنجره همیشه روی 

                                                           
1 - Cursor Data 
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 Cursor Dataپنجره  -17-3شکل 

 1نوار وضعیت 3.8.2

ی ها منعکس کنندهنوار وضعیت در پایین پنجره مشاهده کرد. این دادهتوان در مربوط به یک میله قیمت را می یهاداده

 د.نباشمی ماوسمشخصات میله قیمت در موقعیت کنونی نشانگر 

 
 نوار وضعیت -18-3شکل 

                                                           
1 - Bar Status 
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 1پنجره شناور 3.8.3

 2میله به مدت  آنرا روی یک میله قیمت قرار دهید یک پنجره شناور همراه با اطلاعاتی در خصوص  ماوساگر نشانگر 

 ثانیه به نمایش در خواهد آمد.

 
 پنجره شناور روی میله قیمت -19-3شکل 

 2خطوط متقاطع 3.8.4

برای نمایان ساختن مقادیر  ماوسویژگی خطوط متقاطع باعث ترسیم خطوط عمودی و افقی در مکان کنونی نشانگر 

 شود.محور عمودی )قیمت( و محور افقی )زمان( می

 
 خطوط متقاطع -20-3شکل 

                                                           
1 - Hover Popup 

2 - Cross Hair 
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 <- Configure برگه باید به آناطع وجود دارند. برای تنظیم های مختلفی برای پیکربندی این خطوط متقگزینه

Preferences -> Chart ->Options  .مراجعه کنید 

 
 تنظیمات خطوط متقاطع -21-3شکل 

 1خطوط متقاطع سراسری 3.8.4.1

Global Cross Hair  ابزارمالیمیان چندین نمودار مختلف است که  ماوسروشی مناسب برای تعیین موقعیت نشانگر 

فعال کنید )به بخش قبلی مراجعه کنید(. در تصویر  Preferencesی توانید در پنجرهرا می دهند. این گزینهیکسانی را نمایش می

 ابزارمالیدار دیگر همان روی نمودار اول توجه داشته باشید. شما همان موقعیت را در سه نمو ماوسزیر به موقعیت کنونی نشانگر 

 کنید.های قیمت( مشاهده میهای مختلف میله)یا اندازه بازه زمانی( در Google)در اینجا 

                                                           
1 - Global Cross Hair 
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 خطوط متقاطع سراسری -22-3شکل 

 1ها زمان و فروش 3.9
های موجود در این قاب ها و ستوندهد. دادهانتخابی نمایش می ابزارمالیرا برای  تاریخیهای تیک Time & Salesقاب 

را  e-Mini S&Pمربوط به قرارداد  Time & Salesی انتخاب شما بستگی دارد. مثال زیر قاب به نوع کارگزاری و سرویس داده

 دهد:می شنمای

 
 Time & Salesقاب  -23-3شکل 

                                                           
1 - Time & Sales 



 PiroozTrader  نمودارها –فصل سوم 

 

62 

توانید از نوار منوی برای فعالسازی نمایش این قاب تعبیه شده است یا این که می ای در نوار ابزاربرای سادگی کار، دکمه

 کلیک کنید. View -> Display -> Time & Sales Panelبالا روی 

 قاب عمق بازار 3.10
 Display -View <- <دهد. برای نمایش این قاب به جدولی از مقادیر عرضه و تقاضا نمایش می یا 1قاب عمق بازار

DOM Panel  ای برای نمایش یا عدم نمایش این قاب در نوار ابزار تعبیه شده نید. برای راحتی کار دکمهکدر نوار ابزار بالا مراجعه

 مراجعه کنید. (DOMعمق بازار )با عنوان  4.6 است. برای مطالعه بیشتر در خصوص نحوه استفاده از قاب عمق بازار به بخش

 
 قاب عمق بازار -24-3شکل 

 2های نمودار برچسب 3.11
گوشه نمودار  4در هر  توانمی را هادهد. این برچسبنمودار را نمایش می Price Plotهای نمودار اطلاعات برچسب

 دهد:های نمودار را نمایش می. مثال زیر برخی از برچسبنمایش داد

                                                           
1 - Depth Of Market (DOM) Panel 

2 - Chart Labels 
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 های نموداربرچسب -25-3شکل 

)با دوبار کلیک کردن روی نمودار(  Chart Settingsتوانید از پنجره ده روی نمودار را میشهای نمایش داده برچسب

 قرار دارد: Labelsی ها در برگهپیکربندی نمود. مشخصات برچسب

 
 تنظیمات برچسب نمودار-26-3شکل 
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و کلیک روی  اهآنهای موجود در فهرست سمت راست )یا انتخاب یکی از با دوبار کلیک کردن روی یکی از برچسب

توانید توانید مشخصات برچسب را تغییر دهید )تصویر بالا(. از پنجره ظاهر شده، میویرایش که به شکل یک مداد است( میدکمه 

. ترتیب نمایش تغییر دهیدرا  آنهای ای را که قصد نمایش برچسب دارید انتخاب کرده و رنگ، فونت و سایر مشخصهگوشه

 یابد.تغییر می Chart Settingsهای بالا/پایین در پنجره لشاز فِها با استفاده برچسب

 اخبار 3.12
شوید از انتشار اخبار مربوط به ابزارمالی پشتبیانی کند، مقالات خبری متصل می آنای که به اگر کارگزاری یا سرویس داده

 <- Viewکار روی مودار نمایش داد. برای اینن در قابی زیر News Headlinesتوان با استفاده از قاب خاص این ابزارمالی را می

Display -> News Headlines .واقع در نوار منوی بالا کلیک کنید 

 
 خبری عناوینقاب نمایش  -27-3شکل 

داخلی به نمایش درخواهد  1در ناظر اخبار فرضپیشاگر روی عنوانی در قاب عناوین خبری کلیک کنید، مقاله جدید به طور 

های خبری را در مروگر توانید مقالهمی، کنید را انتخاب Show In Browserی کرده و گزینه اگر روی عنوان خبری کلیک راست آمد.

 وب مشاهده نمایید.

                                                           
1 - News Viewer 
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 نمایش مقاله خبری -28-3شکل 

 باشد.مرورگر اخبار می درتصویر زیر مثالی از نمایش یک مقاله خبری جدید 

 
 ناظر اخبار -29-3شکل 

3.13 Watermark 
و یا توضیحات  ابزارمالیامکان نمایش برچسب نیمه شفاف همراه با نماد  Watermarkویژگی  MotiveWaveدر 

توانید با مراجعه به پنجره را می Watermarkتوانید مکان و فونت این برچسب را تعیین کنید. کند. همچنین میمربوطه را فراهم می

Chart Settings  و برگهWatermark .پیکربندی کنید 



 PiroozTrader  نمودارها –فصل سوم 

 

66 

 
 Watermarkتنظیمات  -30-3شکل 

 دهد:را نشان می Microsoftمربوط به سهام شرکت  Watermarkتصویر زیر توضیحات 

 
 Watermarkنمونه از قابلیت  -31-3شکل 
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 گذاری مقایس 3.14
فرض، دامنه قیمت شگذاری برای دامنه قیمت/زمان در پلات قیمت وجود دارد. به طور پیی مختلف مقیاسچندین گزینه

گذاری موجود به شرح زیر های مقیاسگزینه شود.گذاری میها و اجزای قابل رویت مقیاسنمودار به طور خودکار براساس داده

 هستند:

1. Auto Scale – توان دامنه شوند )در صورت تمایل فقط میها و ابزار قابل رویت تنظیم میدامنه قیمت مطابق با داده

 را قفل خواهد کرد. نمودارها را در نظر گرفت(. این گزینه حرکت عمودی داده

2. Price Range –  این گزینه دامنه قیمت را ثابت در نظر گرفته و شما قادر خواهید بود نمودار را به صورت دستی به

 سمت بالا و پایین جابجا کنید.

3. Square – کند. اگر عرض میله بسط یابد )یا تنظیم می را این گزینه تعداد معینی از نقاط به ازای هر عرض میله

 .خواهد شدرسانی روزبه آنمنقبض شود(، دامنه قیمت برای انعکاس 

 بیابید. Chart Settingsدر پنجره  Scalingی توانید در برگهگذاری را میهای مقیاسگزینه

 
 گذاریهای مقیاسگزینه -32-3شکل 

 تحلیل  3.15
MotiveWave  از عبارتAnalysis دهید ( برای اقداماتی که شما برای تجلیل حرکت قیمت روی نمودار انجام می)تحلیل

 شامل انواع مختلفی از اطلاعات به شرح زیر است: تحلیل کند. یکاستفاده می

کنید، شامل خطوط روند، امواج الیوت، ابزارهای گن، الگوهای گارتلی، ای که به نمودار اضافه میهر مؤلفه –1هامولفه .1

 تفسیر و غیره.

 اید.ای که به نمودار اضافه کردههر مطالعه – 2مطالعات .2

 کنید.ابزار راهنمایی که به محورهای افقی و عمودی اضافه می - 3راهنماهای زمان/قیمت .3

                                                           
1 - Components 

2  - Studies 

3 - Time/Price Guides 
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این موضوع  تحلیل است.ای از نمودار هستند. نمودار یک نما یا یک فایل ها موجودیت جداگانهتحلیلبدانید  مهم است که

برآن بنا شده است. شاید این مفهوم در ابتدا  MotiveWaveیک تمایز مهم است و ساختار اساسی طراحی در  MotiveWaveدر 

 به همراه دارد:کمی مبهم به نظر برسد ولی مزایای بسیار زیادی را 

توانید فریم مشاهده کرد. میتوان به طور همزمان در چندین تایمتحلیل را مییک  –مختلف های زمانی مشاهده در بازه .1

 را از هر یک از نمودارها ویرایش کنید. هاآنیکسان اشاره دارد باز کرده،  تحلیل چندین نمودار را که به یک

 .شودبه ابزارها محدود می تحلیل داشته باشد. نام تحلیل تواند هر تعدادمی ابزارمالیهر  –های جایگزین تحلیل  .2

 بنابراین لازم نیست در تمامی نمادها منحصر به فرد باشد.

 را روی نمودار بارگذاری کنید. آنرا ذخیره کرده و بعدها  تحلیل توانید یکمی –ذخیره شده در مخزن  .3

را با سایر  آنخروجی گرفته و  XMLتوانید در قالب فرمت فایل را می هاتحلیل –به اشتراک گذاری با سایر کاربران  .4

به اشتراک  Analysis Sourcesها را با استفاده از قابلیت تحلیلتوانید دوستان خود به اشتراک بگذارید. همچنین می

 بگذارید.

داشته باشد که در پایگاه  تحلیل تواند چندیندهد. هر ابزارمالی میها را نمایش میتحلیل تصویر زیر رابطه بین نمودارها و

 MotiveWaveشود. نمودار نیز باز می آنمربوط به  تحلیل کنید، همزماناند. وقتی نموداری را باز میداده محلی )مخزن( ذخیره شده

ا از بیش از یک نمودار باز کنید. تغییرات ایجاد شده در هر دو نمودار، بین دهد به طور همزمان یک تحلیل راین اجازه را به شما می

 تغییرات شوید. 2شود، بنابراین نیازی نیست نگران رونویسیمی 1دو نمودار همسان آن

 
 تحلیل رابطه بین نمودار و -33-3شکل 

                                                           
1 - Synchronize 

2 - Overwriting 
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 جدید تحلیل ایجاد یک 3.15.1

کنید، نام دارد. هرگاه نموداری را برای بار نخست باز می Primary Analysisفرض برای هر ابزارمالی تحلیل پیش 

Primary Analysis ابزارمالی  آنغییرات میان نمودارهای باز مربوط به تاصلی این رفتار این است که همه  تأثیر. نیز باز خواهد شد

 همسان سازی خواهد شد. هاآنمیان 

جایگزین ایجاد کنید. چندین روش برای  تحلیل سازی شوند، باید یک یا چندینخواهید این تغییرات همساناگر نمی

 باشد.در نوار ابزار می New Analysisاستفاده از دکمه  هاآنترین انجام این کار وجود دارد که شاید راحت

 
 New Analysis -34-3شکل 

 فرضپیش وروارد کنید. به ط تحلیل شود. نامی را برایپنجره زیر ظاهر میکنید، جدید ایجاد می تحلیل هنگامی که یک

 تحلیل هر نامی را که دوست دارید انتخاب کنید. یدتوانشود. با این حال میو ... نامگذاری می Alternate 1 ،Alternate 2نام 

انتخاب  Based Onدیگری که از لیست کشویی  تحلیل را روی آنتوانید های قیمت( یا میجدید ممکن است خالی باشد )فقط میله

 ریزی کنید.کنید، پایهمی

 
 New Analysisپنجره  -35-3شکل 

جدید  تحلیل ی فعال با نامرا در قسمت بالا، که برگه هاای از برگهمجموعهکنید، نمودار جدیدی ایجاد می تحلیل وقتی

 مشخص شده است باز خواهد کرد.
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 های جدیدتحلیل نموداری با -36-3شکل 

 بازکردن تحلیل موجود 3.15.2

در نوار  Openتحلیلی را باز کنید، فقط نیاز است که روی مثلث مشکی کوچکی که کنار دکمه اگر بخواهید خیلی سریع 

 در نوار منوی کنسول کلیک کنید. File->Chart->Open/Manage Analysesابزار قرار دارد کلیک کنید. یا این که روی 

 
 Open Analysis -37-3شکل 

 ها تحلیل مدیریت 3.15.3

های جدید تحلیل مختلفی مانند باز کردن، صادر کردن، تغییرنام، حذف و ایجاد هایعملیات Manage Analysesپنجره 

 File -> Chart -> Open/Manageتوان از نوار منو کنسول و کلیک روی این پنجره را می کند.برای ابزارمالی معینی فراهم می

Analyses .باز کرد 



 PiroozTrader  نمودارها –فصل سوم 

 

71 

 
 Manage Analysesپنجره  -38-3شکل 

 ها تحلیل وراد کردن/صادر کردن 3.15.4

 است. MotiveWaveها با دیگر کاربران  تحلیل وارد کردن و صادر کردن ابزاری بسیار ارزشمند برای به اشتراک گذاری

فایل شامل تمامی اطلاعات مرتبط با تحلیل و نیز اطلاعات مرتبط با ابزارمالی  آنکنید، صادر میوقتی فایل تحلیلی را 

 ( است.MotiveWave Markup Language) mwml آنبوده و پسوند  JSONاست. فایل خروجی دارای فرمت 

 فرضپیشرا اجرا کنید. فایل تحلیل به طور  File -> Chart -> Export Analysisدستور  Exportبرای باز کردن پنجره 

سازی را توانید نام و مکان ذخیرهدر دسکتاپ رایانه ذخیره خواهد شد. می Symbol> – <Analysis Name>.mwml>در قالب 

 کلیک کنید. Saveروی دکمه  براساس نام انتخابی،تغییر دهید. برای خروجی گرفتن از تحلیل 

 
 Export Analysisپنجره  -39-3شکل 
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جهت  را File -> Chart -> Import Analysisکنسول دستور  دربه همین شیوه، برای وارد کردن یک فایل تحلیلی، 

لیک کنید. اگر ک Openرا انتخاب کرده و روی دکمه  آناجرا کنید. مکان فایل تحلیل را یافته،  Import Analysisنمایش پنجره 

همان ابزارمالی موجود در فایل تحلیلی ورودی باشد، فایل ورودی در برگه تحلیلی دیگری  ،هستید آننموداری که در حال استفاده از 

بوده و نحوه  زیآم تیموفق ورود دادهشود که  ینشان داده م امیپ کیبا نمودار مطابقت نداشته باشد ،  مالیاگر ابزارباز خواهد شد. 

 .شود یداده م شیوارد شده نما فایلباز کردن 

 
 پنجره وارد کردن تحلیل -40-3شکل 

 ها مولفه 3.16
روند هایی از مولفه شامل خطوط توان به عنوا بخشی از تحلیل به نمودار اضافه کرد. نمونهها را میانواع مختلفی از مولفه

(Trend Lines)برچسب ،( های قیمتPrice Labels)کانال ،(هاChannels)(تفسیر ،Commentary)(امواج الیوت ،Elliott 

Waves( و نشانگرها )Markersتوان از قاب میرا ها مولفه باشد.( میComponents  واقع در نوار  ماوسیا با استفاده از ابزار(

 ابزار( به نمودار اضافه کرد.

 ها اب مولفهق 3.16.1

کند. این قاب در سمت چپ ناحیه نمودار ها را سازماندهی میابزار مورد استفاده در نمودارها و تحلیل 1هاقاب مولفه

بالا سمت  ’X‘ ضربدر توانید با کلیک روی علامتهایی سازماندهی شده است. این قاب را میشود و در قالب پروندهنمایش داده می

توانید ای در سمت راست نوار ابزار جهت نمایش/پنهان کردن قاب مذکور تعبیه شده است. یا اینکه میراست قاب مخفی نمود. دکمه

 در نوار منو کلیک کنید. View -> Display -> Componentsروی 

                                                           
1 - Components Panel 
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 Components Panel -41-3شکل 

 افزودن یک مولفه 3.16.2

را به روی نمودار بکشید )تصویر  آنها به نمودار، روی ابزار مورد نظر کلیک کرده و ای از قاب مولفهبرای افزودن مولفه

 <Add To -> <Graphی کلیک راست کرده و گزینه آنزیر(. روش دیگر این است که روی ابزار مورد نظر دوبار کلیک کنید یا روی 

 کلیک کنید. در این حالت ابزار مورد نظر در مرکز نمودار درج خواهد شد.

 
 افزودن مولفه به نمودار -42-3شکل 
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تواند راحتر از استفاده از قاب تر است. در برخی موارد استفاده از این ابزار میهای عمومیبیشتر شامل مولفه ماوسابزار 

Components  در لیست کشویی  ماوسباشد. ابزارTools  وجود دارد. ضمن این  آندر نوار ابزار قرار دارد. امکان سفارشی نمودن

 د.هستن <Ctrl + Shift + <Keyهای میانبر برای انتخاب سریعتر این ابزار وجود دارد. این کلیدها معمولا ترکیبی از که کلید

 
 Toolsلیست کشویی  -43-3شکل 

دهد. این ابزار خاص برای ترسیم نیاز به سه کانال را برای ایجاد یک کانال نشان می Channel Toolمثال زیر استفاده از 

 شود.کنید، کانال ترسیم میهمانطور که کلیک می در ضمندارد. 

 
 کانال ترسیمابزار  -44-3شکل 
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 های انتخابی مولفه 3.16.3

شود، معمولاً نقاط ای انتخاب میانتخاب کرد. وقتی مولفه ماوستوان با کلیک های ترسیمی روی یک نمودار را میمولفه

 اندازه توانید یک مولفه را جابجا کرده یا تغییرمی هاآنفاده از تغییر اندازه سبز رنگی در اطراف یک مولفه خواهید دید که با است

 دهید.

 
 انتخاب مولفه -45-3شکل 

 ها کلیک کنید. نقاط تغییر اندازه مولفه اولرا نگاه داشته و روی مولفه Shiftاگر بخواهید چند مولفه را انتخاب کنید، کلید 

 های ثانویه( به رنگ آبی خواهد بود.های انتخابی )مولفهبه رنگ سبز و نقاط تغییر اندازه سایر مولفه )مولفه اولیه( انتخابی

 
 انتخاب چندین مولفه -46-3شکل 
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تواند مفید باشد. می هاآنی کنید، انتخاب به یکبارهاگر بخواهید چندین مولفه را در قالب یک گروه جابجا کرده یا حذف 

توانید . در مثال زیر، میامکانات بیشتری را در اختیار خواهید داشت ،محتوی، با ظاهر شدن منوی هابا کلیک راست روی برخی مولفه

را به حالت  هاآن ”Make Lines Parallel“ی و و انتخاب گزینه هاآنچند خط را انتخاب کرده و با کلیک راست کردن روی یا دو 

 : خطوط موازی با مولفه اولیه )نخستین خط انتخابی( به حالت موازی در خواهند آمد.نکته موازی در بیاورید.

 
 موازی نمودن خطوط روند ترسیمی روی نمودار – 47-3شکل 

 حذف یک مولفه 3.16.4

یا این که روی را بفشارید. روی صفحه کلید  Deleteرا انتخاب کرده و کلید  آنبرای حذف یک مولفه، فقط لازم است 

 را کلیک کنید. Edit -> Deleteکلیک راست کرده و  آن

را در نوار منوی  Edit -> Delete Allهای موجود روی یک نمودار را به یکباره حذف کنید دستور اگر بخواهید همه مولفه

 بالا کلیک کنید.

 1های مولفه خصیصه 3.16.5

توانید می آنشود که در ای ظاهر میپنجره Propertiesی و انتخاب گزینه هاآنها با کلیک راست روی در بیشتر مولفه

 بار کلیک کنید.روی مولفه دو  این پنجره توانید برای ظاهر شدنبرخی از خصوصیات یک مولفه را تغییر دهید. یا این که می

                                                           
1 - Component Properties 
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 دسترسی به خصوصیات یک مولفه -48-3شکل 

ای دارد های موجود در این پنجره بستگی به مولفهدهد. گزینهرا نشان می Channelهای مولفه تصویر زیر پنجره خصیصه

 اید.که برای ویرایش انتخاب کرده

 
 Channelهای پنجره خصیصه -49-3شکل 

 بندی قالب  3.16.5.1

 Formatی و برگه Propertiesمانند رنگ، فونت، پهنا/سبک خط، سایه و غیره به پنجره  1بندیهای قالببرای تغییر گزینه

بندی در هایی از قالبها، گزینهدوبار کلیک کردن روی مولفه(. برای راحتی اعمال برخی تغییرات روی قالب مولفه یامراجعه کنید )

شوند )تصویر زیر می فعال و غیرفعالی انتخابی مولفه به محتوی حساس بوده و بسته به نوعها دکمه نوار ابزار تعبیه شده ست. این

 آیند.و به رنگ خاکستری در می یافتهحالت غیرفعال  هانتخاب نشده باشد دکمهای ارا مشاهده کنید(. اگر مولفه

                                                           
1 - Formatting 
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 بندیهای قالبگزینه -50-3شکل 

 کار با خطوط روند 3.16.6

ویژگی برای چند  MotiveWaveدر  باشد.بازار مینمودارهای قیمت در خطوط روند یکی از مهمترین عناصر تحلیل 

 تسهیل کار با خطوط روند ایجاد شده است.

 که در لیست کشویی ابزار قرار دارد ترسم کرد.  Lineتوان با استفاده از ابزارخطوط روند را می

 
 ابزار ترسیم خط روند -51-3شکل 

دارد. کلیک اول نقطه شروع و کلیک دوم نقطه پایان را تعیین خواهد کرد.  ماوسترسیم خط روند نیاز به دو کلیک چپ 

ی البته اگر گزینه، فعال شود Dragفرض پیشرا فشار دهید تا ابزار  Space barتوانید کلید وقتی خط روند را ایجاد کردید، می
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Revert to Default Tool  در تنظیماتPreferences -> Chart -> Chart Settings تنظیمات  -3.1.1به قسمت ) غیر فعال باشد

 (.مراجعه کنید فرض نمودار های پیش و گزینه

شود )مانند محدوده قیمت و شود اطلاعات اصلی در خصوص خط روند نمایش داده میوقتی خط روندی انتخاب می

مانند  یهای کلید)نقاط سبز تغییر اندازه( جابجا کنید. این نقاط به مکان آنی پایانی توانید با استفاده از نقطهزمان(. خط روند را می

 این ویژگی را غیر فعال کنید(. ’Alt‘چسبند )با نگه داشتن کلید های قیمت میهپایین و بالای ملی

 
 تنظیم یک خط روند -52-3شکل 

توانید خط را روی یکی از صفحه کلید را نگه دارید می Shiftاگر در هنگام جابجا کردن نقطه پایانی یک خط روند کلید 

در هنگام جابجا کردن خط روند  حالت، تنظیم کرده و ترسیم کنید. در ایندرجه و غیره(  45زوایای عمومی )مانند افقی، عمودی، 

حفظ  آنرا نگاه دارید زاویه جاری خط روند در هنگام جابجایی  Ctrlشاهد پرش خط روی زوایای مذکور خواهید بود و اگر کلید 

 شود.نامیده می قفل نمودن خط روند روی زوایااین عمل اصطلاحاً  د شد.خواه

 
 قفل کردن خط روند روی زوایای عمومی -53-3شکل 
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 1در یک پنجره شناور ثانیه روی یک خط روند به حال خود بگذارید، جزئیات خط روند 2را به مدت  ماوساگر نشانگر 

 ظاهر خواهد شد.

 
 خط روند روی ظاهر شده پنجره شناور جزئیات اطلاعات -54-3شکل 

 برای کار با یک خط روند در منوی محتوی ظاهر خواهد شد: تعملیابا کلیک راست روی یک خط روند چندین نوع 

1. Create Alert –های هشداربا عنوان  3.30.3 ایجاد یک هشدار در هنگام برخورد نمودار قیمت با خط روند )به بخش

 مراجعه کنید(. مولفه

2. Show Info – .نمایش اطلاعاتی در خصوص خط روند 

3. Show Angle – .نماش زوایه خط روند 

4. Relative End Point – ،نقطه پایان را  فاصله به جای استفاده از زمان/مقدار مشخص برای نقطه پایان خط روند

 کند.نسبت به نقطه شروع خط روند محاسبه می

5. Extend –  خط روند به سمت راست.توسعه 

6. Extend Left – .توسعه خط روند به سمت چپ 

7. Show Midpoint- .نمایش نقطه میانی خط روند 

8. Flip Line –  ،شوند.مقادیر نقطه شروع و پایان جابجا میبا تغییر خط روند 

9. Circle Radius – ای ترسیم خواهد کرد.با تعیین خط روند به عنوان شعاع، دایره 

10. Circle Diameter – ای ترسیم خواهد کرد.خط روند به عنوان قطر، دایره ینبا تعی 

11. Rotate 90 Degrees –  های ساعت.درجه در جهت عقربه-90چرخش خط روند به میزان 

12. Rotate 45 Degrees –  های ساعت.درجه در جه عقربه-45چرخش خط روند به میزان 

13. Make Lines Parallel - شود تمامی خطوط نسبت به خط اولیه کنیداین دستور باعث میچند خط را انتخاب  ایدو  اگر

 )خطی که دارای نقاط تغییر اندازه سبز است( در حالت موازی نسبت به هم قرار بگیرند.

                                                           
1 - Hover Popup 
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14. Make Lines Parallel and Equidistant –  اگر چند خط روند را انتخاب کنید، با اجرای این دستور خطوط نسبت

 گیرند.اصلی به حالت موازی با هم در آمده و به فاصله مساوی بین خطوط بالا و پایین قرار میبه خط 

 
 انواع عمیات قابل اعمال به خطوط روند -55-3شکل 

 ابزار سفارشی 3.16.7

دهد که به عبارت دیگر، ابزار سفاشی این امکان را به شما می هستند. ماوسمبتنی بر ابزار موجود  1ابزار سفارشی

توانید یک ابزار خط روند فرض یک مولفه را که با استفاده از ابزار ترسیم شده است، پیکربندی کنید. برای مثال، میخصوصیات پیش

 ی(.کند )به جای ترسیم یک خط ممتد مشکسفارشی ایجاد کنید که یک خط چین آبی را ترسیم می

واقع در نوار منوی کنسول( ایجاد کرد.  Configure -> Preferences) Preferencesتوان از پنجره ابزار سفارشی را می

 کلیک کنید. Custom Toolsو سپس  Tool Barدر این پنجره روی 

 
 ساخت ابزار سفارشی – 56-3شکل 

                                                           
1 - Custom tools 
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باز شود. ابزار  Add Custom Tool+( کلیک کنید تا پنجره  آیکون)با  Add، روی دکمه Custom Toolsاز بخش 

)در این مثال ابزار  ابزار مورد نظر را انتخاب کنید Base Toolبایست مبتنی بر ابزار موجود باشد. از لیست کشویی سفارشی می

Lineمنظور، در این مثال،  همینتغییر دهید. به  آنتوانید رنگ )های( آیکون ابزار را به منظور تشخیص بهتر ( . در صورت تمایل می

 ایم.رنگ آبی را برای رنگ آیکون اول انتخاب کرده

 
 سفارشی نمودن ابزار خط روند -57-3شکل 

کلیک کنید. در این  Customizeفرض روی دکمه و تغییر تنظیمات پیش Component Propertiesبرای بازشدن پنجره 

 مراجعه کرد. Formatمثال قصد داریم یک خط روند خط چین آبی ایجاد کنیم. برای این کار باید به برگه 

 
 Trend Line Propertiesدر پنجره  Formatبرگه  – 58-3شکل 

 در دو پنجره قبلی ابزار سفارشی اضافه شده به فهرست زیر را مشاهده خواهید کرد: OKبعد از کلیک روی دکمه 
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 ابزار سفارشی اضافه شده به فهرست – 59-3شکل 

. پیدا کرد یدسترس آننوار ابزار است تا با استفاده از ماوس به  کیبه  آنافزودن  یدر استفاده از ابزار سفارش یمرحله بعد

ای تغییر دهیم را به گونه  Top Tool Bar قصد داریم مثالبرای سفارشی نمودن نوار ابزار کلیک کنید. در این  Tool Barروی برگه 

 اضافه شود. مانابزارسمت چپ لیست کشویی   را به خط روند خط چین آبیابزار  که

 
 افزودن ابزار سفارشی ایجاد شده به نوار ابزار -60-3شکل 
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برای فعال شدن بعد از ایجاد تغییرات فوق، ابزار خط روند خط چین آبی به نوار ابزار بالا اضافه خواهد شد )تصویر زیر(. 

 Tooltipبا نگه داشتن ماوس روی این ابزار جدید، نام آن به صورت  :نکتهکلیک کنید.  آنابزار سفارشی مورد نظر روی دکمه 

 نمایش داده خواهد شد.

 
 استفاده از ابزار سفارشی در نوار ابزار بالا -61-3شکل 

 دهد:می تصیویر زیر استفاده از ابزار سفارشی جدید را در عمل نمایش

 
 استفاده از ابزار سفارشی جدید در عمل -62-3شکل 

3.16.8 Tool Group 
Tool Group  امکانی برای ایجاد یک لیست کشویی سفارشی برای سازماندهی ابزار موجود و ابزار سفارشی فراهم

توانید با مراجعه به ها را می Tool Groupشود. می MotiveWaveسازی فضای نوارهای ابزار در سازد. این امکان باعث بهینهمی

Configure -> Preferences -> Tool Bar -> Tool Groups  و کلیک روی دکمهAdd (.ایجاد کنید )+ 

 
 Tool Groupافزودن یک  -63-3شکل 
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 Tool Group Actionsبه  Available Actionsنامی را برای گروه ابزار انتخاب کرده و ابزار مورد نظر خود را از فهرست 

خواهد کرد و نیز به عنوان انتخابی گروه ابزار را تعریف : نام نکتهکلیک کنید.  OKروی دکمه  Tool Groupاضافه کنید. برای ایجاد 

 د.ظاهر خواهد ش Tooltipمتن در 

 
 Tool Groupافزودن یک  -64-3شکل 

Tool Group اید به فهرست ی که اخیراً ایجاد کردهTool Groups  در پنجرهPreferences شود. آیکون اولین اضافه می

 نمایش داده خواهد شد. آنابزار انتخابی در گروه ابزار به عنوان آیکون 

برگه  یبر رو Preferencesاستفاده کرد. در پنجره  آننوار ابزار است تا بتوان از  کیافزودن گروه ابزار به  یمرحله بعد

Tool Bar لیست کشویی کرده و از  کیکلTool Bar  نوار ابزارTop ما گروه ابزار  مثال نی. در ادیرا انتخاب کنMy Tools  را درست

 کرد. میاضافه خواه میکرد جادیدر قسمت قبل ا هک Blue Dashed Lineبعد از ابزار 

 
 به نوار ابزار بالا Tool Groupافزودن  -65-3شکل 
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وقتی روی لیست کشویی کلیک کنید  دهد.تصویر زیر گروه ابزار جدید را که به نوار ابزار بالا اضافه شده است نمایش می

 اید، مشاهده خواهید کرد.ابزاری را که به این گروه ابزاری اضافه کرده

 
 استفاده از گروه ابزار در عمل -66-3شکل 

 قابلیت رویت 3.16.9

ها را در جایی ا قادر خواهد کرد تا اندازه میلهاست که شما ر MotiveWaveیک ویژگی بسیار مفید در  1قابلیت رویت

ها روی تواند برای جلوگیری از بهم ریختگی هنگام تغییر اندازه میلهکه یک مولفه قابل مشاهده است، مشخص کنید. این قابلیت می

یا منوی راست کلیک روی مولفه تغییر  Propertiesتوان با مراجعه به پنجره را می Visibilityنمودار بسیار مفید باشد. تنظیمات 

 داد.

 
 تغییر تنظیمات قابلیت رویت یک مولفه -67-3شکل 

 
 یک مولفه Visibilityپنجره  -68-3شکل 

                                                           
1 - Visibility 



 PiroozTrader  نمودارها –فصل سوم 

 

87 

 نمایشگر اشیاء 3.16.10

ها را واحد است. مولفه پنجرهیک  درها موجود روی یک نمودار ابزاری مناسب برای مدیریت مولفه 1نمایشگر اشیاء

با کلیک روی  Object Viewer پنجره. دادرا تغییر  هاآنقابلیت رویت و ترتیب رسم  نیزتوان از روی نمودار حذف کرد و می

 شود.ظاهر می View -> Display -> Object Viewerدستور 

 
 Object Viewerپنجره  -69-3کل ش

 ها نسبت 3.17
MotiveWave های های زمان و قیمت فراهم ساخته است. شاید نسبتنسبت شناساییهای بسیار مختلفی را برای گزینه

ی در برگه های فیبوناچهای موجود برای تحلیلها است. مولفههای قابل استفاده در تحلیلیکی از عمومی ترین نسبتفیبوناچی 

Fibonacci  در قابComponents  در برخی نسخهقرار دارند( هایMotiveWave :)در دسترس نیستند 

 
 های فیبوناچیمولفه -70-3شکل 

                                                           
1 - Object Viewer 
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توان برای تغییر موقعیت نقاط تغییر اندازه زرد را می دهد.را نمایش می 1ای از یک فیبوناچی بازگشتیتصویر زیر نمونه

 ها استفاده کرد.ها و طول خطوط نسبتبرچسب

 
 Fibonacci Retracement -71-3شکل 

MotiveWave کرده است. اگر تمایل به تغییر خصوصیات ها فراهم قابلیت انعطاف بسیار زیادی برای کار با نسبت

را انتخاب  Ratio Settingsکلیک راست کرده و  ،فقط لازم است روی یک برچسب نسبت خصوصی دارید،ی بهها برای مولفهنسبت

 که روی برچسب مربوطه دوبار کلیک کنید.کنید یا این

 
 Ratio Settings -72-3شکل 

 رود.می Ratios -> Ratiosبرگه را برای مولفه باز خواهد کرد و به  Propertiesپنجره  Ratio Settingsی گزینه

                                                           
1 - Fibonacci Retracement 
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 Ratio Settingsپنجره  -73-3شکل 

 های سفارشی نسبت 3.17.1

توان برای وارد کردن فعال یا غیرفعال کنید. از فیلد ورودی می آنتوانید با استفاده از تیک مربوط به هر نسبتی را می

 بندی نسبت مربوطه را تغییر دهید.توانید قالبهای دلخواه )به درصد( استفاده کرد. با کلیک روی دکمه ویرایش )مداد( مینسبت

 
 پنجره تنظیمات نسبت -74-3شکل 

 خواهد بود: ریز شکلنسبت به  نیا یانتخاب شده در بالا برا یسفارش ماتیتنظ

 
 های فیبوناچی بازگشتیسفارشی نمودن یکی از نسبت -75-3شکل 
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 تنظیمات نمایشی نسبت 3.17.2

ی ها را تغییر دهید. تنظیمات موجود در این برگه به همهدهد نحوه نمایش نسبتبه شما امکان می Displayی برگه

های موجود در مولفه اعمال خواهد شد )مگر این که به طور واضح برای هر نسبت، طبق روش پیشین، ها و خطوط نسبتبرچسب

 ای اعمال شده باشد(.تنظیمات جداگانه

 
 های فیبوناچی بازگشتیخصیصهتنظیم  -76-3شکل 

 تنظیم پیشهای  نسبت 3.17.3

ای دیگر بر روی مولفه آنسازی پیکربندی یک نسبت و اعمال تواند در ذخیره( میRatio Presets) تنظیمهای پیشنسبت

برای  Save Presetبسیار کمک خواهد کرد. از دکمه  پر تکرار بسیار مفید واقع شود. این ویژگی به اجتناب از انجام کارهای

 نمودن پیکربندی نسبت کنونی جهت استفاده در در زمانی دیگر استفاده کنید.ذخیره

 
 هابرای استفاده در سایر موقعیت هاتنظیمپیشسازی ذخیره -77-3شکل 

 Save Ratioتایپ کنید. بعد از انتخاب نام در پنجره  آن، نیاز است که نامی را برای هاتنظیمپیشسازی هنگام ذخیره

Preset  روی دکمهSave :)کلیک کنید )تصویر زیر 
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 Save Ratio Presetپنجره -78-3شکل 

توان خیلی سریع می <Ratio Preset -> <Preset Nameسبت و انتخاب های نروی یکی از برچسب راست با کلیک

را، که در مرحله قبل تعریف  My Ratiosتنظیم در مثال زیر، قصد انتخاب پیش تنظیم ذخیره شده را به یک مولفه اعمال کرد.پیش

 کرده بودیم را داریم.

 
 تنظیم به یک مولفه دیگراعمال یک پیش -79-3شکل 

 ها نسبت تنظیمات سراسری 3.17.4

 Presetsکه دو زیربرگه به نام های  Ratiosو در برگه  Preferencesتوانید در پنجره را می هاسراسری نسبتتنظیمات 

 دارد، پیکربندی کنید: Defaultsو 

 
 هاتنظیمات سراسری نسبت -80-3شکل 
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ت بها نسهای نسبتی اعمال کنید. مولفهفرض را به هر نوع از مولفههای پیشتنظیمتوانید پیشمی Defaultsدر قسمت 

 ها و ... هستند. Elliott Waveها،  Circleها،  Fanها،  Retracementشامل 

 
 تنظیماتفرض پیشتنظیمات پیش -81-3شکل 

 خطوط راهنمای قیمت/زمان 3.18
های عمودی و زمان اضافه نمود. اساساً خط راهنما یک خط عمودی )یا افقی( است که توان به محوریخطوط راهنما را م

 است. دو نوع خط راهنما وجود دارد: آندارای نشانگری متصل برای نمایش مقدار 

 نمایش یک خط افقی همراه با نشانگر متصل در محور عمودی. –خط راهنمای قیمت/مقدار  .1

 )در سرتاسر پلات( همراه با شاخص متصل در محور زمان. عمودینمایش یک خط  –خط راهنمای زمان  .2

به یک نمودار اضافه کرد.  Add Guideتوان با استفاده از منوی راست کلیک روی محورها و انتخاب خطوط راهنما را می

تغییر  آنتوان و با کلیک و کشیدن توان برای ویرایش یا حذف خطوط راهنما نیز استفاده کرد. مکان خط راهنما را میمی از این منو

 داد.

 
 خطوط راهنما -82-3شکل 
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 خط راهنما پنجره خصوصیات -83-3شکل 

 نمودارهای درصد تغییر 3.19
نمای دیگری  1دهند. نمودارهای درصد تغییریک نماد را نمایش می تاریخیهای به طور معمول یک پلات قیمت، قیمت

با تغییر نوع میله در لیست کشویی در د. ندههای قیمت را برحسب درصد نمایش میاز نمودار هستند که تفاوت قیمت میان میله

 یک نمودار درصد تغییر را نمایش داد.توان می Percent Changeی ابزار بالا و انتخاب گزینهنوار 

 
 نمودار درصد تغییر -84-3شکل 

توان با کلیک شوند. شروع محاسبه را میفرض، نمودارهای درصد تغییر از منتهی الیه چپ نمودار محاسبه میبه طور پیش

 ای خاص تغییر داد.و تعیین نقطهنمودار )هر جایی که تمایل به شروع محاسبه از آنجا را دارید(  هاییکی از میله راست روی

                                                           
1 - Percent change charts 
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 ای خاص در نمودارمحاسبه درصد تغییر از میله -85-3شکل 

 شوند )تصویر زیر(:محل محاسبه نمودار نمایش داده می دو خط منقطع برای نمایش بصری

 
 محاسبه تغییر درصد در نمودار میان دو خط چین -86-3شکل 

-توانید حرکتمراجعه کنید( ترکیب شود، می همپوشانی ابزارمالیبا عنوان  3.20.5)به بخش  1ابزارمالی پوشانیهموقتی با 

 مستقیم در یک نمودار مقایسه کنید.های نسبی بین ابزارهای مالی را به طور 

                                                           
1 - Instrument Overlay 
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 نمودار درصد تغییر چندین ابزارمالی -87-3شکل 

 مطالعات 3.20
MotiveWave  روی نمودار قیمت یا به صورت  هاآنتوان ی درون ساخت دارد که مینوع مطالعه-257بیش از

 نمایش داد. ،در پلاتی زیر نمودار قیمت ،جداگانه

 نرم افزار وجود دارد: ناساساً دو نوع مطالعه در ای

شوند )مانند اطلاعاتی که در روی یک پلات موجود )به طور معمول پلات قیمت( نمایش داده می: 1پوشاهم .1

 (.Moving Averageاندیکاتور 

 (RSIآیند )مانند اندیکاتور به نمایش در می: اطلاعاتی که در پلاتی جداگانه از پلات قیمت پلات .2

 افزودن یک مطالعه 3.20.1

در نوار ابزار بالا قرار دارند به یک نمودار  Studyتوان با انتخاب یکی از مطالعات موجود که در منوی یک مطالعه را می

بندی ( دستههاآنیا عملکرد  هاخترع آنمرا( داخل گروهایی منطقی )براساس  هاآناضافه نمود. این منو برخی از مطالعات را )نه همه 

 آنتوانید به جای سعی در یافتن یک مطالعه در یک زیر منوها، نام در منوی مذکور می Add Studyکرده است. با استفاده از دستور 

اید در دسترس کرده استفاده هاآن، مطالعاتی که اخیراً از Recentرا تایپ کرده و جستجو کنید. برای تسهیل بیشتر نیز، در منوی 

 هستند.

                                                           
1 - Overlay 
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 Studyمنوی  -88-3شکل 

ظاهر خواهد شد که روشی آسان برای جستجوی یک مطالعه با تایپ کنید، پنجره زیر را انتخاب  Add Studyاگر دستور 

 باشد:می Filterدر فیلد  آننام 

 
 جسجوی یک مطالعه -89-3شکل 

مشابه با تصویر زیر را خواهید دید. هر مطالعه تنظیمات خاص  Studyکنید، پنجره ای را اضافه یا ویرایش میوقتی مطالعه

ی ی مطالعه یک برگههاهای موجود در این پنجره بسته به نوع مطالعه انتخابی متفاوت هستند، اما همه پنجرهخود را دارد. برگه

Options  وSignals  (.ابلیت ارسال سیگنال داشته باشدقمطالعه  آندارند)اگر 
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 Simple Moving Averageاندیکاتور  Studyپنجره -90-3شکل 

توانید با را به نمودار اضافه کند. برای تسهیل بیشتر، می آن Createتنظیمات مطالعه را تغییر داده و با کلیک روی دکمه 

 ذخیره کنید.تنظیمات مطالعه را برای مواقع دیگر  Save Defaultsکلیک روی دکمه 

 رویرا انجام داده بودید،  آنی قبلی تنظیمات را که در پنجره Simple Moving Average (SMA)تصویر زیر اندیکاتور 

را نیز  MACDاندیکاتور مربوط به  یک پلات مطالعهایش گذاشته است. همچنین در زیر نمودار قیمت، نم یک نمودار قیمت به

 کنید.مشاهده می

 
 مطالعات درج شده در رو و زیر نمودار -91-3شکل 
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 ویرایش یک مطالعه 3.20.2

دوبار کلیک کنید یا این که کلیک راست  آناگر بخواهد تنظیماتی را روی یک مطالعه انجام دهید صرفاً نیاز است که روی 

 را انتخاب کنید. Edit Studyی کرده و گزینه

 
 ویرایش یک مطالعه -92-3شکل 

 های مطالعه گزینه 3.20.3

وجود دارد که در زمان ایجاد یا تغییر قابل مشاهده است.  Optionsای به نام مربوط به همه مطالعات برگهدر تنظیمات 

 مختلفی است. گزینه و مقادیرپوشا یا پلات باشد، دارای این برگه بسته به این که مطالعه از نوع هم

 
 پوشاهای مطالعه از نوع همگزینه -93-3شکل 
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 های مطالعه از نوع پلاتگزینه -94-3شکل 

 پوشا هم 3.20.3.1

در های موجود توانید یکی از پلات. میاست Price Plotفرض پیش Graphپوشا، هنگام ایجاد یک مطالعه از نوع هم 

تغییر خواهید  آن Inputهای فیلد گزینهدهید، ی گرافی را برای مطالعه تغییر میوقت انتخاب کنید. را برای نمایش مطالعه Graphفیلد 

نمایش دهید، نیاز است که در  RSIرا روی پلات مطالعه  Simple Moving Average (SMA)برای مثال، اگر بخواهید یک  .یافت

ی )در برگه Inputغییر، فیلد با این ت کنید. تنظیم RSI(C,14)ی زینهگ روی را Graphمقدار فیلد  ،SMAمربوط به  Optionsی برگه

General )موجود در نمودار ورودی های شود تا به روز میRSI را منعکس کند. 

 
 SMAمربوط به مطالعه  Optionsی در برگه Graphپلات در فیلد تغییر  -95-3شکل 

 
 برای انعکاس تغییرات Generalی در برگه Inputفیلد تغییر خودکار  -96-3شکل 
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 از نوع پلات RSIپوشا روی مطالعه از نوع هم SMAترسیم مطالعه  -97-3شکل 

 مطالعه در اندازه میله 3.20.3.2

کند، . وقتی اندازه میله نمودار تغییر میفرض، اندازه میله مطالعه، در هنگام ایجاد آن، با نمودار یکسان استبه طور پیش

ای با دهد تا میلهاین اجازه را می MotiveWaveشود. ی جدید به روز میمطالعه نیز به طور خودکار برای انعکاس اندازه میله

روزانه را روی نمودار  SMAدهد، به طور مثال، این اجازه را به شما می ویژگیمطالعه انتخاب کنید. این  یک برایی خاص را اندازه

ای را ده دقیقه RSIتوانید های مطالعه نیز به کار برد. برای مثال میتوان روی پلاتهمچنین این ویژگی را می دقیقه نمایش دهید. 15

 )تصویر زیر(: ترسیم کنیدای دقیقه 15 تیک نمودار قیم روی

 
 SMAپوشای ی روزانه در مطالعه همانتخاب میله -98-3شکل 

 
 RSIای برای مطالعه پلاتی ی ده دقیقهانتخاب میله -99-3شکل 
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 متفاوت روی نمودار قیمت های زمانیبازهبا  RSIو  SMAاعمال مطالعات  -100-3شکل 

 پوشا مطاله پلاتی هم 3.20.3.3

 درها ترسیم کرد. شاید این نوع مطالعه را از قبل پوشا روی سایر پلاتتوان به صورت همبرخی مطالعات پلاتی را می

 چیدمان کنسول قرار دارد: درفرض باشید که به طور پیشیدهدپوشا هم Volumeاندیکاتور 

 
 Volume Overlay -101-3شکل 

توان روی پلات مطالعه را می تیک پلا تغییر دهید. آن Optionsی از برگه ،پوشا را برای یک مطالعهتوانید پلات هممی

را روی پلات  RSIو یک پلات  Priceرا روی پلات  CCIمثال زیر یک پلات  .پوشان کردهم ،پلاتهای مطالعهقیمت یا سایر 

Stochastic دهد:نشان می 

 
 پوشاهای همپلات -102-3شکل 
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 قابلیت رویت مطالعه  3.20.3.4

ی خاص قابل مشاهده باشند. این ویژگی ی با اندازهیهاپیکربندی کنید که فقط روی میلهای ای را به گونهتوانید مطالعهمی

شود. این ویژگی ها دیده میای از میلهفرض یک مطالعه روی هر اندازهها است. به طور پیشمشابه با ویژگی قابلیت رویت در مولفه

 تغییر دهید. Optionsی توانید در برگهرا می

 
 یک مطالعه Visibilityتغییر مقدار  -103-3شکل 

 ها سیگنال 3.20.4

نیز  آنافتد، سیگنال مربوط به برخی مطالعات امکان تولید سیگنال دارند. وقتی رویداد خاصی برای یک مطالعه اتفاق می

قرار گیرد،  ی قیمتخط راهنما تر ازبالا آن وقتی مقدار را طوری تنظیم کرد که CCIتوان مطالعه می شود. برای مثال،فعال تواند می

 هشدارتواند برای نمایش هشدارها، پخش صداها یا حتی ارسال یک ایمیل ها میاین سیگنال شود. نیز صادر آنسیگنال مربوط به 

انجام دهید.  Preferencesی ایمیل را در پنجره SMTP : اگر بخواهید ایمیل ارسال کنید، نیاز است که تنظیماتنکته د.ناستفاده شو

 قرار دارد. Emailی این تنظیمات در برگه

 
 های مطالعهسیگنال -104-3شکل 
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 همپوشانی ابزارمالی 3.20.5

از نوار منوی بالا روی پلات  Study -> Instrument -> Instrument Overlayتوان با انتخاب را می ابزارمالییک 

تایپ یا  Instrumentقیمت همپوشان کرد. این اقدام باعث باز شدن پنجره زیر خواهد شد. نام ابزارمالی مورد نظر خود را در فیلد 

در این  کلیک کنید. عناصر موجود Createاز لیست کشویی انتخاب کنید. برای افزودن این همپوشانی به پلات قیمت روی دکمه 

 پنجره به شرح زیر هستند:

1. Instrument – .نام ابزارمالی را تایپ یا انتخاب کنید 

2. Bar Type – فرض انتخاب کنید. مقدار پیش ،د در حالت همپوشانی نمایش داده شودینوع میله را که قصد دار

 نمودار خطی است.

3. Line Source – ی قبلی را اگر گزینهLine Chart  ،منبع  بتوانید که شداین امکان فراهم خواهد انتخاب کنید

 ( را انتخاب کنید.رهیغ ایبسته شدن، باز شدن  متیبه طور مثال قورودی خط )

4. Shift – کند )مقدارمنفی باعث عقبگرد نمودار ها برای جابجایی مطالعه به سمت جلو را مشخص میتعداد میله

پوشان به سمت همابزارمالی غیر فعال باشد امکان جابجا کردن  Lock Shiftی مطالعه خواهد شد(. اگر گزینه

 فراهم خواهد شد. ماوسجلو یا عقب، با استفاده از 

5. Style – .در نمودارهای خطی، رنگ، ضخامت و سبک خط را انتخاب کنید 

6. Show Axis – .محورهای مربوط به ابزارمالی را در کناره سمت چپ پلات قیمت نمایش خواهد داد 

7. Inverted – .باعث نمایش ابزارمالی همپوشان به صورت وارونه خواهد شد 

8. Bar Updates – ابزارمالی همپوشان به صورت زنده )به جای به روز  یبرای به روز رسانی لحظه به لحظه

 MotiveWaveتوانید این گزینه را فعال کنید )باعث افزایش بار ترافیکی رسانی بر اساس بسته شدن میله( می

 خواهد شد(.

9. Show Legend –  دهد.همپوشان را در قسمت راهنمای مطالعه نمایش مینام نمودار 

10. Show label – هد.همپوشان نمایش میابزار  نمودار در انتهایاز نماد ابزارمالی  برچسبی 

 
 Instrument Overlayپنجره  -105-3شکل 
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دهد. محور نماش می EUR/USDرا روی پلات قیمت جفت ارز  USD/CADمثال زیر همپوشانی ابزارمالی جفت ارز 

ی اگرگزینه جاری دارد. هایدر سمت چپ نمایش داده شده است و اندیکاتورهایی برای قیمت USD/CADمربوط به جفت ارز 

Auto Scale بندی خواهد کرد.ادیر نمودار همپوشان را به طور خودکار مقیاسفعال باشد، کشیدن نمودار به سمت چپ یا راست مق 

 
 مثالی از همپوشانی ابزارهای مالی -106-3شکل 

کشیدن  رهای همپوشان و پلات قیمت تنظیم نمود.ان با کلیک و کشیدن فضای بین محوتومقیاس عمودی همپوشان را می

 .دیاز وسط بکش را آن همزمان هر دو میتنظ یبرا شدن فضای بالا یا پایین خواهد شد. بالا یا پایین محور باعث اضافهاز 

توانید مکان نمودار همپوشان را با کلیک و کشیدن به سمت بالا یا پایین به منظور غیرفعال باشد، می Auto Scaleاگر 

 کنید.جابجا نسبت به محور نمودار اصلی،  آنتنظیم 

 
 تنظیم مکان عمودی ابزارمالی همپوشان -107-3شکل 
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تنظیم کرد. مقدار  Instrument Overlayی در پنجره Shiftتوان با تغییر مقدار فیلد مکان افقی نمودار همپوشان را می

غیرفعال باشد قادر خواهید  Lock Shiftرد. اگر گزینه کرا به سمت گذشته جابجا خواهد  آنمثبت نمودار را به آینده و مقدار منفی 

 و به چپ و راست تنظیم کنید. ماوسبود مقدار جابجایی را با کشیدن نمودار به وسیله 

 
 Instrument Overlayی در پنجره Lock Shiftی غیرفعال کردن گزینه -108-3شکل 

 
 همپوشان ابزارمالیجابجایی  -109-3شکل 
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 ها استراتژی 3.21
خودکار شوند.  نمیهمعاملات به صورت خودکار یا  موجب انجامتواند که میات هستند نوع خاصی از مطالعها 1استراتژی

 استراتژیبرای فعال یا غیرفعال نمودن یک  آن باد توانیکه می دارندنیز  2نمایش اطلاعات مطالعه، جعبه کنترلیوه بر علا هااستراتژی

 د.عات مهم زمان اجرا را مشاهده کنیاستفاده کرده و اطلا

MotiveWave  کند:را پشتیبانی می هااستراتژیدو حالت از 

1. Automatic  )براساس منطق داخلی خود به صورت  استراتژیکند، را فعال می استراتژیوقتی کاربر  –)خودکار

 دهد.خودکار خرید و فروش را انجام می

2. Manual  )گویدمیمناسب برای ورود را  موقعیت استراتژیاین حالت، کاربر به در  –)دستی. 

3. MotiveWave  درون ساخت دارد که در منوی  استراتژی-30حدودStrategy را بیابید. هاآنتوانید می 

 
 Strategyمنوی  -110-3شکل 

 Slowخط  Fast MAهنگامی که خط  استراتژیدهد. این را نشان می Moving Average Cross استراتژیتصویر زیر 

MA  های به سمت پایین قطع کند عمل فروش را انجام خواهد داد )علامت را آنبرعکس اگر را به سمت بالا قطع کند عمل خرید و

 آنرا ویرایش کرده و  استراتژیهای تقاطع این دو خط مشاهده کنید(. این ویژگی شما را قادر خواهد کرد مثلث کوچک را در محل

 دهد.ی کنترل اطلاعات موقعیت جاری را نمایش میدر ضمن جعبه را فعال کنید.

                                                           
1-  Strategy 

2 - Control Box 
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 MA Cross استراتژی -111-3شکل 

 دستیهای  استراتژی 3.21.1

یک موقعیت پاسخ  ورود به/خروج ازهایی ایجاد کنید که به ورودی کاربر برای استراتژیتوانید می MotiveWaveدر 

 باشد. دیمف اریبستواند یممعاملات آغاز شده توسط کاربر،  درنقاط خروج  تیریو مد تیکمک به هدا یبراویژگی  نیا دهد.

 .، مطالعه کنیدرا پرداخته شده است آنکه در ادامه  Trade Manager استراتژی درای از نحوه عملکرد، نمونه

د یتوان( میEntry/Exitی نخست )دهد. در برگهرا نشان می Trade Manager استراتژی هایتصویر زیر پیکربندی گزینه

 کند.را فراهم می زیاندستور توقف هایی برای گزینه Stop Lossی برگه دستور ورود و حداکثر سه دستور خروج را تنظیم کنید.

 
 Trade Manager استراتژی Entry/Exitی تنظیمات ورود/خروج در برگه -112-3شکل 
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 Trade Manager استراتژی Stop Lossی تنظیمات توقف ضرر در برگه -113-3شکل 

)فروش( را انتخاب کنید. وقتی  Short)خرید( یا  Longتوانید می Trade Manager استراتژیجعبه کنترل مربوط به در 

 شود.روی قیمت بسته شدن میله وارد می استراتژیکلید کنید،  Activeروی دکمه 

 
 Trade Manager استراتژیجعبه کنترل  -114-3شکل 

 Activeفعال است و دکمه  استراتژیکه نشانگر یک  ،زندخاموش چشمک میفعال است، نوار عنوان  استراتژیهنگامی که 

 شود.ورود به موقعیت( جایگزین می بازار برای)ایجاد سفارش  Enter Now( و استراتژی)برای غیرفعال کردن  Cancelهای با دکمه

 
 Trade Manager استراتژیفعال و غیر فعال کردن  -115-3شکل 
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 بازشده، Position مربوط به تاطلاعا کنترل جعبه یهاشود، برچسببه موقعیتی ورود می استراتژیوقتی در 

Unrealized P/L (Profit “یا  ”سودLoss “زیان”  ،)تحقق نیافتهTarget P/L  ،)سود و زیان هدف(Stop P/L  )سود و زیان توقف(

 همراه با سایر اطلاعات را نمایش خواهد داد.

 
 Trade Manager استراتژیهای جعبه کنترل برچسب -116-3شکل 

 استراتژیپیکربندی  3.21.2

د. نشواعمال می هااستراتژیمتفاوت هستند، اما تنظیماتی وجود دارند که در بسیاری از  استراتژیهای پیکربندی یک گزینه

 کند:است. این قاب امکانات پیکربندی زیر را رونمایی می Trading Optionsاولین قاب 

Trading Options: 

1. Trade Lots – شود، تعیین ها استفاده میاین فیلد، مقدار مربوط به سفارشاتی را که برای ورود و خروج موقعیت

 شود تا مقدار واقعی تعیین گردد.فرض ضرب میدر مقدار پیش Trade Lotکند. می

2. Position Type –  های تواند موقعیتمی استراتژیاز این گزینه برای نشان دادن این که آیاLong  یاShort داشته-

 شود.باشد، استفاده می

3. Use Account Position- کند.از موقعیت موجودی که در حساب انتخاب شده وجود دارد، استفاده می 

4. Enter On Active – یک موقعیت اولیه ایجاد خواهد شد.استراتژیسازی اگر این گزینه فعال باشد، هنگام فعال ، 

5. Close On Deactivate –  موقعیت در قیمت بازار بسته  آنشود، اگر موقعیتی باز باشد، غیرفعال می استراتژیوقتی

 خواهد شد.

6. Bar Updates -  ،ی قیمت بسته شود، به تغییرات لحظه به به جای این که صبر کند میله استراتژیاگر فعال باشد

 واکنش نشان خواهد داد. قیمتی لحظه

7. Underlay –  ،های قیمت ترسیم خواهد شد.پشت میله استراتژیبا انتخاب این گزینه 

Trading Sessions: 

فعال  هاآنممکن است در  استراتژیهایی که نشست توانیدهای معاملاتی، مییا نشست Trading Sessionsبخش در 

 به صورت خودکار غیرفعال خواهد شد. استراتژی ،های معاملاتینشست مابین تعریف کنید. را شود
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1. Session 1 – .نخستین نشست معاملاتی را با زمان شروع و پایان تعریف کنید 

2. Session 2 – .دومین نشست معاملاتی را تعریف کنید 

3. Time Zone – مشخص کنید. 2و  1های در صورت تمایل ناحیه زمانی را برای ساعات تعریف شده در نشست 

4. Close On Session End – بنددرا می آنموقعیت باز رسد وقتی نشستی به پایان می. 

 
 Trading Optionsی برگه -117-3شکل 

Strategy Panel: 

های شوند را انتخاب کنید. برچسبهایی که روی جعبه کنترل نمایش داده میبرچسبتوانید می Strategy Panelدر 

 انتخابی بستگی دارد: استراتژیموجود به نوع 

1. Show Position – دهد.موقعیت باز جاری را نشان می 

2. Show Entry Price – دهد.میانگین قیمت ورودی را برای موقعیت باز نشان می 

3. Show Unrealized P/L – دهد.نشان می اسود/زیان تحقق نیافته برای موقعیت باز جاری ر 

4. Show Realized P/L – دهد.سود/زیان تحقیق یافته جاری را نمایش می 

5. Show Stop P/L – دهد.اگر به سطح توقف زیان برسد میزان سود/زیان را نشان می 

6. Show Target P/L – دهد.اگر به سطح هدف برسد میزان سود/زیان را نشان می 

7. Show Risk Ratio - زیان توقف(تقسیم بر سود/دهد )سود/زیان هدف سطح ریسک را نشان می 

8. Show Total P/L -  دهد.را نشان می استراتژیکل سود/زیان جاری از زمان فعال شدن این 
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 Strategy Panelهای گزینه -118-3شکل 

 افزار بسته توسعه نرم 3.22
( سفارشی نمود. برای اطلاعات بیشتر به 1SDKافزار )بسته توسعه نرمتوان با استفاده از را می هااستراتژیمطالعات و 

 مراجعه کنید. http://www.motivewave.com/support/sdk.htmتارنمای 

 نوار ابزار 3.23
پنجره نمودار قرار داده شده است و شامل یک سری از برای تسهیل در تحلیل نمودارها، نوار ابزاری در کنسول یا در 

در پنجره  آنتنظیمات توان از طریق های عمومی روی یک نمودار است. این نوار ابزار را میها برای اجرای عملیاتدکمه

Preferences های پنجره افزود. در پنجره توان به پایین یا کنارهابزارهای دیگری را می تغییر داد. نوارPreferences توان می

Action برای حذف یا مرتب سازی راست ( یا از سمت چپهاآن)برای افزودن  به از سمت راست هاآنها( را با انتخاب ها )دکمه( 

های راست و چپ تعبیه شده بین دو ناحیه توانید از فلشاضافه نمود. برای این کار می هاآن( از نوار ابزار حذف یا به هاآنمجدد 

 هاآنی خود مرتب کرده و بین ها را برحسب سلیقهتوانید دکمههای سمت راست میو چپ استفاده کنید. با استفاده از دکمه استر

 یا فضای اضافی قرار دهید. 2خط حائل

                                                           
1 - Software Development Kit 
2 - Separators 

http://www.motivewave.com/support/sdk.htm
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 Preferencesدر پنجره  Tool Barی برگه -119-3شکل 

توانید نوار می آندر سمت راست  Enabledی و فعال نمودن گزینه Tool Barبا انتخاب نوار ابزار خود از لیست کشویی 

 اضافه کنید.ابزارهای دیگری را به پنجره 

 
 اند.فعال شده Leftو  Top 2نوار ابزار قسمت  -120-3شکل 
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 مطالعات کردن قفل 3.24
قفل  توانید از ویژگیوقتی در حال ایجاد تغییرات در نمودار هستید برای حفظ مجموعه مطالعات روی یک نمودار می

حال  را اجرا کنید. View -> Lock Studiesکار از نوار منوی بالا دستور استفاده کنید. برای این (Lock Studies) تکردن مطالعا

مالی روی نمودار، نام نماد جدید برای تغییر ابزار روی نمودار تغییر کند، مطالعات سرجای خودشان قفل خواهند بود. ابزارمالیاگر 

دو تصویر بعدی استفاده از ویژگی  را بفشارید. Enterدر سمت چپ نوار ابزار تایپ کرده و کلید  Quick Searchرا در جعبه متن 

Lock Studies دهد:را نشان می 

 
 Lock Studies ویژگی فعال سازی -121-3ل شک

 
 Lock Studies تتغییر ابزارمالی در حال -122-3شکل 

 قفل کردن نوار پیمایش 3.25
( روشی مناسب برای حفظ موقعیت یکسان در چندین نمودار هنگام استفاده از Lock Scrollپیمایش )نوار قفل کردن 

 View -> Lockسازی این ویژگی دستور برای فعال است. تاریخی برای حرکت به جلو و عقب در محور قیمت Scrollویژگی 
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Scroll  اگر این ویژگی فعال باشد، در هنگام پیمایش  نوار ابزار کلیک کنید. دررا اجرا کنید یا این که روی دکمه معادل این دستور

حال ، مابقی نمودارهای موجود در گروه نیز به همان موقعیت پیمایش خواهند شد. 1گروه پیوند یک یکی از نمودارهای موجود در

ند همراه با در یک صفحه کنسول باشد، همه نمودارهایی که در همان صفحه هستنباشد، اما  پیوندار بخشی از یک گروه دنمو اگر

 این نمودار پیمایش خواهند شد.

 
 Lock Scrollسازی ویژگی فعال -123-3شکل 

 
 Lock Scrollپیمایش نمودارها در حالت  -124-3شکل 

                                                           
1 - Link Group 
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 اتیالگوهای مطالع 3.26
سازماندهی کرد. یک الگو حاوی یک یا چندین  ایتعریف شدهت را در الگوهای از پیشتوان مطالعابرای سهولت، می

مطالعات مورد نظر خود را به نمودار اضافه کرده و تنظیمات دلخواه باشد. برای ایجاد یک الگو، همه مطالعه با تنظیمات خاص می

الگوی مورد نظر خود را  File -> Chart -> Template -> Save As Templateسپس با اجرای دستور  .اعمال کنید هاآنرا روی 

 ذخیره کنید.

 
 (مرحله اولایجاد الگو ) -125-3شکل 

 
 ذخیره سازی الگو )مرحله دوم( -126-3شکل 
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توان یک الگوی مطالعاتی را به سایر نمودارها می <File -> Chart -> Templates -> <Template Nameبا کلیک روی 

، Alt+1انبر از کلیدهای میتوانید می برای اعمال الگو به نمودار اند.بینی شدههای میانبری برای افزایش سرعت پیشاعمال کرد. کلید

Alt+2 باشد.می هاآنزمان ایجاد  براساسها ترتیب الگوها شماره .و ... استفاده کنید 

 
 به یک نمودار اعمال الگو -127-3شکل 

 
 نمودارالگوی اعمال شده به  -128-3شکل 
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 حذف یک الگو 3.26.1

(، در راهنمای مطالعه، روی نام الگو کلیک راست آنهای مرتبط با نمودار )از جمله همه پلاتبرای حذف الگو از رو یک 

 کلیک کنید. Deleteکرده و روی 

 
 حذف یک الگو -129-3شکل 

 مدیریت الگوها 3.26.2

مراجعه کنید. برای باز کردن این پنجره روی  Manage Templatesتوانید به پنجره برای مدیریت الگوهای موجود می

File ->Chart -> Templates -> Manage Templates توانید نام یا ترتیب الگوها را تغییر داده کلیک کنید. در پنجره باز شده می

 گذارد.می تأثیرو ...(  Alt+1 ،Alt+2) هاآنهای میانبر مرتبط با را حذف کنید. تغییر ترتیب الگوها بر ترتیب کلید هاآنیا 

 
 Manage Templateپنجره  -130-3شکل 

 وارد یا صادر کردن الگوها 3.26.3

دیگری منتقل کنید.  کاریفضایرا به  هاآنتوانید الگوهای موجود را به صورت یک فایل خروجی گرفته و به راحتی می

تواند مفید باشد. هر دو عملکرد وارد یا صادر میان فضاهای کاری می هاآناین ویژگی برای به اشتراک گذاری الگوها یا جابجایی 
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در پایین این پنجره قابل مشاهده  Import/Exportهای پذیر است. دکمهامکان Manage Templatesکردن الگوها از طریق پنجره 

 هستند.

 
 وارد یا صادر کردن الگوها -131-3شکل 

 تنظیمات الگوها 3.26.4

ی و سپس روی زیربرگه Chartی قرار دارد. روی برگه Preferencesی تنظیمات مرتبط با الگوهای مطالعاتی در پنجره

Templates ی انتخاب گزینهتوانید با فرض را میکلیک کنید. الگوی پیشUse Default  پیکربندی کنید. هرگاه نمودار جدیدی

 اعمال خواهد شد. آنفرض بر روی ایجاد کنید، الگوی پیش

)البته اگر  کردیک الگو را به همه نمودارهای موجود در یک گروه پیوند اعمال خواهد  Link Templatesی گزینه

 پیوند زدن نمودارها مراجعه کنید(. بعدی با عنوان پیکربندی شده باشد. به بخش

 
 تنظیمات الگوها -132-3شکل 
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 زدن نمودارها پیوند 3.27
سازد یک عمل را به است که شما را قادر می MotiveWave( یک ویژگی قدرتمند در Chart Linkingپیوند نمودار )

)به  فرض بین نمودارها پیوندی وجود نداردیک نمودار( در یک زمان اعمال کنید. به طور پیش ای از نمودارها )به جایمجموعه

ترین روش چند روش متفاوت برای انتساب یک گروه پیوند به یک نمودار وجود دارد. ساده. منتسب نیستند( 1هیچ گروه پیوند

 کند(.نیز کار می Time/Salesو  DOMهای مورد برای پنجره : ایننکتهانتخاب گروه پیوند از نوار وضعیت در پایین پنجره است )

 
 انتخاب پیوند در نوار وضعیت -133-3شکل 

 سه حالت برای پیوند زدن نمودارها وجود دارد:

1. Instrument  )نمودارها موجود در گروه پیوند  غییر نماد روی یک نمودار باعث تغییر همهتدر این حالت،  –)نماد

 به همان نماد خواهد شد.

2. Bar Size (زمان )– ی همه نمودارهای وارد تغییر یابد، اندازه میلهی قیمت روی یک نمدر این حالت اگر اندازه میله

 پیوند شده به هم نیز به همان اندازه تغییر خواهند یافت.

3. None (Replay) – رودبه کار می 2پخشبازحالت  ازاستفاده  یبرا گریکدیدادن نمودارها به  وندیپ یحالت برا نیا 

با عنوان  3.29شوند. برای آشنایی بیشتر با این قابلیت به بخش بازپخش می گروه کیاز  یبخش یوندیپ ی)نمودارها

 .(مراجعه کنید حالت بازپخش

توان برای هر رنگ پیوند به صورت جداگانه انتخاب کرد. تنظیمات مربوط به پیوند در پنجره های پیوند را میحالت

Configure -> Preferences ی هبرگLinking .قرار دارد 

                                                           
1 - link group 

2 - Replay Mode 
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 Preferencesتنظیمات پیوند در پنجره  -134-3شکل 

توان به یک گروه پیوند زد. در مثال زیر، دو نمودار و یک پنجره را نیز می Time/Salesو  DOMها مانند سایر پنجره

DOM اند. انتخاب یک نماد جدید از طریق جعبه متن به یک رنگ پیوند یکسان منتسب شدهQuick Search ها از یکی از پنجره

 های موجود در گروه پیوند خواهد شد.باعث تغییر خودکار نماد برای همه پنجره

 
 (اول مرحله)نمونه پیوند  -135-3شکل 
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 (مرحله دوم)نمونه پیوند  -136-3شکل 

 پیوند با الگوها 3.27.1

توان در کنار الگوهای مطالعاتی استفاده ذکر شد، از ویژگی پیوند می اتیالگوهای مطالعبا عنوان  3.26همانطور که در بخش 

ر گروه (، اعمال یک الگو به یک نمودار دPreferencesدر پنجره  Chart -> Templatesی نمود. اگر این گزینه فعال باشد )برگه

 گروه پیوند اعمال خواهد شد. آنی نمودارهای موجود در به همه ،پیوند

 پیوند زدن 3.27.2

خواهید شد. این  Link Allی پیوند دیگری با نام کنید، متوجه یک گزینهی کنسول )یا یک دسکتاپ( کار میاگر با پنجره

اهد زد. این ویژگی روشی مناسب برای پیوند زدن همه گزینه همه نمودارهای که روی صفحه جاری قرار دارند را به هم پیوند خو

 باشد )به جای انتخاب یک لینک برای هر نمودار(.ا یک کلیک میهای موجود روی یک صفحه بنمودار

 
 Link Allنمودارهای دارای  -137-3شکل 
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 های نمودار کار با پنجره 3.28

 فشردهحالت نمای   3.28.1

به منظور بیشنه نمودن فضای نمودار روی یک پنجره، نوارهای ابزار، منو و وضعیت حذف خواهند شد.  1در حالت فشرده

 در سمت راست کنار نوار عنوان، برای تغییر حالت نما میان معمولی و فشرده استفاده کنید. Compact/Uncompactاز دکمه 

 
 Compactدکمه  -138-3شکل 

دهد. توجه داشته باشید که ناحیه نمودار، کل پنجره نمایش را تصویر زیر یک پنجره نمودار را در حالت فشرده نشان می

در نوار ابزار کلیک  Uncompactبه منظور بهینه سازی فضای نمایش اشغال کرده است. برای برگشت به حالت معمولی، روی دکمه 

 کنید.

 
 حالت فشرده -139-3شکل 

پیکربندی کرد.  Compact Mode ی¬برگهو در  Preferencesتوان  با مراجعه به پنجره رفتار حالت فشرده را می

های مورد نظر خود را به شما اجازه خواهد داد که نمایش یا عدم نمایش المان Compact Modeی های موجود در برگهگزینه

 کنترل کنید.

                                                           
1 - Compact mode 
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 Preferencesی در پنجره Compact Modeبرگه  -140-3شکل 

 ها کاری پنجره کاشی 3.28.2

ای را روی یک صفحه نمایش، بدون این که بخواهید پنجره چیدمان نمودارهای موجودبرای  1هاکاری پنجرهویژگی کاشی

قرار گیرند، شروع  هاآنخواهید های نمودار در جایی که میتواند مفید باشد. با مرتب کردن پنجرهبه صورت دستی جابجا کنید، می

)یا فشردن  Tile Windowsرده و گزینه های نمودار کلیک راست ککنید. وقتی این کار را انجام دادید، روی نوار عنوان یکی از پنجره

را در نوار منوی بالا اجرا  Window -> Tile Windows دستور Mac OS X: در نکته( را انتخاب کنید. Ctrl+Wکلیدهای ترکیبی 

 کنید.

 
 مرتب کنید. کاریفضایرا به دلخواه در  هاآنها، کاری پنجرهپیش از کاشی -141-3شکل 

                                                           
1 - Tile Windows 
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 Tile Windowsها با اجرای دستور کاری پنجرهکاشی -142-3شکل 

 ها آبشاری کردن پنجره 3.28.3

در صفحه به روی های موجود ، موجب چیدمان پنجره1هاها، قابلیت آبشاری کردن پنجرهکاری پنجرههمانند ویژگی کاشی

 را از نوار منوی بالا اجرا کنید. Window -> Cascade Windowsشود. برای این کار دستور ی بالا سمت چپ میهم از گوشه

 
 ها به حالت آبشاریچیدمان پنجره -143-3شکل 

                                                           
1 - Cascade Windows 
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 ها اندازه پنجره 3.28.4

تعیین نمود. این ویژگی برای  <Windows -> Windows Size -> <Sizeز طریق منوی توان ااندازه پنجره را می

های ای که در اندازهبرای مشخص نمودن اندازه Customتواند مفید باشد. از ی نمایش میبرداری از صفحهتصویربرداری یا فیلم

 تنظیم وجود ندارند، استفاده کنید.پیش

 
 های پنجرهتغییر اندازه -144-3شکل 

 حالت بازپخش 3.29
های بازار سازد در زمان به عقب برگشته و دادهویژگی مفید است که شما را قادر می Replay Modeیا حالت بازپخش 

سفارشی بسیار مفید است. کنترل حالت های استراتژین مطالعات یا ورا بازپخش کنید. این قابلیت برای تمرین معاملاتی یا آزم

ای که در : فعال سازی این قابلیت از طریق دکمهنکته) View -> Replay Modeبازپخش از نوار منوی نمودار در دسترس است :

دار در پایین نمو Replay Modeکنید نوار سمت راست نوار ابزار قرار دارد نیز امکان پذیر است(. وقتی روی این ایتم کلیک می

 ظاهر خواهد شد.

 
 در پایین پنجره نمودار Replay Modeنمایش  -145-3شکل 
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 شروع خواهد شد. Powerحالت بازپخش با انتخاب تاریخ شروع و کلیک روی دکمه 

 
 حالت بازپخش سازیفعال -146-3شکل 

ها استفاده کنید. عملکرد برای پیشروی به سمت جلو و بررسی داده Stopو  Play ،Fast forward ،Reverseهای از دکمه

 ها به شرح زیر هستند:دکمه

1. Rewind – .این دکمه باعث شروع مجدد حالت بازپخش از ابتدا خواهد شد 

2. Play – .پیشروی به سمت جلو در زمان با یک تیک 

3. Forward – ی بعدیها تا رسیدن به میلهپخش تیک 

4. Fast Forward – ها به طور مداوم.پخش تیک 

5. Stop – های ها. فقط زمانی فعال است که دکمهتوقف پخش تیکForward  یاFast forward .کلیک شده باشند 

 
 Replayهای دکمه -147-3شکل 

ی زمانی به صورت زنده در حال معامله هستید. یک حساب بازه آنای است که گویا در کار در حالت بازپخش به گونه

 شود.ی معاملات ایجاد میها و تاریخچهها، موقعیتبازپخش ویژه برای مدیریت سفارش

 تنظیمات بازپخش 3.29.1

 توانید تنظیمات بازپخش را انجام دهید.می Replay Modeبا کلیک روی ایکون چرخ دنده در سمت راست نوار 

 
 تنظیمات بازپخش -148-3شکل 
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 تنظیمات داده بازپخش

 ها در حالت بازپخش به شرح زیر هستند:پخش دادهتنظیمات موجود برای 

1. Source Data – ذیل هستند:های منبع شامل موارد های موجود برای دادهگزینه 

a. Bar Data –  4هر میله برای تولید-( تیک قیمت باز شدنOpen )، ( بیشترین قیمتHigh )،  کمترین

 شود.( استفاده میClose( و قیمت بسته شدن )Lowقیمت )

b. Minute Data - قهیدق میلهشوند )هر  یم یریداده بارگ سیاز سرو کیت دیتول یبرا یا قهیدق یداده ها 

 .(بیشترین، کمترین و بسته شدن استباز ، های قیمت تیک-4 یدارا

c. Tick Data – تیک را ارائه کند، این گزینه می تواند  تاریخی هایی شما دادهاگر کارگزاری یا سرویس داده

 مفید باشد.

2. Generate Ticks –  این ویژگیMotiveWave فراتر از ای از تیکرا قادر خواهد ساخت تا مجموعه( ها راOHLC )

 شود.اعمال نمی Tick Dataی برای پخش تولید کند. این گزینه برای گزینه

3. Step Until Price Change – ،وقتی دکمه  در صورت فعال بودنPlay ی که قیمت تغییر تا زمان شود،فشار داده می

 شوند )به جای یک بار تیک در یک زمان(.می پخش هاتیکند، می

4. Real Delay – انتخاب این گزینه،  باMotiveWave سازی های تیک شبیهها را با استفاده از مهرزمانبین تیک تأخیر

 این گزینه را انتخاب کنید. دارید،ها در زمان واقعی سازی پخش واقعی تیکخواهد کرد. اگر تمایل به شبیه

5. Speed Factor –  برایReal Delay ها را دهد تا سرعت پخش تیکاجازه میرود. که در بالا تشریح شد به کار می

 در زمان واقعی افزایش یا کاهش دهید.

6. Tick Delay –  کند.میان پخش هر تیک را تعیین می تأخیراین گزینه زمان 

7. Bar Delay –  کند.میان پخش هر میله قیمت را تعیین می تأخیراین گزینه زمان 

8. Replay Link – شود.بازپخش میان همه نمودارها به هم پیوند خورده استفاده می از این گزینه برای استفاده از حالت 

 1حساب بازپخش

تواند برای می حساب بازپخشسازی کنید، صد دارید معاملات خود را در حالت بازپخش به صورت واقعی شبیهاگر ق

های برای نشستیک حساب ویژه ی معاملات ها و تاریخچهشما مفید باشد. اگر فعال باشد، برای ردیابی همه سفارشات، موقعیت

 (.کنسول مراجعه کنید نوار پایین در Accountبه صفحه بازپخش ایجاد خواهد شد )

1. Account ID – .نام حساب ایجاد شده که معاملات را ردگیری خواهد کرد 

2. Base Currency – را تغییر دهید. آنتوانید کند، ولی میفرض را تعیین میواحد پول پیش 

3. Cash Balance - دیکن یپخش را فعال مبازکه حالت  یباز کردن مانده پول نقد هنگام. 

                                                           
1 - Replay Account 
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4. Include Commissions – خواهید کمیسیون معاملات در محاسبات سود/زیان شما محاسبه شود این گزینه اگر می

 را انتخاب کنید.

 پیوند زدن در حالت بازپخش 3.29.2

دهد که از حالت بازپخش در میان چندین نمودار مختلف این امکان را به شما می MotiveWaveویژگی پیوند زدن در 

 دهد:توضیح میرا در یک زمان استفاده کنید. مراحل زیر نحوه گنجاندن چندین نمودار در یک نشست بازپخش 

های قیمت را میله مالی و اندازهخواهید در حالت بازپخش بگنجانید انتخاب کرده و ابزارهاینمودارهایی را که می .1

 تعیین کنید.

 باشد(. ”Replay“روی  Link Typeیک رنگ پیوند را برای هر نمودار انتخاب کنید )مطمئن شوید که  .2

 را انجام دهید. Replayتنظیمات  .3

 کلیک کنید. ”Update“پیوند را انتخاب کرده و روی دکمه  .4

 
 تنظیمات بازپخش به هم پیوند خورده -149-3شکل 
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کنند را نشان نمودار را که بخشی از یک گروه قرمز هستند و از یک نشست بازپخش یکسان استفاده می 4تصویر زیر 

 دهد:می

 
 پیوند خودرهنمودارهای به هم  –نشست بازپخش  -150-3شکل 

تر تواند بسیار راحتفرض( استفاده از حالت بازپخش میخورند )حالت پیشدرها در یک صفحه به هم پیوند میوقتی نموا

 از حالت کنسول )یا یک دسکتاپ( باشد. همه نمودارهایی که بخشی از یک صفحه هستند در نشست بازپخش گنجانده خواهند شد.

 
 نشست بازپخش درون یک صفحه -151-3شکل 
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 ها هشدار 3.30
 هشدارباشد. به طور مثال صدور روشی مفید برای دریافت یک هشدار هنگام وقوع یک رویدار خاص می 1هاهشدار

یک خط روند را قطع کند.  یافتد که قیمت یک ابزارمالی خاص به یک قیمت تعیین شده برسد یا این کهتواند وقتی اتفاق بمی

 تواند شامل مقایسه مقادیر حاصله از مطالعات مختلف باشد.ها میهشدارتر های پشرفتهنهنمو

فرض، در کنسول مدیریت کرد. به طور پیش Alertsتوان به صورت متمرکز و با استفاده از قاب های فعال را میهشدار

های موجود در سمت راست هر یکی از قاب توانیدمی Add Tabبا استفاده از دکمه  گنجانده شده است. Homeاین قاب در صفحه 

 اضافه کنید. هشداردر کنسول یک قاب 

 
 MotiveWaveدر  هشدارقاب  -152-3شکل 

 های قیمتهشدار 3.30.1

براساس  هاهشدارقیمت نیازی به اجرای نمودار قیمت ندارد. این نوع  هشداراست.  Price Alertترین نوع هشدار ساده

 Alertsتوان به طور مستقیم در قاب های قیمت را میهشدارصادر خواهد شد. قیمت عرضه/تقاضا یا آخرین قیمت یک ابزارمالی 

 یا از طریق محور قیمت یک نمودار ایجاد کرد.

 
 Alertsقاب  –قیمت  هشدارایجاد  -153-3شکل 

                                                           
1 - Alerts 
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 محور قیمت –قیمت  هشدارایجاد  -154-3شکل 

های ایجاد شده از طریق هشدارکنید تصویر زیر نمایش داده خواهد شد. ایجاد می Alertsی را از طریق قاب هشداروقتی 

محور قیمت شبیه تصویر زیر هستند با این تفاوت که در حالت دوم امکان انتخاب ابزارمالی وجود ندارد )فرض بر این است که 

 (.استابزارمالی نمودار مد نظر کاربر 

 
 هشدارپنجره ایجاد  -155-3شکل 



 PiroozTrader  نمودارها –فصل سوم 

 

132 

 موجود در این قاب به شرح زیر هستند:تنظیمات 

1. Parameters 
a. Conditions –  تواند می ،. فیلد )ورودی( نخستشودمیتعریف  هشداربرای صدور  یمعیاردر این قسمت

تیک باشد )آخرین قیمت، قیمت عرضه/تقاضا، بیشترین/کمترین قیمت و ... (. فیلد هریک از ورودهای 

یک قیمت نسبی  Indicatorی توان با انتخاب گزینهیا این که می تواند یک قیمت مشخص باشد.آخر می

، در بیشتر مواقع Price Alertمانند آخرین قیمت، بهترین عرضه و بهترین تقاضا را تعیین نمود. در مورد 

 برای مقایسه وجود دارد: عملگرشود. سه نوع یک مقدار مشخص تعیین می

i. Cross – کند.ت بالا یا پایین قطع میورودی اول ورودی دوم را به سم 

ii. Crosses Above – ورودی اول قیمت تعیین شده در ورودی دوم را به سمت بالا قطع  فقط اگر

 صادر خواهد شد. هشدار ،کند

iii. Cross Below - قطع  پاییندوم را به سمت  یشده در ورود نییتع متیاول ق یاگر فقط ورود

 صادر خواهد شد. هشدار ،کند

iv. Touches –  صادر خواهد شد. هشداراگر مقدار هدف لمس یا قطع شود 

b. Trigger Multiple – همچنان معتبر  یسازفعال نیپس از اول هشدار، نهیگز نیا یدر صورت علامت گذار

لغو  به طور صریح مگر این که ،خواهد ماندبه طور نامحدود فعال  هشدار نیحالت ا نیخواهد بود. در ا

 .شود

c. Label / Comments –  قارد خواهند ساخت متنی را به  را ها شماصادر شد، این فیلد هشدارهنگامی که

 شود اضافه کنید.ایمیلی که ارسال می

2. Notifications 
a. Show Alert –  اگر این گزینه در حالتYes  پنجره هشدارباشد، هنگام فعال شدن ،Alert History 

 نمایش داده خواهد شد.

b. Play Sound – تواند از یک صدای پخش خواهد شد. این صدا می ی، صدایهشداردن هنگام فعال ش

 تنظیم یا یک فایل صوتی مشخصی باشد که شما تعیین خواهد نمود.پیش

c. Send Email –  هشدارهنگام فعال شدن  ،( آدرس ایمیلی پیکربندی شده باشد )واگر این گزینه فعال باشد ،

 ارسال خواهد شد.یک ایمیل به آدرس الکترونیکی تعیین شده 

 های مطالعاتیهشدار 3.30.2

ها در محتوی هشدارشوند. این نوع توانند مبتنی بر مقادیری باشند که به عنوان بخشی از یک مطالعه تولید میها میهشدار

را  1لعاتیمطا هشدارقیمت،  هشدارنیاز است که نمودار قیمت باز باشد. مشابه با  هاآنیک نمودار اجرا شده و به منظور فعال شدن 

 ایجاد کنید. Create Alertی راست کلیک روی محورهای عمودیِ )پلات قیمت یا پلات مطالعه( و انتخاب گزینه باتوانید می

                                                           
1 - Study Alert 
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 مطالعاتی هشدارایجاد  -156-3شکل 

 
 مطالعاتی هشداری ایجاد پنجره -157-3شکل 

 توان ساخت:مطالعاتی دو نوع مقایسه را می هشداربا یک 

1. Absolute Comparison –  در مثال فوق(  0.1174-مقدار یک مطالعه با یک مقدار مشخصی )به طور مثال مقدار

 شود.مقایسه می

2. Relative Comparison – مقدار یک مطالعه برخلاف مقدار مطالعه دیگری باشد )در پلاتی یکسان(. برای فعال-

 کلیک کنید. Indicatorسازی مقایسه نسبی روی 
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 ای دیگرمقایسه نسبی مقدار یک مطالعه با مقدار مطالعه -158-3شکل 

-Tenkanی دیگر )از مقدار مطالعه KAMA (C,20)مقدار مطالعه  آندهد که در مطالعاتی را نشان می هشدارمثال زیر یک 

Sen(9)) عبور (Crosse)  .شود که نقطه تلاقی بین این دو مقدار است.در جایی نمایش داده می هشدارکرده است 

 
 طالعاتی از نوع مقایسه نسبیم هشدار -159-3شکل 

 1های مولفههشدار 3.30.3

ی هشدار Moving Averageتوانید برای یک ها استفاد کرد. برای مثال، میهشدارتوان برای تولید ها میاز برخی مولفه

کنید، روی  ها استفادههشدارخواهید از این نوع اگر می صادر شود. هشدار آنرا ایجاد کنید که هر وقت خط روندی را قطع کرد، 

 را انتخاب کنید. Create Alertی یک خط روند کلیک راست کرده و گزینه

                                                           
1 - Component Alerts 
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 ایجاد هشدار مولفه -160-3شکل 

 
 Component Alertی پنجره -161-3شکل 

، مقدار هشداربرای قطع خط روند انتخاب شده است. برچسب  KAMA(C,20) )اندیکاتور( مطالعهدر مثال زیر مقدار 

 هشدارتوان با دوبار کلیک روی برچسب را می هشداررا حذف کنید.  هشدار ’C‘دهد. با کلیک روی محل تقاطع کنونی را نشان می

 ویرایش کرد. Edit Alertو انتخاب  آنیا با راست کردن روی 
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 خط روند هشدار -162-3شکل 

 

 هاهشدارمعامله از طریق  3.30.4

برای  Tradeی ها روی برگههشدارانجام داد. در پنجره تنظیمات مربوط به  هشدارتوان هنگام صدور معاملات را می

 کلیک کنید. هشدارتعریف یک سفارش بر اساس صدور یک 

 
 Alertدر پنجره تنظیمات  Tradeی برگههای گزینه -163-3شکل 
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به  Limit ،Market ،Stopسفارشات قرار داد. سفارش  ،شودصادر می هشدارمتفاوت از جایی که  توان در ابزارمالیِمی

پیوست  Stop/Trailو/یا سفارش  Limit (Profit)توانید یک سفارش در صورت تمایل می شوند.عنوان انواع سفارشات پشتیبانی می

 کنید.

 هشدارتنظیمات پیشرفته  3.30.5

توانید مشخص نمود. در این برگه می هشدارهای دیگری را برای یک توان گزینهمی Advancedی با استفاده از برگه

 را تنظیم کنید. آننمایش ( و خصوصیات آن)یا انقضای  هشدارهای قابل اجرا بودن زمان

 
 هشدارتنظیمات پیشرفته  -164-3شکل 

Time In Force 

در صورت تمایل و  دیکن نییتع هشدار کی یزمان انقضا را برا/خیدهد تا تار یبه شما اجازه م Time In Forceبخش 

 .نیز مشخص کنید را توان فعال باشدمی هشدارساعاتی از روز را که 

1. Time Zone – های مشخص شده در این بخش همانند ناحیه زمانی تعریف شده برای نمودار است. ها و زمانتاریخ

 ناحیه زمانی را تغییر دهید. Use Defaultی توانید با غیر فعال کردن گزینهبا این حال می

2. Expires – ی با فعال کردن جعبهEnabled هشداررا مشخص کنید.  هشدارتوانید تاریخ وز مان منقضی شدن می 

 پس از انقضاء حذف خواهد شد.

3. Session 1 – تواند فعال باشد.کند که هشدار میزمانی از روز را تعیین می 

4. Session 2 –  کند.تعیین می هشداریک زمان ثانویه از روز را برای فعالیت 
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Display 

 تغییر دهید. هشدارفرض مربوط به صفات نمایش را برای یک دهد مقادیر پیشاجازه می Displayبخش 

 تاریخچه هشدارها 3.30.6

 دهد. این پنجره را با کلیک رویاند را نمایش میهشدارهایی را که در گذشته اتفاق افتاده Alert Historyپنجره 

 View -> Display -> Alert History را فعال کرده است هنوز موجود باشد، یک دکمه  هاآن باز کنید. اگر نموداری کهChart 

 برای نمایش نمودار منشاء هشدارها در دسترس خواهد بود.

 
 نحوه نمایش پنجره تاریخچه هشدار -165-3شکل 

 
 پنجره تاریخچه هشدار -166-3شکل 

شوند. زمان و مکان )چه قیمتی( و هشدار به طور مستقیم روی نودار مشاهده می تاریخی )پیشین(در ضمن هشدارهای 

های هشدار ساعت شکل قرار را روی یکی از آیکون ماوسشوند. اگر نشانگر ها به نمایش گذاشته میی آیکوناتفاق افتاده به وسیله

 هشدار را مشاهده کنید. آنجزئیات اطلاعات مربوط به توانید دهیدف می

 
 ی هشدارها روی نمودارمشاهده تاریخچه -167-3شکل 
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 مشاهده نمود. Alertsدر قاب  Historyی توان در برگهتاریخچه هشدار را می

 
 برای مشاهده هشدارهای پیشین Historyبرگه  -168-3شکل 

 تنظیمات هشدار 3.30.7

قرار  Alertsی پیکربندی نمود. تنظیمات هشدار در برگه Preferencesتوان در پنجره تنظیمات کلی هشدارها را می

 دارند.

 
 Alertتظیمات کلی  -169-3شکل 

 نوار تیکر 3.31
های مربوط به یک مجموعه انتخاب شده از ابزارهای مالی را در قسمت بالای کنسول، ای از قیمتمجموعه 1نوار تیکر

 فعال نمود. View -> Display -> Ticker Tapeتوان با انتخاب دهد. این گزینه را میدسکتاپ یا پنجره نمودار نمایش می

                                                           
1 - Ticker Tap 
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 فعال کردن نوار تیکر -170-3شکل 

 Ticker Tapی و زیربرگه Generalدر برگه  Preferencesتوان در پنجره مالی و نمایش نوار تیکر را میابزارهای

 این قاب شامل تنظیمات زیر است:پیکربندی کرد. 

1. Instruments – توان ابزارهای مالی را اضافه یا سمت چپ فهرست، می با استفاده از ابزار تعبیه شده در قسمت بالا

 را حذف کرد. هاآن

2. Font –  ابزارهای مالی نمایش داده شده روی نوار تیکر.اعمال تغییرات مورد نظر در فونت 

3. Scroll Speed – .تنظیم سرعتی نسبی پیمایش ابزارمالی در نوار تیکر 

4. Show Ticker Tape – فرض این نوار در منوی به طور پیشView->Display  وجود ندارد. با فعال کردن این گزینه

 شود.نوار تیکر در پنجره نمودار نمایش داده می

5. Show Change– تغییر از زمان باز شدن بازار. نمایش 

6. Show Change % - .نمایش تغییر بر حسب درصد از زمان باز شدن بازار 

 
 تنظیمات نوار تیکر -171-3شکل 
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 کلیدهای میانبر 3.32
MotiveWave آسان برای انجام سریع برخی وظایف عمومی برآورده کرده است. این بخش برخی از  هایروش برخی

 ها را رونمایی خواهد کرد.این گزینه

 های میانبرمنوی کلید 3.32.1

های موجود توجه کرده باشید که هنگام نمایش یک منو، یک کلید ترکیبی در سمت راست برخی از آیتم از اینپیششاید 

و مراجعه  ماوسآیتم، بدون استفاده از  آنتوان به عنوان میانبری برای دسترسی به نوشته شده است. این کلید ترکیبی را می ،در منو

 به منوها، استفاده کرد.

نمایش داده شده است. به این معنی است که  Ctrl + Shift + Lبر برای دسترسی به ابزار خط در مثال زیر، کلید میان

خود را  ماوسروی صفحه کلید )همه کلیدها در یک زمان(  Lو فشردن کلید  Shift( و Ctrl) Controlتوانید با نگاه داشتن کلید می

و برای بازکردن لیست کشویی ابزار  ماوسبزار خط با استفاده از به ابزار خط تغییر دهید. این روش بسیار سریعتر از جستجوی ا

 است. آنانتخاب 

 

 های میانبر صفحه کلیدکلید -172-3شکل 

ابزار،  آنبینی شده برای ابزار یک توالی از حروف گنجانده شده در های ترکیبی پیشتوجه داشته باشید کلید نکتهبه این 

 سازد.. این روش یادآوری کلید میانبر مربوط به ابزار را راحتر میبردمیبهره <Ctrl + Shift + <keyبه شکل 

 های میانبرسفارشی سازی کلید – 3.32.1.1

 Useی پیکربندی کرد. در ابتدا گزینه Keyboardی و در برگه Preferencesتوان در پنجره کلیدهای میانبر را می

Default هاآنتوانید روی هر یک از عملیات فهرست شده در این برگه دوبار کلیک کرده )یا این که را غیرفعال کنید. با این کار می 

 منتسب کنید. آن( و کلید میانبری را به کلیک کنید -آیکون مداد–را انتخاب کرده روی دکمه ویرایش 



 PiroozTrader  نمودارها –فصل سوم 

 

142 

 
 MotiveWaveهای میانبر در سفارشی سازی کلید -173-3شکل 

با فشردن یک توالی دلخواه از کلیدهای صفحه کلید، میانبری را به عملیات ، فقط لازم است Edit Shortcutی در پنجره

 خاکستری ظاهر خواهد شد.مورد نظر منتسب کنید. این توالی کلیدها در جعبه 

 
 پنجره ویرایش کلید میانبر -174-3شکل 

 ماوسچرخک  3.32.2

 د:نمودار استفاده کربرای اجرای اقدامات زیر روی توان می آنتان چرخک دارد، از اگر موس

1. Time Shift  )یا چپ )بسته به جهت چرخش چرخک(.حرکت دادن نمودار به سمت راست  -)تغییر زمان 
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2. Bar Width  )نمایی نمودار خواهد شد.نمایی یا بزرگباعث کوچک –)عرض میله 

3. Vertical Space  )دهد.فضای موجود در بالا یا پایین نمودار را تغییر می –)فضای عمودی 

را  Altزمان است. اگر کلید  تغییر آنفرض چرخانید، عمل پیشرا به سمت جلو یا عقب می ماوسهنگامی که چرخک 

 نمایی( تنظیم خواهد شد.نمایی و کوچکرا حرکت دهید، عرض میله )یعنی بزرگ ماوسنگه داشته و چرخک 

 پیکربندی نمود. Mouseو زیر برگه  General، برگه Preferencesی توان در پنجرهاین رفتارها را می

 
 ماوستنظیمات چرخک  -175-3شکل 

 ماوسهای کلیک  گزینه 3.32.3

توان را می ماوس( همراه با کلیک چپ Ctrl + Altو  Shift ،Ctrlهای صفحه کلید )یعنی عمکلرد استفاده از تغییردهنده

 فرض به شرح زیر هستند:برای انجام اقداماتی خاصی تغییر داد. رفتار پیش

1. Shift + Click –د یک جعبه ورود متن روی نمودار شواجرا می. وقتی این میانبر را کندمیایجاد  یک متن توضیحی

( را Esc)یا  Enterکلید  آنتایپ کرده و برای تکمیل  آنظاهر خواهد شد. فقط لازم است توضیحات خود را در 

 بفشارید.

2. Ctrl + Click – کندمیایجاد  ماوسگر یک خط راهنمای قیمت در محل قرارگیری اشاره. 

3. Ctrl + Alt + Click – دکن¬یمایجاد  ماوسگر یک خط راهنمایی زمان در محل قرارگیری اشاره. 

و سپس  Chartی پیکربندی نمود. برای این کار در پنجره مذکور به برگه Preferencesتوان در پنجره ها را میاین قابلیت

 به هریک از میانبرهای کلیک تشریح شده در بالا منتسب نمود: توانبروید. اقدامات زیر را می Chart Settingsی زیر برگه

1. Price Guide –  دکن¬یمترسیم  ماوسیک خط راهنمای قیمت در مکان. 

2. Horizontal Line –  دکن¬یمترسیم  ماوسدر مکان  )بسط یافته به سمت چپ و راست( یخط افقیک. 

3. Time Guide –  دکن¬یمترسیم  ماوسیک خط راهنمای زمان در مکان. 
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4. Vertical Line –  دکن¬یمترسیم  ماوسیک خط عمودی )بسط یافته به بالا و پایین( در مکان. 

5. Text –  دکن¬یمیک جعبه متن برای توضیحات مورد نظر ایجاد. 

6. Note – ی یک مولفهNote  دکن¬یمایجاد. 

7. Box Callout –  دکن¬یمیک مولفه نقل قول از نوع جعبه متن ایجاد. 

8. Balloon Callout –  دکن¬یمیک مولفه نقل قول از نوع بالن ایجاد. 

9. Line Callout – دکن¬یمایجاد  دارل خطویک مولفه نقل ق. 

10. Annotation –  دکن¬یمیک مولفه حاشیه نویسی از نوع کروشه ایجاد. 

11. Curly Annotation –  دکن¬یمیک مولفه حاشیه نویسی از نوع آکولاد ایجاد. 

 
 ماوسمیانبرهای مرتبط با کلیک چپ تنظیمات  -176-3شکل 

 سایر میانبرها 3.32.4

 سایر میانبرهایی که ممکن است مفید واقع شوند به شرح زیر هستند:

Ctrl + Mouse+ Drag )کپی( 

تواند برای ایجاد را به محل مورد نظر بکشید. برای مثال، این اقدام می آن ماوسرا نگاه داشته و با  Ctrlبرای کپی یک مولفه، کلید 

 به شکل زیر تغییر خواهید یافت: ماوسبا این کار نشانگر  تواند بسیار مفید باشد.خطی که موازی با خط دیگری است می

 
 ی انتخابی دارد:این تغییر شکل نشان از کپی شدن مولفه
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 کپی کردن خط -177-3شکل 

 (کلید فاصله – Space Barفرض )کلید بازگشت به ابزار پیش

( Time Dragابزار ماوس ) فرضپیش، به سرعت به ابزار با فشار دادن نوار فاصله دیتوان یابزار ماوس، م تغییرهنگام 

تا پس  دیده رییماوس را تغ یرفتار ابزارها دیتوانیمیا این که باشد.  Ctrl + Shift + Dتر از فشار دادن تواند راحتیم نی. ادیبرگرد

 Chartبرگه زیر و سپس Chart یتوانید در برگهرفتار را می نی. ادفرض برگردشی، به طور خودکار به ابزار پرداز اتمام عملک

Settings ی در پنجرهPreferences پیکربندی کنید. 

 
 ماوسفرض ابزار پیش -178-3شکل 
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 گری معامله 4
از  یبخش برخ نیدر ابینی شده است. پیش MotiveWaveهای زیادی برای قرار دادن و مدیریت معاملات درون روش

گری مانند های معامله. بعضی از ویژگیکرد دیخواه یها و معاملات را بررستیسفارشات، موقع مدیریت یمناسب برا یهایژگیو

 کاری داشته باشد.کارگزاری انتخابی شما برای فضایشده ممکن است بستگی زیادی به انواع سفارش پشتیبان

 مدیریت حساب 4.1
ها و تاریخچه معاملات در کنسول نمایی مناسب از اطلاعات حساب جاری و نیز سفارشات باز، موقعیت Accountصفحه 

ی انتخابی شما س دادههای نمایش داده شده در هر بخش بستگی به کارگزاری یا سرویدهد. ستونگران قرار میدر اختیار معامله

 دارد.

 
 Accountصفحه  -1-4شکل 

ی درون کنسول یا دسکتاپ اضافه توان هرجایها را میاست. این قاب Accountفرض صفحه تصویر فوق چیدمان پیش

 اضافه کنید، کلیک کنید. آنخواهید قاب را به که می ی( کنار برگه موجود+) Add Tabد. کافیست روی دکمه کر

 
 Accountافزودن قاب  -2-4شکل 
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 Accountقاب  4.1.1

های نمایش داده شده دهد. ستوناطلاعاتی در خصوص هر حساب موجود در فضای کاری نمایش می Accountقاب 

برای همه کارگزاران مشترک است و سود و زیان تحقق  Unrealized PLبسته به کارگزاری انتخابی متفاوت خواهند بود. ستون 

 دهد.هایی که متعلق به هر حساب است، نشان مینیافته فعلی را برای همه موقعیت

 
 Accountsقاب  -3-4شکل 

فرض است. با کلیک راست روی هر کدام از دهد کدام حساب برای قراردادن سفارش پیشمینشان Defaultستون 

فرض را تغییر دهید. این پیکربندی برای اجتناب از توانید حساب پیشمی Set As Default Accountها و کلیک روی حساب

 اشتباه بسیار مهم است.تصادفی در یک حساب سفارشات قراردادن 

 
 فرضحساب پیش -4-4شکل 

 Ordersقاب  4.1.2

 OCOسفارشاتی که به عنوان  Group . ستوناست سفارشات فعال کنونیمناسب برای مشاهده  سمکان ،قاب سفارشات
 Statusدهد. ستون نمایش میرا  اندکند( به هم پیوند خوردهمی)یکی دیگری را ارسال OSO 2کند( یا )یکی دیگری را لغو می1

 کلیک کنید. ’C‘هد. برای لغو یک سفارش فعال روی دوضعیت سفارش جاری )سفارش فعال به رنگ سبز( را نشان می

                                                           
1 - One Cancels Other 
2 - One Submit Other 
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 قاب سفارشات -5-4 شکل

کنید )تصویر زیر(. اگر سفارشی  ویرایش جاهمین از را سفارشات توانید می ،جدولمناسب در  سلول روی کلیک با

برای انتقال )ارسال( تغییرات به  ’T‘تغییر خواهد کرد. روی  ’D‘و  ’T‘برای نمایش  Statusای داشته باشد، ستون تغییرات برجسته

 برای لغو تغییرات کلیک کنید. ’D‘کارگزاری یا روی 

 
 ویرایش سفارش -6-4 شکل

ی پنجره سفارش، یک روی بر کلیک دوبار با. کنید راست کلیک سفارش یک روی اضافی، هایگزینه مشاهده برای

Order Ticket باز خواهد شد. 

 
 های قاب سفارشگزینه -7-4 شکل

 Positionsقاب  4.1.3

ها دهد. هر یک از موقعیتها( را نشان میهای باز کنونی ) و بسته شده مربوط به برخی کارگزاریموقعیت Positionsقاب 

ها را ببندید، روی یک موقعیت کلیک بست. اگر بخواهید همه موقعیت Closeتوان )در قیمت بازار(  با کلیک کردن روی دکمه را می

 را انتخاب کنید. Close All Positionsراست کرده و گزینه 
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 هاقاب موقعیت -8-4 شکل

با کلیک روی  توانید، می( فعال باشدرا مطالعه کنید Simulated Accountبا عنوان  4.2بخش شده )سازیحساب شبیهاگر 

Add Position (+) این هایی را به این قاب اضافه کنید. به صورت دستی موقعیتبالا و سمت راست این قاب،  واقع در قسمت

تواند مفید باشد. تصویر زیر می، شوندای مدیریت میهایی را که خارج از کارگزاری یا سرویس دادهموقعیتویژگی برای رهگیری 

 ا دارد:های زیر ردهد. این پنجره فیلدرا نشان می Add Positionپنجره 

1. Instrument – مالی را انتخاب کنید.نماد مرتبط با ابزار 

2. Opened Date – .برای زمانی است که موقعیت در ابتدا باز شده باشد 

3. Quantity – غیره. و قراردادها ، سهام (عدادکمیت )ت 

4. Avg Price – .میانگین قیمت ورودی برای موقعیت 

5. Commission - کنید واردمقدار کمیسیون معالات را  ها،هزینه پیگیری برای اختیاری صورت به. 

 
 Add Positionی پنجره -9-4 شکل

 می ارائه ،شده بسته اخیراً  های موقعیت مانند ها،موقعیت مورد در یبیشتر اطلاعات( FXCM مانند) کارگزاران از برخی

 شده گرفته نظر در هاموقعیتتک تک کردن جمع برای Summary برگه یک ،FXCMهایی مانند حساب برای خاص طور به. دهند

 .است

 
 های بازموقعیت -10-4 شکل
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 هاخلاصه موقعیت -11-4 شکل

 
 های بسته شدهموقعیت -12-4 شکل

 Tradesقاب  4.1.4

نمایش داده شده در این  یهاستون دهد.( را نشان میاست پرشدهمنظور معاملات )معاملات  تاریخچه قاب معاملات

ها فقط تعداد محدودی از معاملات کارگزاریکاری متفاوت هستند. برخی صفحه، بسته به کارگزاری انتخاب شده برای فضای

 ارائه حساب مدیریت ابزارهای به باید ،تاریخی معاملات دقیق گزارش از اطمینان برای دلیل، همین بهکنند. را گزارش می تاریخی

 .کنید اعتماد خود کارگزار توسط شده

 
 معاملاتقاب  -13-4 شکل

4.2 Simulated Account 
برای تمرینات  آنتوانید از درون ساخت دارد که می سازی شدهحساب شبیهیک  MotiveWaveبرای راحتی کار، 

فرض فعال خواهد به طور پیشکاری خود انتخاب کنید، آنگاه این حساب ای برای فضایدادهمعاملاتی خود استفاه کنید. اگر سرویس

)به شرطی  کنید استفاده آزمایشی حساب یک از ،یکارگزارجای به که شود می توصیه کنید،کارگزاری استفاده میشد. اگر از یک 

 از پشتیبانی و معاملات محیط از بهتری سازیشبیه ی،کارگزار آزمایشی هایحسابحساب آزمایشی را ارائه کند(.  آنکه کارگزاری 

 .دنده می ارائه هاآن رفتار و سفارشات انواع

 Simulatedی و زیر برگه General، برگه Configure -> Preferencesتوان با مراجعه به را می سازی شدهحساب شبیه

Account های زیر است:پیکربندی کرد. این قاب حاوی فیلد 

1. Enabled – .این حساب را فعال یا غیر فعال کنید 
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2. Base Currency – ص کنید.واحد پول پایه برای این حساب را مشخ 

3. Cash Balance - را تعیین کنید. اولیه نقدی مانده 

4. Fill Immediate –  ،مقدار  بلافاصله بااگر فعال باشد، سفارشات بازار به جای انتظار برای معامله بعدی

 پر خواهد شد.عرضه/تقاضای جاری 

5. Include Commission – د شد.نخواه محاسبهها هنگام قراردادن معاملات اگر فعال باشد، کمیسیون 

6. Reset Account – ی نقدی، روی این دکمه کلیک کنید.برای بازنشانی حساب به مقدار اولیه مانده 

 
 سازی شدهحساب شبیهتنظیمات  -14-4 شکل

برای این حساب، یک ورودی خواهید دید. شناسه این  Accountsرا فعال کنید، در قاب  سازی شدهحساب شبیهاگر 

 است. ”Simulated‘حساب عبارت 

 
 Accountsسازی شده در قاب ورودی حساب شبیه -15-4 شکل

 ها کمیسیون 4.3
سازی شده، در حالت بازپخش یا به عنوان قسمتی از توان با استفاده از حساب شبیهمی MotiveWaveها را در کمیسیون

Strategy Back Testing را در پنجره  آنی بایست تنظیمات اولیهها محاسبه گردد، میخواهید کمیسیونمحاسبه نمود. اگر می

Configure -> Commissions :پیکربندی کنید 

1. Base Cost – گونها نرخ ثابتی برای کارمزد خود دارند. اگر اینهی یک معامله است. برخی کارگزاریی پایههزینه 

 است، فقط هزینه را اینجا وارد کنید.
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2. Unit Cost – واحدهایی که بخشی از یک سفارش است )مانند سهام، تعداد(  ای) کمیتها براساس برخی کارگزاری

 کنند.هزینه دریافت می ...( ،قراردادها و 

3. Unit Size – است 1لات اندازه این ، باشد شده مشخص واحد هزینه اگر. 

 
 پنجره کمیسیون -16-4 شکل

برخی ابزارمالی ساختار  ، تعریف کنید.ابزارمالینوع  بسته بهدهد تا ساختار کمیسیونی را پنجره فوق این امکان را به شما می

تغییر دهید. برای این کار  Instrumentرا با استفاده از پنجره  آنتوانید کمیسیون مخصوص به خود را دارند. در این گونه موارد، می

 مراجعه کنید. Commissionsی به برگه Edit Instrumentروی نمودار کلیک راست کرده و بعد از کلیک روی 

 
 خاص ابزارمالیتغییر کمیسیون  -17-4 شکل

 2تنظیمات سفارش پیش 4.4
ها را براساس نوع فرضتوان پیشهستند. به طور کلی می مناسب سفارش فرضپیش صفات تعریف برای تنظیمات پیش

-توان به پیشاز نوار منوی کنسول، می Configure -> Order Presetsتعریف نمود. با انتخاب  هاآنهای ابزارمالی یا مشخصه

 ای برای هر نوع ابزارمالی دارد. هر قاب دارای فیلدهایی به شرح زیر است:تنظیمات کلی سفارش دسترسی پیدا کرد. این پنجره برگه

                                                           
1 - Lot گرمعامله یک که چرا ،است سرمایه و ریسک مدیریت در مهم معیارهای از یکی همچنین و باشدمی شما معاملات حجم گیری اندازه واحد معنای به 

 و سکیر مدیریت برای ابزاری نوعیهب باشد، کندمی معامله یک وارد که ای سرمایه حجم مراقب ،کندمی شناسایی که هاییموقعیت بهترین در حتی باید

 .آید می حسابهب سرمایه
2 - Order Presets 
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1. Order Type –برای قراردادن. فرض سفارشنوع پیش 

2. Time In Force – .زمان انقضاء سفارش را تعریف کنید. انواع موجود به کارگزاری بستگی دارد 

3. 1igger OTHrT –  خارج از ساعات معمول معاملات ارسال خواهد شد.اگر فعال باشد، سفارش 

4. Offset – ( از قیمت جاری تا هنگام قراردادن یک سفارش3مقایس پیپ درفرض )پیش 2آفست. 

5. Limit Offset – فرض )در مقیاس پیپ( از قیمت جاری هنگام قراردادن یک سفارش آفست پیشLimit4. 

6. Stop Offset – فرض )در مقیاس پیپ( از قیمت جاری هنگام قرارداد سفارش آفست پیشStop5. 

7. Trail Offset – فرض )در مقیاس پیپ( از قیمت جاری هنگام قراردادن یک سفارش آفست پیشTrail. 

8. Default Quantity – فرض هنگام ایجاد یک سفارش جدید.پیش کمیت 

9. Increment – .اندازه افزایش )یا کاهش( هنگام تنظیم کمیت سفارش 

10. Preset Quantities - فیلددر کنار هر  ییکشو یمنو کیطریق از فهرست، موجود در  ریمقاد Quantity  در دسترس

 دسترس هستند.در  زین DOMدر  Quantity Selectorاز  ریمقاد نیخواهد بود. ا

 
 General Order Presetsپنجره  -18-4شکل 

                                                           
1 - Outside of Trading Hours 

 .فاصله قیمت سفارش نسبت به قیمت جاری است آفست - 2
3 -Pip  - د.شو می نامیده ”پیپ“ ارز دو بین تغییرارزش بیان برای گیری اندازه واحد 
4 Limit Order - وجود تضمینی هیچ دهید می قرار را سفارش نوع این وقتی .میباشد خاص قیمت یک در فروش و خرید سفارش یک محدود سفارش 

 .برسد اید کرده ذکر سفارش در که ای¬محدوده به قیمت که شود می فعال صورتی در فقط است طبیعی و گردد( اجرا) فعال شما سفارش که ندارد

سفارش  متیبازار، ق کهیباشد. زمان دهیشده در سفارش متوقف رس نییتع متیبازار به ق متیشود که ق یاجرا م کارگزارتوسط  یسفارش متوقف، زمان کی - 5

 ،(Buy Stop) دیخردر سفارش متوقف  متیکند. ق ی( را به بازار ارسال مMarket Orderبازار ) متیسفارش به ق کیشما  کارگزارمتوقف را لمس کند 

 شود. یبازار قرار داده م یتر از نرخ جار نیی(، پاSell Stopسفارش متوقف فروش ) کی نیشود. همچن یم نییبازار تع یبالاتر از نرخ جار
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ابزارمالی مورد نظررا در حالت ویرایش باز کرده تنظیمات سفارش رابرای ابزارمالی خاصی تغییر دهید، اگر بخواهید پیش

در پایین پنجره کلیک  Order Presetsرا انتخاب کنید( و روی دکمه  Edit Instrument)روی یک نمودار کلیک راست کرده و 

 کنید.

 
 Edit Instrumentپنجره  -19-4شکل 

 
 ابزارمالیتنظیمات پیش -20-4شکل 

 گری با نمودار معامله 4.5
استفاده از ابزار موجود روی یک نمودار است. چندین  MotiveWaveشاید راحترین راه برای ایجاد یک سفارش در 

 روش برای انجام این کار وجود دارند:

 توان به طور مستقیم از طریق محور قیمت انجام داد.معاملات را می –محور قیمت  .1

 توان به روی یک نمودار اضافه نمود.را می Buy/Sellدکمه  در صورت تمایل – Buy/Sellهای دکمه .2

 های معامله موجود در این منو استفاده کنید.توانید از آیتمبا کلیک راست روی نمودار می – Contextمنوی  .3
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 را در سمت راست یک نمودار به نمایش درآورد استفاده کنید. آنتوان از قاب معامله که می – Tradeقاب  .4

طریق  آنتوانید سمت راست نمودار به نمایش درآوده و از ( را میDepth of Marketقاب عمق بازار ) – DOMقاب  .5

 معامله خود را انجام دهید.

معاملات خود را  هااستراتژیتوانید با استفاده از تشریح گردید، می هااستراتژیهمانطور که در بخش  – هااستراتژی .6

 تنظیم و انجام دهید.

 دارسفارشات نمو 4.5.1

ای نمایش یا عدم نمایش . برنمود میداده و تنظ شینمودار نما یرو توان به طور مستقیمرا میسفارشات فعال و پر شده 

 .دیکن کیدر نوار ابزار کل Show Ordersدکمه  سفارشات موجود روی یک نمودار، روی

 
 موجود روی یک نمودارسفارشات  -21-4شکل 

فرض، سفارش به سمت بالا یا پایین تنظیم نمود. به طور پیش آنتوان با کلیک و کشیدن برچسب قیمت یک سفارش را می

قاب  4.1.2 تغییر دهید )به بخش Preferencesی توان در پنجرهفرش را میبراساس قیمت تغییر یافته ارسال خواهد شد. این پیش

Orders .)ی اگر گزینه مراجعه کنید“Auto Submit Modified Orders”  ،رش تغییریافته به برای ارسال سفاغیرفعال باشد

 را کلیک کنید. ’T‘نیاز خواهد بود که دکمه کارگزاری، 

 
 سفارشات نمودار -22-4شکل 
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 تنظیم قیمت سفارش در نمودار -23-4شکل 

به نمایش درخواهد آمد. با کلیک راست روی همین  Order Ticketپنجره  ،سفارشبا دوبار کلیک کردن روی برچسب 

 در منوی محتوی ظاهر شده نیز می توان به این پنجره دسترسی یافت. Edit Order Ticketی برچسب و انتخاب گزینه

 
 منوی محتوی سفارش -24-4شکل 

 معاملاتتاریخچه  4.5.2

در نوار ابزار نمایش داد. اطلاعات  Show Tradesتوان به طور مستقیم با کلیک کردن روی دکمه تاریخچه معاملات را می

 های معامله به نمایش در آورد.لشروی یکی از فِ ماوستوان با قرار دادن نشانگر مربوط به هر معامله را نیز می
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 تاریخچه معاملات -25-4شکل 

 قیمت گری با محور معامله 4.5.3

سفارش  دیخواه یکه م ییاایجاد کرد. برای این کار کافیست ج متیمحور ق روی به طور مستقیمتوان  یسفارشات را م

شکل هدف به  ماوسرا روی محور قیمت حرکت دهید، متوجه خواهید شد که نشانگر  ماوسیجاد شود، کلیک کنید. اگر ا یمحدود

یابد. در ضمن متوجه برچسبی خواهید شد که قیمت تغییر شکل می (دیباش یفعل متیاز ق نییپا ایکه بالاتر  نیبسته به ا) قرمز/آبی

 دهد.را نشان می

 
 Limit Buyسفارش از نوع  –معامله با محور قیمت  -26-4شکل 

 متیق آندر  ی، سفارش محدود مالیفرض ابزارشیتا با استفاده از مقدار پ دیبار فشار ده کیدکمه سمت چپ ماوس را 

بالای قیمت جاری منجر به  ماوسقراردادن نشانگر : نکته. (دیکنمراجعه  تنظیمات سفارش پیشبا عنوان  4.4)به بخش  دیکن جادیا

 ایجاد خواهد کرد. Limit Buyسفارش از نوع  آنو در پایین  Limit Sellایجاد سفارش 

توانید فرض این سفارش فقط ایجاد خواهد شد و به سمت کارگزار ارسال نخواهد شد. در صورت تمایل میبه طور پیش

 ارسال کنید. ( سفارش را به کارگزار خودTransmit)اول حرف  ’T‘این سفارش را تغییر داده و با کلیک روی دکمه 
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 تنظیم سفارش با استفاده از محور قیمت -27-4شکل 

 انواع سفارشات محور قیمت 4.5.3.1

توانید بر روی محور قیمت قرار دهید. برای این کار نیاز است که یکی از کلیدهای زیر انواع مختلفی از سفارشات را می

فرضی خواهد بود که به ابزارمالی همه این سفارشات مقدار پیش کمیتروی محور قیمت، نگه دارید.  ماوس را هنگام کلیک چپ

 اید.اختصاص داده Quantityدر فیلد  مورد نظر

 .ماوس خواهد بود یمقدار در مکان فعل ،محدود متیق، Limit Orderکلید: بدون  .1

a. Limit Buy –  زیر قیمت جاری است. ماوسنشانگر 

b. Limit Sell –  بالای قیمت جاری است. ماوسنشانگر 

 خواهد بود. ماوس، قیمت توقف، مقدار در مکان فعلی Ctrl :Stop Orderکلید  .2

a. Stop Buy – .نشانگر ماوس بالای قیمت جاری است 

b. Stop Sell –  .نشانگر ماوس زیر قیمت جاری است 

 سفارش خرید یا فروش در قیمت جاری بازار )بر اساس بهترین عرضه یا تقاضا(. – Shift :Market Orderکلید  .3

a. Buy Market – .نشانگر ماوس زیر قیمت جاری است 

b. Sell Market –  بالای قیمت جاری است. ماوسنشانگر 

همراه با  Limit Orderیک  –پیوست شده  Ctrl + Shift :Limit Order   +Limit & Stop Orderکلید ترکیبی  .4

 Limit Orderبه  Stop Lossو  Limitقرار داده خواهد شد. یک سفارش  ماوسقیمت محدود معادل با مکان جاری 

 )والد( پیوست خواهد شد.

a. Buy Limit + Sell Stop/Limit  

b. Sell Limit + Buy Stop/Limit  
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اید، به یکی از تغییردهنده را نگاه داشتهدر هنگام حرکت نشانگر ماوس روی محور قیمت، بسته به این که کدام کلید 

 های ترسیمی در بندهای فوق، تغییر شکل خواهد یافت.شکل

 منوی محتوی محور قیمت 4.5.3.2

 منوی محتوی )کلیک راست روی محور قیمت( نیز دستوراتی برای ایجاد سفارشات دارد )تصویر زیر را مشاهده کنید(:

 
 منوی معاملات روی محور قیمت -28-4شکل 

 Buy/Sellهای  دکمه 4.5.4

-ه عنوان برچسبها ب( را به نمودار اضافه کرد. این دکمهBuy & Sellهای خرید و فروش )توان دکمهبرای سادگی کار، می

کلیک  آنار کلیک کنید )یا روی روی نمودار دوب Chart Settingsگیرند. برای بازکردن پنجره های نمودار در دسترس قرار می

 قرار دارند. Labelی در برگه Sell Buttonو  Buy Buttonهای را انتخاب کنید(. برچسب Chart Settingsی راست کرده و گزینه

 
 Buyو  Sellهای سازی دکمهفعال -29-4شکل 
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 کیدر نمودار هستند کل ماًیکه مستق Sell ای Buy یدکمه ها ی، رودیکن جادیفروش ا ای دیسفارش خر دیخواه یاگر م

 .دیاستفاده کن آناز  سفارش خود جادیا یبرا دیتوانیشود که م یباز م Order Ticketپنجره کار  نی. با ادیکن

 
 Sellو  Buyهای دکمه -30-4شکل 

د ممکن است متفاوت به نظر برسد. پنجره زیر مربوط به فضای کنیبسته به کارگزاری که استفاده می Order Ticketپنجره 

 است: CQGکاری پیکربندی شده برای کارگزار 

 
 Order Ticketپنجره  -31-4شکل 

 منوی محتوی 4.5.5

 هایی برای قراردادن سفارشات و تغییر تنظیمات معاملاتی دارد.ک راست روی ناحیه نمودار( گزینهمنوی محتوی )کلی

 
 های معاملاتی در منوی محتویگزینه -32-4شکل 
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 Tradeقاب  4.5.6

توان با انتخاب نمودار است. این قاب را میها از روی ابزاری مناسب برای مدیریت سفارشات و موقعیت معامله،قاب 

View -> Display -> Trade Panel یا با فشردن کلید ماینبر  در نوار منوی بالا به نمایش درآورد(Alt + T کردرا باز  آن).  در نوار

 یا عدم نمایش این قاب وجود دارد.ای برای نمایش ابزار دکمه

 کند.مختلفی را برای یک معامله ارائه میهای سه برگه دارد که گزینه Tradeقاب 

 Positionبرگه  4.5.6.1

 د:نشومدیریت نمود. عناصر زیر در این برگه مشاهده میرا توان موقعیت جاری در نمودار ابزارمالی می Positionدر برگه 

1. Buy Market –  کند.معین در قیمت بازار ایجاد می کمیتییک سفارش بازار برای خرید در 

2. Sell Market –  کند.معین در قیمت بازار ایجاد می کمتییک سفارش بازار برای فروش در 

3. Quantity –  تنظیمات سفارش ثبت در پیش آنفرض کند. مقدار پیش( سفارش بازار را مشخص میتعداد)کمیت

 شده است.

4. Flatten – .اگر در حال حاضر موقعیت بازی دارید، این دکمه موقعیت را در قیمت بازار خواهد بست 

5. Cancel All – های بازی برای نمودار ابزارمالی دارید، این دکمه این سفارشات را لغو خواهد کرد.اگر سفارش 

6. Break Even –  یک سفارش خروج در قیمتBreak Even1. 

7. Reverse –  باز خواهد کرد.  آنرا بسته و موقعیتی در جهت عکس  آناگر موقعیت بازی داشته باشید، این دکمه

هزار ابزارمالی )سهم یا قرارداد و ...( هستید، این موقعیت بسته شده و  10برای  2 در موقعیت خریدبرای مثال، اگر 

 هزار ابزارمالی باز خواهد شد. 10برای  3موقعیت جدید فروش

8. Account Choice– انتخاب کنید.ات حساب مورد نظر خود را برای سفارش توانیددر این لیست کشویی می 

9. Position Lable – عبارت موقعیت جاری را نمایش می این برچسب( دهدN/A  اگر .)زمینه پسبرای عدم موقعیت

منفی  آنزمنیه قرمز داشته و عدد کمیت پس Shortهای است. موقعیت Longبی باشد، موقعیت از نوع آبرچسب 

 به پاورقی همین صفحه مراجعه کنید(. Shortو  Longاست )در خصوص مفاهیم 

10. P/L Lable –  زمینه قرمز دهد. زیان حاصله با پسسود/زیان تحقیق نیافته برای موقعیت باز را نمایش میاین برچسب

شود. اگر موقعیت بازی وجود نداشته باشد، این یش داده مینما زمینه آبیو علامت منفی و سود حاصله نیز با پس

 را نمایش خواهد داد. N/Aبرچسب حروف 

                                                           
توقف نقطه  یوقت ،هیصفر. در اصطلاح بازار سرما انیسود و ز یعنی(. سکیو درآمد هست )بدون ر نهیسر شدن هزه سرب یبه معن یاقتصاد اتیدر ادب - 1

(Stop) به نقطه ورود( توقف)انتقال  دیشویخارج م موقعیتشما بدون ضرر از  لمس شودهم  موقیعت توقفاگر  جهی. در نتشودیبه نقطه ورود منتقل م. 

2 positionLong  -  مفهومLong  ترجمه شده است، اما در واقع اصطلاح تخصصی این کلمه و نیز کلمه  ’خرید‘در اینجا با کلمهShort  فروش( در(

 آنبه امید کاهش قیمت  آنتوان با قرض گرفتن یک دارایی و فروش می آنبازارهای دو طرف آتی، برخی جفت ارزها و ارزهای دیجیتال کاربرد دارد که در 

 دارایی، سود کسب کرد.
3 Short Position –  مفهوم قبلی در خصوص کلمه بهLong .مراجعه فرمایید 
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 Tradeدر قاب  Positionبرگه  -33-4شکل 

 Orderبرگه  4.5.6.2

های توان با کلیک روی دکمهجدید را می تشود. سفارشابرای ایجاد یا تغییر سفارشات موجود استفاده می Orderبرگه 

Buy  یاSell ویرایش کرد. روی نمودار )روی برچسب سفارش کلیک چپ کنید( آنتوان با انتخاب انجام داد. سفارش موجود را می 

1. Buy – دهد سفارش از نوع خرید است یا فروش. اگر سفارشی روی نمودار انتخاب نشده باشد، با کلیک نشان می

 ایجاد کنید. خریدتوانید یک سفارش دکمه میروی این 

2. Sell – دهد سفارش از نوع خرید است یا فروش. اگر سفارشی روی نمودار انتخاب نشده باشد، با کلیک نشان می

 توانید یک سفارش فروش ایجاد کنید.روی این دکمه می

3. Quantity – فرض این فیلد برابر با قدار پیشکمیت برای سفارش انتخاب شده. اگر سفارش از نوع جدید باشد، م

 تنظیمات سفارش خواهد بود.مقدار تعیین شده در پیش

4. Type –  با توجه به نوع کارگزاری(.  خدمات ارائه شده از سوی )بسته بهرا نشان خواهد داد فهرستی از انواع سفارش

 واهند یافت.تغییر خ ،آنهای قابل رویت زیر کنید، ایتمسفارشی که در این فیلد انتخاب می

 دیده شوند. Typeبسته به نوع سفارش این فیلدها ممکن است زیر فیلد نوع  – Limit/Stopقیمت  .5

6. Expires –  کند. سفارشات برای سفارش را تعیین می مؤثرزمانDay  در پایان روز منقضی خواهند شد. سفارشات

GTS1  موجود در این فیلد بسته به کارگزاری شما متفاوت  هایرا لغو کنید. موقعیت هاآنفعال خواهند ماند تا این که

 خواهد بود.

7. Limit –  از این گزینه برای انضمام یک سفارشLimit  سود( استفاده کنید. این سفارش هنگامی که سفارش اولیه پر(

 شود فعال خواهد شد.

                                                           
1 - Good Till Cancelled 



 PiroozTrader  گریمعامله –فصل چهارم 

 

164 

8. Stop –  از این گزینه برای انضمام یک سفارشStop  که سفارش اولیه پر شود و اسفاده کنید. این سفارش هنگامی

 در بند قبلی باشد، فعال خواهد شد. Limitهمراه با سفارش OCO1یک سفارش 

9. Trail –  از این گزینه برای انضمام یک سفارشStopTrailing  2 به جای سفارش(Stop .استفاده کنید )در بند قبلی 

10. Submit/Modify – کنید. این دکمه برای سفارشات از نوع  برای ارسال سفارش به کارگزاری روی این دکمه کلیک

 زمینه آبی خواهد داشت.زمینه قرمز و برای سفارشات خرید، پسفروش، پس

11. Discard/Cancel – .از این دکمه برای انصراف )برای سفارشات جدید( یا لغو سفارش استفاده کنید 

12. Account – ای سفارشات جدید، مقدار اولیه این در لیست کشویی موجود، حسابی را برای سفارش انتخاب کنید. بر

 شود(.تعیین می Accountsفرض خواهد بود )این مقدار در قاب پیش Primaryفیلد برابر با حساب 

 
 Tradeدر قاب  Orderبرگه  -34-4شکل 

 Bid/Askبرگه  4.5.6.3

دهد. این برگه )همراه با بهترین قیمت عرضه و تقاضا( را نشان می Buy/Sellجعبه  ،)عرضه و تقاضا( Bid/Askبرگه 

. با استتقاضا /عرضه یها متیق نیب متیق 3نظارت بر اختلافمکانی مناسب برای قراردادن سفارشات خرید و فروش در بازار و 

 ارسال کنید. Marketتوانید سفارشی از نوع می Buyیا  Sellهای دوبار کلیک کردن روی جعبه

                                                           
1 - One Cancels Other 

 سکینمودار و با توجه به نسبت پاداش به ر طی. بر اساس شرادیثابت فرض کن انیبا حد ز یمعاملات تیموقع کی -حد ضرر متحرک یا دنبال کننده  - 2

امر تا زمان  نیجا شود. ابه سود، جا  یشرویپ ریبه همان اندازه و در مس زیبازار، حد ضرر ن یحرکت یهااز گام یمشخص زانیم یکه به ازا دیکنیم نیمعامله، مع

 ندی. فرآشودیانجام م ان،یو مکرر حد ز یاپله راتییسود توسط تغ بیتعق اتیحد ضرر )نقاط خروج از معامله( ادامه داشته و عمل ایبه حد سود  متیق دنیرس

 ریدر مس فاًآن هم صر ان،یحد سود ثابت بوده و فقط حد ز ه،یرو نیا یکه ط دی. توجه داشته باششودیم دهیاستاپ نام نگیلیتر ایمذکور، حد ضرر متحرک 

 .ابدییم رییمعاملات تغ یسودده

3 - Spread - شودتامین می ونیاز اسپرد و کمس ها¬یکارگزاردرآمد . شود¬یدرآمد کارگزار حساب م قتیو فروش هست که در حق دیخر متیتفاوت ق. 
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 Tradeدر قاب  Bid/Askبرگه  -35-4شکل 

 Entry/Exitهای  استراتژی 4.5.6.4

آورد. بخش روشی مناسب برای قراردادن ترکیبی از سفارشات در یک کلیک فراهم می Entry/Exitهای استراتژی

Entry/Exit  علاوه بر قابTrade  در قابDOM فرض پنهان است( نیز قابل مشاهده است.)عمق بازار که به طور پیش 

لیک روی دکمه ویرایش، توان با کرا می هااستراتژیدهد. را نشان می Tradeمربوط به قاب  Entry/Exitتصویر زیر بخش 

 یا حذف کرد. ته بالا سمت راست این بخش، ایجاد، اصلاحقرار گرف

 کلیک کنید. Executeانتخاب کرده و روی دکمه  هااستراتژیرا از لیست کشویی  آنی را اجرا کنید، استراتژیاگر بخواهید 

 توان در فیلدهای زیر تنظیم نمود:را می Offset Sizeو  Lot Size ،Time In Forceپارامترهایی مانند 

 
 Entry/Exitتنظیمات  -36-4شکل 

MotiveWave  استفاده کرده یا این که متناسب با نیازهای خود  هاآنتوانید از درون ساخت دارد که می استراتژیچندین

 را صلاح کنید: هاآن

1. Breakout –  سفارشاتی از نوعBuy/Sell Stop  از نوعOCO (One Cancels Other در بالا و پایین قیمت جاری )

 نی، ادیروند را دنبال کن دیشود و بخواه ادیکم و ز متیق کینزد ندهیکه در آ دیانتظار داراگر کند. بازار ایجاد می

 باشد. دیتواند مف یم استراتژی
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2. Fade –  سفارشاتLimit OCO کند.بالا و پایین قیمت جاری بازار ایجاد می 

3. Brk Up/Fade Down –  یک سفارشBuy Stop  بالای قیمت جاری( و یک سفارش(Buy Limit Order  زیر(

 کند.ایجاد می (Longخرید ) موقعیت ( برای ورود بهOCOقیمت جاری( )سفارشات 

4. Brk Dn/Fade Up –  یک سفارشSell Stop (و یک سفارش  زیر )قیمت جاریSell Limit  )زیر قیمت جاری(

 ( ایجاد کنید.Short( برای ورود به موقعیت فروش )OCO)سفارشات 

5. Bracket Exit –  یک سفارشLimit  برای خروج از یک موقعیت و یک سفارشStop  به عنوان یکStop Loss 

 هستند. OCOکند. هر دوی این سفارشات از نوع ایجاد می

6. Scale Out-2 –  دو سفارشLimit Exit  و دو سفارشStop Loss کند.گذاری از یک موقعیت ایجاد میبرای مقیاس 

 .کند¬یم جادیا تیموقع کیاز  گذاری¬اسیمق یبرا Stop Lossسفارش  سهو  Limit Exitسفارش  سه .7

 توان با کلیک روی دکمه ویرایش مدیریت نمود. با این عمل پنجره زیر باز خواهد شد:را می Entry/Exitهای استراتژی

 
 Entry/Exitهای استراتژیپنجره مدیریت  -37-4شکل 

 Editهای موجود را انتخاب کرده و روی استراتژیکلیک کنید یا یکی از  Newجدید روی دکمه  استراتژیبرای ایجاد یک 

 استراتژیرا برای این  Exitو/یا  Entryتوانید سفارشات ظاهر خواهد شد. در این پنجره می Entry/Exit Strategyکلیک کنید. پنجره 

نیز ایجاد خواهد شد.  Exitسفارشات  ،Entryبا پرشدن سفارشات  خابی از هر دو نوع داشته باشند،انت استراتژیاگر  پیکربندی کنید.

 فیلدهای موجود در این پنجره به شرح زیر هستند:

1. Name –  استراتژینام Entry/Exit .بوده و در لیست کشویی نمایش داده خواهد شد 

2. Absolute Offset – آفست در اندازه آفست موجود در قاب فرض به طور پیشEntry/Exit  ضرب خواهد شد. اگر

 آفست مطلق مشخص کنید، از آفست همانگونه که هست استفاده خواهد شد.

3. Offset – ها( از قیمت جاری است. اگر گزینه فاصله )در تیک آفستAbsolute Offset  انتخاب نشود، این مقدار

 ضرب خواهد شد. Entry/Exitدر اندازه آفست موجود در قاب 

4. Lots – شود. این تعداد در مقدار لات موجود در قاب های معامله که به عنوان مقدار سفارش تعیین میتعداد لات

Entry/Exit .ضرب خواهد شد 
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Entry Orders 

تواند یک یا دو سفارش داشته د. هر ورودی میتوان تعریف کررا میحداکثر پنج سفارش ورودی برای یک استراتژی 

یکی دیگری را کنسل  - OCO (One Cancels Otherباشد. اگر دو سفارش تعیین شود، آنگاه این سفارشات به عنوان یک جفت 

 کند( ارسال خواهند شد.می

 
 Entry/Exit Strategyپنجره  -38-4شکل 

Exit Orders 

ورودی داشته  اتسفارش ،استراتژید. اگر این سفارش خروج تعریف کر 5توان حداکثر همانند سفارشات ورودی، می

 (1)سفارش دریافت سود Limitتواند یک هر خروج می ایجاد خواهند شد. خروجپس از پرشدن ورودی متناظر، سفارشات باشد، 

ارسال خواهند شد. اگر  OCO( داشته باشد. این سفارشات به عنوان یک جفت Stop Loss)سفارش  Stop/Trailو یک سفارش 

 انتخاب شود، اندازه لات برای مطابقت با موقعیت باز فعلی تنظیم خواهد شد. Auto Adjust Sizeی گزینه

 
 Exitسفارشات  -Entry/Exit Strategyپنجره  -39-4شکل 

                                                           
1 - Profit Taking Order 
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 Preferencesتنظیمات سفارشات در پنجره  4.5.7

 تغییر داد: Preferencesی در پنجره Ordersی توان از طریق برگهرفتار و ظاهر سفارشات را می

1. Price Axis Trading – کند.توانایی معامله با محور قیمت را فعال یا غیرفعال می 

2. Buy/Sell Box Trading – های توانایی معامله با جعبهBuy/Sell کند.را فعال یا غیرفعال می 

3. Use Pips for Attached Orders – شود.هنگام تعیین آفست از سفارش اصلی، به جای قیمت از پیپ استفاده می 

4. Confirm Closing Positions –  هنگام کلیک روی دکمهClose ای جهت تایید نمایش داده یک موقعیت، پنجره

 خواهد شد.

5. Auto Submit Modified Orders –  اگر این گزینه فعال باشد، با جابجا کردن سفارش روی نمودار، تغییر قیمت

 رییانتقال تغ یبرا یمرحله اضاف کیبه  نکهیا یبه جاحاصله به طور خودکار به سمت کارگزاری گسیل خواهد شد )

 د(.یشداشته با ازین "T"دکمه  یکردن رو کیبا کل

6. Send Email on Filled Order – شود، ایمیلی به آدرس الکترونیکی تایید شده ارسال هنگامی که سفارشی پر می

مراجعه  تنظیم ایمیلبا عنوان  2.10نیاز است که تنظیمات ایمیل را از قبل انجام داده باشید )به بخش  :نکتهشود. می

 کنید(.

7. Send Email on Rejected Order – خورد، ایمیلی به آدرس الکترونیکی تایید هنگامی که سفارشی برگشت می

 شود.شده ارسال می

8. Show Client OCO Warning –  هنگام قراردادن یک سفارش از نوعClient OCOشود. ، یک هشدار نمایش داده می

را در  OCOسفارش  MotiveWaveکنند. در این موارد های از سفارشات سمت سرور پشتیبانی نمیبرخی کارگزاری

 سازی خواهد کرد.( شبیهClientسمت مشتری )

9. Show Client Attach Warning – ،مشابه با بند قبلی MotiveWave  هشداری را برای یادآوری به شما در خصوص

 (.در ابتدا به سرور ارسال نشده استدهد )این که سفارشی به یک سفارش مشتری منضم شده است نمایش می

10. Create Order – شود(.شود )ولی ارسال نمیبا کلیک ماوس سفارشی ایجاد می 

11. Show Order Ticket –  اگر این گزینه را فعال کنید، پنجرهOrder Ticket  هنگام ایجاد یک سفارش نمایش داده

 خواهد شد.

12. Auto Submit –  فرض روی حالت دوبار کلیک سفارشی ایجاد و ارسال خواهد شد )به طور پیش ماوسبا کلیک

 فعال است(.

13. Price Axis Key Modifiers – سفارشاتی که از طریق محور قیمت ایجاد  توان برای تنظیم انواعبخش می این از

 شوند، استفاده کرد.می

a. Default (No Key) - دکن¬یم فیاصلاح کننده را تعر دیبدون کل، ماوس کیشده هنگام کل جادینوع سفارش ا. 

b. Shift Key - دین کلهمراه با فشردماوس  یرو کیشده هنگام کل جادینوع سفارش ا Shift کندیم نییرا تع. 

c. Ctrl Key - دیکل همراه با فشردنماوس  یرو کیشده هنگام کل جادینوع سفارش ا Ctrl کندیم نییرا تع. 
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d. Ctrl + Shift Key - های ترکیبیدیکل همراه با فشردنماوس  یرو کیشده هنگام کل جادینوع سفارش ا Ctrl 

+ Shift کندیم نییرا تع. 

 
 پیش تنظیمات سفارش -40-4شکل 

 کند:تنظیماتی برای سفارشات نمایش داده شده روی نمودار ارائه می Displayبرگه 

 
 تنظیمات نمایش سفارشات -41-4شکل 

 (DOMعمق بازار ) 4.6
MotiveWave ای¬یژگیو ( به نام عمق بازارDOMفراهم کرده است ) عرضه  ریها/مقاد متیدهد ق یکه به شما امکان م

و مجوز لازم را در  یبانیپشت، یکارگزار ایداده  سیکه سرو یبه شرط د،ینیتقاضا بب نیعرضه و بهتر نیو تقاضا را، فراتر از بهتر

ی جداگانه یا از یک پنجرهتوان به عنوان یک قاب روی نمودار، یک قاب در کنسول به عمق بازار می .دیارائه نما ریمقاد نیخصوص ا

(File -> New -> New DOM Window.دسترسی داشت )  
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 های عمق بازارپنجره و ستون -42-4شکل 

توان در پایین پنجره مشاهده کرد. ناحیه جدول است. اطلاعات موقعیت جاری را می DOMای از پنجره نمونه فوقتصویر 

 توضیحات هر ستون به شرح زیر است: قابل پیکربندی است. Preferencesشامل چندین ستون مختلف است که در پنجره 

1. P/L –  دهد. سطوح سود با نمایش میرا میزان سود و زیان حاصله از هر بازه قیمتی نسبت به موقعیت باز شده

 شوند.ها با رنگ صورتی نمایش داده میآبی روشن و زیانزمینه رنگ پس

2. Orders – دهد. سفارشات فروش در ستون چپ سفارشات فعال را نشان میOrders  و سفارشات خرید در ستون

دهد. برای تنظیم را در سمت راست نشان می Limit Sellیک سفارش  فوققرار دارند. مثال  Ordersسمت راست 

 لغو کنید. ’C‘را با ماوس جابجا کنید یا سفارش را با کلیک روی حرف  آنانید برچسب تومی Limitقیمت 

3. Bid –  نشان  نهیزمدر پس افقی ستوگرامیه کی، یراحت یبراهد. می نشانمقادیر عرضه کنونی را در هر سطح قیمتی

 .نشان دهد گرید یهامتیرا نسبت به قمقدار عرضه شود تا یداده م

4. Price – زمینه یک تیک است. آخرین قیمت پس معادل نردبان قیمت است. هر افزایش در نردبان قیمت ستون این

 زمینه زرد و سبز دارند.های بهترین عرضه و تقاضا پسدهد. قیمتآبی تیره دارد و مقدار آخرین معامله را نشان می

 رمز دارند.زمینه قزمینه آبی و کمترین قیمت روزانه پسبیشترین قیمت روزانه پس

5. Ask – رقم ،زمینهدهد. برای راحتی، یک هیستوگرام افقی در پسمقادیر تقاضا کنونی را در هر سطح قیمتی نشان می 

 دهد.می ها نمایشرا نسبت به سایر قیمت یپیشنهاد

6. Volume –  دهد. این ستون براساس معاملات در حال انجام در هر سطح قیمتی نمایش میتاریخی را عملکرد قیمت

 .خواهد شدبه روز 
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 DOMمعامله از طریق  4.6.1

DOM سازی برای فعالکند. فرض قفل است. این امر از قراردادن مستقیم معاملات در جدول جلوگیری میبه طور پیش

توان با کلیک را می Stopو  Limitکلیک کنید. سفارشات در نوار ابزار  Lock/Unlockروی دکمه  DOMگری از جدول معامله

حرکت  Bidو  Askهای قرار داد. اگر دقت کنید خواهید دید که وقتی نشانگر ماوس را روی ستون Askو  Bidهای روی ستون

 دهند:دهید تغییر شکل میمی

1. Buy Limit -  ستون  دراین نشانگرBid  زیرستون  نیدر ا یوقتشود. میظاهر بهترین قیمت عرضه  زیرو 

 .ایجاد خواهد شد Limitسفارشی از نوع  چپ شود، کیکل یعرضه جار متیق نیبالاتر از بهتر یفیرد

2. Buy Stop - ستون  درنشانگر  نیاBid  نیا در ی. وقتشود¬یمظاهر  یعرضه جار متیق نیبهتر بالایو 

 .ایجاد خواهد شد Stopاز نوع  یسفارش ،چپ شود کیکلبالاتر از بهترین قیمت عرضه جاری  یفیرد یروستون 

3. Sell Limit – ستون  درنشانگر  نیاASK  نیدر ا ی. وقتشود¬یم ظاهر یعرضه جار متیق نیبهتر یبالاو 

 خواهد شد. جادیا Limitاز نوع  یچپ شود، سفارش کیکل یعرضه جار متیق نیبالاتر از بهتر یفیرد یروستون 

4. Sell Stop - ستون  درنشانگر  نیاASK  ستون  نیدر ا ی. وقتشود¬یظاهر م یعرضه جار متیق نیبهتر زیرو

 خواهد شد. جادیا Stopاز نوع  یچپ شود، سفارش کیکل یعرضه جار متیق نیبالاتر از بهتر یفیرد زیر

 
 DOMسفارشات  – 43-4شکل 

 ترکیبات سفارش

در نوار ابزار بالای  Order Typeای متفاوت از لیست کشویی توان با انتخاب گزینهترکیبات سفارش را میسایر انواع 

خواهد ایجاد  Limitدهد. در تصویر زیر یک سفارش را نشان می Limit + Stop/Limitایجاد کرد. مثال زیر گزینه  DOMپنجره 

 شود.می الحاق آنبه  Bracketبه عنوان سفارش یک سفارش  Stop/Limitو یک سفارش  شد
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 DOMانواع سفارشات در  – 44-4شکل 

های را هنگام حرکت روی ستون LMT SLانتخاب شده است. نشانگر ماوس  Limit + Stop/Limitدر مثال زیر، گزینه 

Bid/Ask دهد. با یک کلیک چپ ماوس یک سفارش نمایش میLimit  قیمت ایجاد شده و یک سفارش  آندرStop  وLimit  بالای

 پیوست خواهد شد. آنو پایین قیمت جاری به 

 
 DOMدر پنجره  Limit + Stop/Limitقرار دادن یک سفارش  -45-4شکل 

 تنظیم سفارشات

سفارش به سمت بالا یا پایین اصلاح نمود. با دوبار  آنتوان با کشیدن برچسب را می Limitیا  Stopقیمت یک سفارش 

توانید سایر صفات سفارش مانند را به نمایش درآورد. از این پنجره می Order Ticketتوان پنجره کلیک روی برچسب سفارش، می

Time In Force  توان با کلیک روی ید. یک سفارش را میرا تغییر ده آنیا تعداد‘C’ .در سمت راست برچسب سفارش لغو نمود 
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 DOMاصلاح سفارشات از طریق -46-4شکل 

 Positionقاب  4.6.2

کند. این فراهم می راهای مدیریت دهد و گزینهاطلاعات مربوط به موقعیت جاری را نمایش می DOMقابی در پایین 

 ها به شرح زیر هستند:المان

1. Position – دهد. این گزینه به صورت قیمت ورودی ی جاری را نشان میموقعیت باز شدهquantity@average 

 Shortو رنگ قرمز موقعیت  Longزمینه آبی نشان از موقعیت شود. پس( نمایش داده میکیمیت@باشد )میانگینمی

 دارد.

2. P/L – زمینه آبی برای سود و قرمز برای زیان است.سود/زیان جاری. پس 

3. Spread – .تفاوت میان قیمت عرضه و تقاضا 

4. Account – .حساب مورد استفاده برای سفارشات موجود 

 بندد.موقعیت باز را در قیمت بازار می – Flattenدکمه  .5

 کند.لغو میهمه سفارشات فعال را برای این ابزارمالی  – Cancel Allدکمه  .6

 کند.موقعیت باز جاری را در قیمت بازار معکوس می – Reversدکمه  .7

 کند.ه خرید در قیمت باز میباقدام  DOMتعیین شده در بالای  کمیتبا استفاده از  – Buy Mktدکمه  .8

 کند.اقدام به فروش در قیمت بازار می DOMتعیین شده در بالای  کمیتبا استفاده از  – Sell Mktدکمه  .9

 
 Positionقاب  -47-4شکل 
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 متمرکز کردن 4.6.3

های عرضه و تقاضا ممکن است به سرعت تغییر کنند. در برخی موارد این مقادیر ممکن است در یک بازار فعال، قیمت

ها منتقل ثانیه خود را به مرکز قیمت 5خودکار در فواصل زمانی بالا یا پایین نردبان قیمت فعلی ظاهر شوند. نردبان قیمت به طور 

 دوباره متمرکز کنید. Re-Centerرا با کلیک روی دکمه  DOMهای توانید قیمتکند. با این حال میمی

 DOMتنظیمات  4.6.4

این پنجره فیلدهای  توان با کلیک روی آیکون چرخ دنده در نوار ابزار بالای این پنجره تغییر داد. دررا می DOMتنظیمات 

 زیر وجود دارند:

1. Rows – داده شده در جدول های نمایشتعداد ردیفDOM. 

2. Time In Force –  زمان انقضاء سفارشات قرار گرفته از طریقDOM کند.را تعیین می 

3. Show Quantity Selector –  در بالای  کمیتنمایش یا عدم نمایش نوارDOM خیلی سریع یکدهد که اجازه می 

 تنظیم شده را انتخاب کنید.از پیش کمیت

4. Show Order Ticket Window –  اگر فعال شود، پنجرهOrder Ticket  هنگام ایجاد یک سفارش ازDOM  باز

 خواهد شد.

5. Double Click to Place Order –  اگر این گزینه انتخاب شود به جای استفاده از یک تک کلیک چپ برای ایجاد

 نیاز است که دوبار کلیک انجام شود.، DOMیک سفارش از 

6. Show Grid –  نمایش خطوطی در اطراف هر سلول در جدولDOM. 

7. Show Totals –  نمایش نوار جمع کل در پایین جدولDOM. 

8. Show Entry/Exit –  های استراتژینمایش یا عدم نمایش قابEntry/Exit  در پایینDOM. 

 
 DOMتنظیمات  -48-4شکل 

های این جدول سمت راست سرستون ’+‘از دکمه  با استفاده توانرا می DOMهای نمایش داده شده در جدول ستون

 انتخاب نمود:
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 DOMها در نمایش یا عدم نمایش برخی از ستون -49-4شکل 

 ها آپشنزنجیره  4.7
. اگر کارگزار دیکن تیریدر کنسول مد 2قاب زنجیره آپشناز  دیتوان ی( را مآتیسهام و  یهانهی)گز Options 1 یهاگروه

این امکان  Option Chain قاب کرد. دیپنجره کنسول مشاهده خواه نییرا در پا “Options”کند، صفحه  یبانیپشت 3هاآپشنشما از 

. در مثال دیکن تنظیم ،را معین ءانقضا خیتار کی یبرا 4)اصابت( اعمال متیقبراساس  شده مرتب یهاآپشنتا دهد  یم را به شما

)قابل پیکربندی(  آپشن 20فرض کنید. به طور پشمشاهده می Feb 24, 2017را با تاریخ انقضاء  AAPLموجود برای  هاآپشنزیر 

برای راحتی، یک خط مشکی مکان قیمت جاری در حال معامله برای نماد هستند.  داراییشود که نزدیکترین به نمایش داده می

 هد.انتخابی را نشان می

که در مجاورت هر جفت  Buy/Sellهای توان به طور مستقیم با کلیک روی دکمهسفارشات خرید و فروش را می

Put/Call قابل مشاهده است.دول برای هر موقعیت های جاری و سود/زیان نیز روی جقرار دارند، انجام داد. موقعیت 

                                                           
1 - Stock and Future Options 

2 - Option Chain 

زمان از  کی( در یا اعمال اصابت متیمشخص )ق متیرا با ق ییفروش دارا ای دی)نه تعهد( خر دهدیم اریاست که به مالک اخت یقرارداد فرع یآپشن نوع - 3

ساخته  تیروال است شگاهیاست که در آزما یمال دهیچیبا ابزار پ یادهیبه طور معمول ا «یقرارداد فرع»( انجام دهد. اصطلاح ءانقضا خیشده )تار نییتع شیپ

خود به  یهاشنیو از پوز هدادتا درآمد کسب کنند، معاملات سوداگرانه انجام  دهندیدر بازار اجازه م درهایبه تر معاملات آپشن ،یشده است. در سطح فرد

 بازار محافظت کنند. یهادر نوسان ژهیو

4 - Strike Price 
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 هاآپشنزنجیره  -50-4شکل 

 ها آنقراردادن سفارشات و مدیریت  4.7.1

 Callیا  Putدر کنار گزینه  Sellو  Buyهای کلیک روی دکمه Stopیا  Limitآسانترین روش برای قرارداد یک سفارش 

باز خواهد شد که به شما این  Order Ticketکنید یک پنجره دارید. وقتی روی این دکمه کلیک می آناست که تمایل به معامله 

 Tim In( و زمان انقضاء )Quantity) کمیت(، Accountها مانند حساب )فرضدهد سفارش را اصلاح کنید. پیشامکان را می

Forceتنظیم نمود.توان در پایین قاب ( را می 

 
 قراردادن سفارش – آپشنزنجیره  -51-4شکل 
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را می توان با کلیک  Option Chainتوان لغو نمود. همه سفارشات باز در می ’C‘سفارشات باز را با کلیک روی دکمه 

ها در پایین توان با ستفاده از دکمهدر قسمت پایین سمت راست این قاب لغو نمود. سفارشات بازار را می Cancel Allروی دکمه 

 قرار خواهند گرفت که در جدول فوق انتخاب شده اند. Put/Callسمت چپ قاب ایجاد کرد. این سفارشات روی گزینه 

 در پایین سمت راست قاب ببندید. Flattenیک روی دکمه توانید با کلها را میهای باز دارید، این موقعیتاگر موقعیت

 
 مدیریت سفارشات – آپشنزنجیره  -52-4شکل 

 آپشن Spreadهای استراتژی 4.7.2

MotiveWave  استراتژیچندین Spread کند:معمول را پشتیبانی می 

1. Vertical 
2. Calendar 
3. Diagonal 
4. Straddle 
5. Strangle 
6. Back Ratio 
7. Synthetic 
8. Butterfly 
9. Condor 

10. Iron Condor 
11. Vertical Roll 
12. Double Diagonal 
13. Double Calendar 
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را  Spread استراتژیتوان در جدول زنجیره گزینه( می Buy/Sellهای )کلیک روی دکمهآپشن هنگام ایجاد یک سفارش 

 انتخاب نمود.

 
 Spreadهای استراتژی -53-4شکل 

 زنجیره آپشن تنظیمات 4.7.3

در قسمت بالا سمت راست تغییر  Preferencesتوان با کلیک روی آیکون چرخ دنده به نام را می آپشنزنجیره تنظیمات 

 داد. این پنجره دارای موارد زیر است:

1. Max Rows – با کلیک روی هاآپشنها برای نمایش در زنجیره حداکثر تعداد ردیف .Show All Options  همه

 های موجود نمایش داده خواهد شد.گزینه

2. Show Calls/Puts – فرض هم به طور پیشCalls  و همPuts شود. این لیست کشویی به در جدول نمایش داده می

 یا هر دو را انتخاب کنید. Putsیا  Callsدهد که شما این امکان را می

3. Table Font – کند.جدول را تنظیم می هایدر سرستون فونت و اندازه متن نمایش داده شد 

4. Show Grid – دهد.خطوط اطراف هر سلول در جدول را نمایش می 

5. Sort Descending – .مرتب سازی نزولی براساس قیمت اعمال 

6. Show Order Ticket – رش بازار پنجره هنگام قرارداد یک سفاOrder Ticket شود.نمایش داده می 

7. Show Order Panel –  دهد.برای مدیریت سفارشات نمایش می آپشنبخشی را در پایین زنجیره 

8. Show Quote Panel – Quoteدهد.ها را براساس نماد در بالای قاب نشان می 

 بندد.این تغییرات را عمال نموده و پنجره را می – Updateدکمه  .9

 روی این دکمه کلیک کنید. Call Optionsهای نمایش داده شده برای برای انتخاب ستون – Call Columnsدکمه  .10

 روی این دکمه کلیک کنید. Put Optionsهای نمایش داده شده برای برای انتخاب ستون – Put Columnsدکمه  .11
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 کند.ذخیره می هاآپشنی های زنجیرهقاب فرض برایاین تغییرات را به عنوان پیش – Save Defaultدکمه  .12

 بندد.تغییرا اعمال شده را لغو کرده و پنجره را می – Cancelدکمه  .13

 
 Option Chainپنجره تنظیمات  -54-4شکل 

تنظیم نمود )تصویر بالا(.  Put Columnsو  Call Columnsهای توان با کلیک روی دکمهرا می Putو  Callهای ستون

 Tradierهای موجود برای . پنجره زیر ستوندارد یشود بستگ یم یبانیتوسط کارگزار شما پشت که موجود به آنچه یستون ها

Brokerage دهد.را نشان می 

 
 Call/Putهای انتخاب ستون – 55-4شکل 



 

 

 

 

 

 

 

 

 

 هادسکتاپ – پنجمفصل 
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 دسکتاپ 5
Desktop تاپ در دسکآورند. های موجود در یک پنجره فراهم میها روشی آسان برای سازماندهی نمودارها و سایر قاب

. برای ایجاد یک پنجره دسکتاپ کند یصفحات استفاده م دمانیچ یبرا 1است و از همان چارچوب اتصال یگریواقع پنجره کنسول د

 را اجرا کنید. File -> New -> Desktopدستور 

 
 ایجاد یک پنجره دسکتاپ -1-5شکل 

 کلیک کنید. OKروی دکمه  آنوارد کرده و برای ایجاد  Desktopنامی منحصر به فرد برای ، New Desktopدر پنجره 

 
 پنجره ایجاد یک دسکتاپ جدید -2-5شکل 

-دهد. چیدمان پیشنشان میشود، فرض پنجره دسکتاب را، هنگامی که برای اولین بار ایجاد میتصویر زیر چیدمان پیش

 است. Charts 2و  Chartsفرض شامل دو صفحه 

                                                           
1 - Docking Framework 
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 فرضچیدمان پیش –پنجره دسکتاپ  – 3-5شکل 

کلیک  File -> Open -> Open Desktopهای موجود، در نوار منوی کنسول روی برای بازکردن یا مدیریت دسکتاپ

 کنید.

 
 های موجودبازکردن یا مدیریت دسکتاپ -4-5شکل 

در قسمت بالا سمت چپ پنجره(، گروه حذف نخواهد شد، بلکه  ’X‘بندید )با کلیک روی دکمه ی را می Desktopوقتی 

انتخاب  Manage Desktopsرا در پنجره  آنخواهید یک دسکتاپ را برای همیشه حذف کنید، در مخزن موجود است. اگر می

 کلیک کنید. Removeکرده و روی دکمه 
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 Manage Desktopsپنجره  -5-5شکل 

 Desktopتغییر چیدمان  5.1
مراجعه کنید. در واقع یک دسکتاپ پنجره  فرض تغییر چیدمان پیشبا عنوان  2.3به بخش  Desktopبرای تغییر چیدمان 

 ول است.از نوع  کنس

 



 

 

 

 

 

 

 

 

 

 هااسکنر – ششمفصل 
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 اسکنر 6
های معین فریممالی و تایمدر میان یک سری از ابزارهای 2برای جستجوی تنظیمات معامله 1اسکنری MotiveWaveدر 

 را جستجو کنید: هاآنتوانید تعبیه شده است. سه نوع الگو وجود دارد که می

1. Elliott Wave –  و موج  4و  3، 2الگوهای امواج الیوت مانند امواجE .)در یک مثلث( 

2. Gartley –  الگوهای هارمونیک شامل الگوهای نوعXABXD ،AB=CD  وAlternate AB=CD. 

3. Study Conditions – یارهای مبتنی بر مقادیر مطالعه )اندیکاتور(.مع 

مشاهده خواهید کرد. روی این  Scanای در پایین پنجره به نام صفحه ،کنیدرا باز می MotiveWaveوقتی برای اولین بار 

 برگه برای نمایش تصویر زیر کلیک کنید:

 
 Scanصفحه  -1-6شکل 

 (Gartley اسکنر) Scanایجاد یک  6.1
کنید یا این که  انتخابرا   --New Scan--را باز کرده و —Choose Scan--برای ایجاد یک اسکن جدید، منوی کشویی 

شما را در فرآیند ایجاد  شده وباز  ای. با این کار پنجرهکلیک کنیدواقع در سمت راست نوار ابزار قاب اسکنر را  New Scanدکمه 

 سکن راهنمایی خواهد کرد.یک ا

                                                           
1 - Scanner 
2 - Trade Setups 
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 اسکن جدید -2-6شکل 

دهد. نامی برای اسکن تایپ کرده و نوع اسکنر را از لیست را نشان می New Scannerپنجره تصویر زیر صفحه نخست 

 انتخاب شده است. Gartleyانتخاب کنید. در این مثال نوع اسکنر  آنکشویی زیر 

 
 ایجاد اسکنر جدید صفحه اول – تنظیمات اسکنی پنجره -3-6شکل 

 Watchانتخاب کنید. اگر  ها راWatch Listو/یا  ابزارمالیشود یک یا چند ، از شما خواسته میی بعدی پنجرهدر صفحه

List  ،ترتیب ابزارمالی و هنگام اجرای اسکن  .، در اسکن گنجانده خواهند شدآنموجود در  ابزارمالیتمام انتخاب شودWatch 

List در نظر گرفته خواهد شد. ی انتخابیها 

 
 صفحه دوم انتخاب ابزارمالی – تنظیمات اسکنپنجره  -4-6شکل 
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 ،Rangeرا کلیک کنید. هر سایز از میله خطی یا میله غیر خطی )مانند  Addبرای افزودن اندازه میله به فهرست، دکمه 

Renko شوند، تیک گری تولید میهایی که خارج از ساعات معمول معاملهتوان به فهرست افزود. برای استفاده از دادهو ... ( را می

Extended Data .در پایین پنجره را فعال کنید 

 
 انتخاب اندازه میله – تنظیمات اسکنپنجره  -5-6شکل 

محدوده  نیجستجو و همچن یرا برا Gartley ینوع الگوتوانید می Gartley الگوهای اسکنرتنظیمات صفحه آخر در 

 XABCD. اگر تمایل دارید همه اشکال الگوی دیانتخاب کن را وجود داشته باشد هادر آن است الگورا که ممکن های تاریخی داده

 را به عنوان الگو انتخاب کنید. XABCD (All)و ... ( جستجو شود گزینه  Gartley ،Bat ،Butterfly ،Shark)یعنی 

 
 Gartleyانتخاب الگوی  –پنجره تنظیمات اسکن  -6-6 شکل
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 اجرای یک اسکن 6.2
که در مراحل قبلی ایجاد شده بود و نیز نتایج حاصل از اجرای  ،’Gartley XACBD Patterns‘تصویر زیر اسکن جدید 

از لیست کشویی انتخاب را  آنخواهید این اسکن را اجرا کنید، نام دهد. اگر مینشان می، های موجودرا براساس آخرین داده آن

ه است رفت پیش اندازه چه تا اسکن که دهدمی نشان پیشرفت نوار)قسمت بالای قاب اسکنر( کلیک کنید.  Startکرده و روی دکمه 

 )بالا سمت راست قاب اسکنر(.

 
 نتایج حاصل از اسکن -7-6 شکل

 دهد:. این جدول موارد زیر را نمایش میدادد ول در قاب اسکنر نمایش خواهدر ناحیه جدرا  هاآندر صورت یافتن نتایج، 

1. Symbol – .ابزارمالی که الگوی یافته است 

2. Bar Size – .اندازه میله در الگوی یافته شده 

3. Pattern – .نام الگوی یافته شده 

4. Score –  شامل داده شدهامتیاز: Fair مناسب(، ) Good خوب(، ) Very Good  خیلی خوب( و(Excellent .)عالی( 

 های جدول کلیک کنید.برای نمایش نتایج یک اسکن در قاب نمودار واقع شده در پایین قاب اسکنر، روی ردیف

 )دکمه بالا سمت راست قاب اسکنر( کار خواهد کرد. Linkاین ویژگی فقط درصورت انتخاب دکمه  :نکته

صریحاً ذخیره  هاآننام هستند که در حافظه رایانه قرار دارند. اگر های بینتایج نمایش داده شده در جدول اسکنر تحلیل

شود، از بین خواهند رفت. وقتی یکی اندازی میدوباره راه MotiveWaveشود یا ها، دفعه بعد که اسکن اجرا مینشوند، این تحلیل

 در مخزن ذخیره کنید. Saveتحلیل را با کلیک روی دکمه  آنتوان شوند، میقاب نمودار باز میاز این نتایج در پنجره یا 
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ممکن است دریابید که الگو کاملی که پیدا شده است، هنگام نمایش در نمودار به طور کامل قابل مشاهده نیست. برای 

)بازه زمانی  یا این که اندازه بزرگتری از میله قیمت را به سمت راست بکشید آنالگو، روی محور زمان کلیک کرده و  کوچکنمایی

 را انتخاب کنید. بالاتر(

 ویرایش یک اسکن 6.3
های میله یا معیارهای انتخابی اصلاح نمود. اسکن مورد نظر را از لیست ، اندازهآنتوان یک اسکن را با تغییر ابزارمالی می

 Manage( در نوار ابزار قاب اسکن کلیک کنید. یا این که روی دکمه )مداد Editکشویی در قاب اسکن انتخاب کرده و روی دکمه 

Scans  های موجود کلیک کنید.مدیریت اسکنبرای باز شدن پنجره برای 

 
 ویرایش اسکن -8-6 شکل

باز کنید، تغییر نام داده یا حذف نمایید. اسکنی را های موجود را ایجاد کرده، توانید اسکنمی Manage Scansدر پنجره 

 های موجود در نوار ابزار عملیات مورد نظر خود را انتخاب کنید.از فهرست انتخاب کرده و با استفاده از دکمه

 
 پنجره ویرایش اسکن -9-6 شکل
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 اسکنر امواج الیوت 6.4
توانید الگوهای امواج الیوت را با انتخاب الگو از بود. در هنگام ایجاد یک اسکن جدید می Gartleyمثال بالا برای اسکنر 

 ها است.های میله همانند انواع سایر اسکننیز جستجو کنید. انتخاب ابزارمالی و اندازه Elliott Waveنوع 

 
 ساخت اسکنر جدید از نوع امواج الیوت )صفحه اول( -10-6 شکل

توانید الگوی موج الیوت را که قرار است مورد جستجو قرار گیرد انتخاب کنید. الگوهای می Specify Criteriaدر صفحه 

 شوند به شرح زیر هستند:که در حال حاضر پشتیبانی می

1.  Wave 2 –  الیوت را، هنگامی که در حال حاضر سطح بالای موج در یک موج دوم قرار این گزینه یک الگوی موج

شود، زیرا در اغلب در اکثر تنظیمات معاملاتی از موج دوم استفاده می به یاد داشته باشید که .1کنددارد جستجو می

 ترین موج خواهد بود.افتد، طولانیاتفاق می 2، که بعد از موج 3موارد موج 

2. Wave 3 – یابد.هایی که سطح بالای موج در حال حاضر در موج سه الیوت قرار دارند را میالگو 

3. Wave 4 – کند.می والگوهایی که سطح بالای موج در حال حاضر در موج چهار الیوت قرار دارند را جستج 

4. Wave 5 – یابد.الگوهایی که سطح بالای موج در حال حاضر در موج پنج الیوت قرار دارند را می 

5. Wave E (Triangle) –  الگوهایی را که سطح بالای موج در موجE کند.یک مثلث هستند را جستجو می 

. شود تجزیه کوچکتر امواج در باید بالا سطح موج پایین سطح چند که کندمی مشخص Decompose Levelsی گزینه

 رد.انتخاب این گزینه موج را به تمامی سطوح ممکن امواج الیوت تجزیه خواهد ک

ی شود. اگر گزینهاستفاده می تاریخیهای میله نیز برای تعیین محدوده دادهتعداد  Maximumو  Minimumاز تنظیمات 

Use All Available Data انتخاب شود، MotiveWave ه داده محلی را برای واکشی امواج الیوت، های موجود در پایگای دادههمه

 دهد.جستجو قرار میمورد بررسی و 

                                                           
 الیوت قرار دارند را شناسایی خواهد کرد. 2اصلی )یا فرا موج( که در فاز های زیر یک موجمنظور این است که موج - 1
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 انتخاب معیار اسکنر از نوع امواج الیوت -11-6 شکل

دهد. برای مشاهده جزئیات نتایج، روی ردیف در تصویر زیر نتایج حاصل از جستجوی الگوی موج دوم را نشان می

 اید،کرده تعیین اسکن معیارهای در که ایداده مقدار به بسته تا کنید کوچک را نمودار باشد لازم است جدول نتایج کلیک کنید. ممکن

 .ببینید کامل الگو را به طور

 
 نتایج حاصل از جستجوی موج دوم الیوت -12-6 شکل

 اسکنر مطالعه 6.5
 ایجاد جدیدی اسکن وقتی. کنید جستجو را مطالعه چند یا یک شامل مطالعه شرایط تا سازدمی قادر را شما مطالعه اسکنر

 .کنید انتخاب را مطالعه نوع ،Typeکشوی  منوی از کنید،می

 Scanایجاد یک با عنوان  6.1باشد )برای مطالعه بیشتر به های میله انتخابی همانند سایر انواع اسکن میابزارمالی و اندازه

 مراجعه کنید(. (Gartley اسکنر)



 PiroozTrader  اسکنرها –فصل ششم 

 

192 

 
 ساخت اسکنر جدید از نوع مطالعه )صفحه اول( -13-6 شکل

د. برای افزودن یک مطالعه به فهرست زیر روی را در اسکن گنجانتوان یک یا چند مطالعه ، میChoose Studiesدر قاب 

اسکن اضافه کرده ای را که قصد دارید به کنید، قادر خواهید بود مطالعهکلیک کنید. هنگامی که روی این دکمه کلیک می ’+‘دکمه 

 ویر زیر(.صارا پیکربندی نمایید، جستجو کنید )ت آنو تنظیمات 

 
 صفحه اول –اسکنر مطالعه 14-6 شکل

 
 Add Studyپنجره  -15-6 شکل
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 پیکربندی مطالعه -16-6 شکل

به اسکن  ’+‘توان با کلیک روی دکمه به اسکن اضافه شده است. سایر مطالعات را می RSI (C,14)در تصویر زیر، مطالعه 

 اضافه کرد. در مثال زیر، قصد بر این است که فقط با یک مطالعه عمل اسکن انجام شود.

 
 مطالعه افزوده شده به اسکن -17-6 شکل

شود معیارهای ارزیابی اسکن را مشخص کنید. برای افزودن شرایط به فهرست مطالعه در آخرین صفحه از شما خواسته می

 کلیک کنید. دو روش ارزیابی وجود دارد: ’+‘انتخابی، روی دکمه 

1. All – و نتیجه  گیردعمل تطبیق صورت  تا باشند برقرار باید صفحه این در شده تعریف شرایط همه روش، این در

 .(And منطقی)اجرای عملگر  است فرضپیش ،ارزیابی روش این. شودبه خروجی اسکن هدایت 

2. One or More –  در این روش، اگر فقط یکی از شرایط تعریف شده در این صفحه برقرار باشد، عمل تطبیق صورت

 .(ORتیجه به خروجی اسکن هدایت خواهد شد )اجرای عملگر منطقی و ن گرفته

3. Lookback Bars – نشانگر عدد صفر.کندمشخص می را مطالعه معیار ارزیابی و برگشت به عقب برای ،هامیله تعداد 

 .است میله جدیدترین

 
 مطالعهتعیین معیارهای  -18-6 شکل
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متغیر حاصل  آنتوانید شرایطی را مبتنی بر یک متغیر مشخص کنید که )تصویر زیر( می Study Conditionدر پنجره 

توان با مقداری مشخص یا با متغیر دیگری مقایسه نمود. فیلدهای موجود در یکی از مطالعات تعریف شده است. یک متغیر را می

 این صفحه به شرح زیر هستند:

 
 پنجره افزودن شرایط به اسکن از نوع مطالعه -19-6 شکل

1. Study –  صفحه درمطالعاتی را که Choose Studies انتخاب را هاآندهد. یکی از نشان می ،ایدکرده پیکربندی 

 .کنید

2. Bar Index – های توانید با انتخاب یک شاخص معین میلهشود، اما میدر بیشتر موارد مقایسه با میله فعلی انجام می

 را نیز انتخاب نمایید. تاریخی

3. Variable – ای یک یا چند خروجی دارد. این شود. هر مطالعهکنید، این فیلد پر میای را انتخاب میوقتی مطالعه

 مشاهده کنید.Course Data (View -> Display -> Course Data Window )توانید در قاب/پنجره متغیرها را می

4. Operator – های معتبر شود. گزینهبرای مقایسه متغیر با مقدار تعیین شده از عملگرهای این فیلد استفاده می

 Crosses)کوچکتر یا مساوی(، = )مساوی(،  <)کوچکتر از(، = <)بزرگتر یا مساوی(،  >)بزرگتر از(، = >عبارتنداز: 

 Corsses)در بالاتر از مقدار قطع شود(،  Crosses Aboveپایین یا بالای مقدار مهم نیست(،  -)مقدار قطع شود

Below .)در پایین تر از مقدار قطع شود( 

5. Relative Comparison – با متغیر  بایدمقایسه شود یا  تغیین شدهکند که آیا متغییر با مقدار این گزینه مشخص می

 مقایسه گردد.عه دیگری حاصل از مطال

6. Value –  گزینه( اگر مقایسه نسبی صورت نپذیردRelative Comparison )این فیلد حاوی مقدار  انتخاب نشود

 کنید.مشخصی خواهد بود که شما برای مقایسه با خروجی مطالعه تعیین می

دهد مطالعه و متغیر را را انتخاب کنید، پنجره فوق تغییر یافته و به شما اجازه می Relative Comparisonی اگر گزینه

جهت مقایسه انتخاب کنید. مطالعات موجود در این فیلد، همان مطالعاتی هستند که در مرحله قبلی انتخاب کرده و پیکربندی 

را  Open/High/Low/Closeمانند د که مقادیر میله قیمت، کن، این امکان را فراهم میStudyدر فیلد  Price Barاید. گزینه نموده

 EMA(C,20)به فهرست مطالعات اضافه شده است و خروجی حاصل از  EMAsبا مقادیر مورد نظر خود مقایسه کنید. در مثال زیر، دو 
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ت بزرگتر از مقدار دوم کند تا مشخص شود که آیا مقدار نخسمقایسه می)بزرگتر از(  >به وسیله عملگر  EMA(C,50)با خروجی 

 است یا خیر.

 
 مقایسه مقدار یک مطالعه با مطالعه دیگر –افزودن شرایط به اسکن از نوع مطالعه  -20-6 شکل

 RSIمقدار  آندهد. در مثال زیر دو نتیجه یافت شده است که در از اجرای این اسکن را نشان می حاصلتصویر زیر نتایج 

 است. 80بیشتر از 

 
 RSIنتایج حاصل از اجرای اسکن از نوع مطالعه -21-6 شکل

 



 

 

 

 

 

 

 

 

 

 

استراتژی  – هفتمفصل 
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 Back Testing استراتژی 7
( است. این قابلیت به شما پیشین)تاریخی های ای از آزمون داده( نوع ویژهآزمون رو به عقب) Back Testing استراتژی

. این بررسی کنیدرا و شرایط قبلی بازار  تاریخیهای زمانی در طول دوره استراتژیچگونگی عملکرد اجرای یک دهد میاجازه 

 یا مالیاحت مشکلات هرگونهآورد که را فراهم می امکاناین  ولی ،نیست بازار یآینده شرایط در شما معاملاتتضمینی بر ، آزمون

 معاملات انجام به نیاز بدون دهد کهاین توانایی را می به شما آزمون این .کنید شناسایی را بازارگذشته  شرایط برابر در پذیری آسیب

های احتمالی اصلاح نمایید. برای مطالعه بیشتر در با توجه به مشکلات و آسیب را آن و کرده ”آزمایش“ را خود استراتژی واقعی،

 به نشانی زیر مراجعه کنید: Wikipediaتوانید به صفحه این خصوص می
https://en.wikipedia.org/wiki/Backtesting 

MotiveWave  امکاناتبا استفاده از Strategy Optimizer آزمون رو به عقبای جهت پیشرفته بسیار هایگزینه 

شود. دیده می Optimizeای با نام صفحه MotiveWaveکنسول  و اولیه فرضفراهم آورده است. در چیدمان پیش هااستراتژی

 نمایش داده شود. استراتژیساز روی این برگه کلیک کنید تا صفحه بهینه

 
 در کنسول Optimizerصفحه  -1-7 شکل

 استراتژیایجاد یک تحلیل  7.1
ای خواهد اندازی پنجرهکلیک کنید )تصویر زیر(. این اقدام باعث راه New Analysisروی دکمه  Optimizeی در برگه

 راهنمایی خواهد کرد. استراتژیشد که شما را در فرآیند ایجاد یک تحلیل 

MotiveWave  کند:را پشتیبانی می استراتژیسه نوع تحلیل 

https://en.wikipedia.org/wiki/Backtesting
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1. Back Test  )خودتان را با تنظیمات مشخصی روی  استراتژی سازداین گزینه شما را قادر می -)آزمون رو به عقب

 تعیین برایتواند میله )بازه زمانی( اجرا کنید. این اقدام میمشخصی از یک مجموعه معین از ابزارمالی و اندازه 

 .باشد مفید خاص تنظیمات و گذشته های داده با شما استراتژی عملکرد چگونگی

2. Optimize به گزینه این. بود خواهد متفاوت آن پیکربندی نحوه به بسته استراتژی یک سودآوری –سازی( )بهینه 

 این مختلف ترکیبات از بسیاری و کرده مشخص خود استراتژی برای را تنظیمات از وسیعی طیف دهدمی امکان شما

 .است ”بهینه“ ترکیب کدام شود مشخص تا کنید آزمایش را تنظیمات

3. Walk Forward  )ها کافی نیست. بعضی اوقات دانش تنظیمات بهینه برای دامنه خاصی از داده –)آزمون رو به جلو

 کننده تضمین است، داشته خوبی عملکرد ی،مشخص زمانی بازه و میله اندازه برای استراتژی یک که دلیل این به فقط

 به ،بازه زمانی یک تکرار بار هردر زمان بعد از  رفتن جلو با آزمون رو به جلو .نیست آینده در آن خوب عملکرد

 .کند می کمک مشکل این کاهش

 
 صفحه اول – New Strategy Analysisپنجره  -2-7 شکل

د را وخ استراتژیتوانید دهد. از این پنجره میرا نشان می New Strategy Analysisتصویر زیر قاب نخست پنجره 

 خواهید اجرا شود را مشخص کنید.نوع تحلیلی را که می انتخاب کرده و

 استراتژیقاب تنظیمات  7.1.1

هدایت شوید. اگر نوع  استراتژیکلیک کنید تا به صفحه تنظیمات  Nextو نوع تحلیل، بر روی  استراتژیبعد از انتخاب 

 )تصویر زیر(. در مثال زیر را مشخص کنید استراتژید تنظیمات خاص این ی، فقط باکنیدانتخاب  Back Testتحلیل را 

 “MA Cross Strategy” .انتخاب شده است 
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 MA Cross Strategyتنظیمات  -3-7شکل 

 شترپنجره تنظیمات استراتژی بی یصفحه بعد کنید،انتخاب  تحلیل را به عنوان نوع Walk Forward ای Optimizeاگر 

 .دیمشخص کن یاستراتژ یکربندیپ یاز امکانات را برا یعیوس فیدهد ط یبه شما امکان ممرحله  نی. اخواهد بود ریعکس ز هیشب

MotiveWave روی  خواهد کرد. جادیا استراتژی ماتیاز تنظ اتیبیترک هایورود نیبراساس اNext .کلیک کنید 

 
 Optimize/Walk Frowardاز نوع  استراتژیتنظیمات  -4-7شکل 

 پنجره انتخاب ابزارمالی 7.1.2

ای از ابزارهای مالی )نمادها( را برای تحلیل انتخاب کنید. مجموعه دهد که مجموعهصفحه بعدی این امکان را به شما می

توانید انتخاب نمود. در ضمن می Search Instrumentیا دکمه  Add Instrumentتوان با کلیک روی دکمه خاصی از نمادها را می

 که شامل گروهی از ابزارمالی است کنید. Watch Listیک یا چند 
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 صفحه انتخاب ابزارمالی -5-7شکل 

 قاب تنظیمات داده 7.1.3

. در این قاب خواهد بود ریداده مانند ز ماتیتنظ قاب، دیانتخاب کن لیرا به عنوان نوع تحل Optimize ای Back Testاگر 

 تاریخی 1کیت یاز داده ها لیتحل یبرا دیآل، با دهیدر حالت اها را برای تحلیل مشخص کنید. دامنه دادهاندازه میله و توانید می

دهد. متأسفانه همه کارگزاران  یارائه م یواقع یایآزمون دن کی یرا برا بیتقر نیکترینزد رایز (Source Dataفیلد ) دیاستفاده کن

 ها را با استفاده ازتیک دیتوان یموارد م نیدهند. در ای( ارائه نمرا هاآن یبه اندازه کاف ایداده ها را ) نیاها، سرویس دهندگان داده ای

 .دیکن جادیا یاقهیدق 1 یهالهیم ایمنبع  یهاداده

 
 Optimizeیا  Back Testاز نوع  انتخابی استراتژیتنظیمات داده در  -6-7شکل 

 Optimize Periodهای با نام گریدو پارامتر ددر این نوع تحلیل متفاوت است.  در آزمون رو به جلو کمیداده  ماتیتنظ

در  دیکه با ییتعداد روزها) یسازنهیاندازه پنجره به Optimize Period پارامتر .باید مشخص شوند Walk Forward Periodو 

                                                           
 باشد.قیمت باز شدن، بسته شدن، بیشترین و کمترین قیمت و ... میهای داده  1
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هر  یبرا (Start Date) شروع خی، تارشدفعال با Anchor1 نهی. اگر گزکند یم نییرا تع (به جلو لحاظ شودرو هر تکرار حرکت 

حرکت  )یا Walk Forwardی شروع هر تکرار در نوع چون نقطه Anchorبا انتخاب گزینه که به این معنی ماند.  یتکرار ثابت م

در این  روز ...و  120،  90،  60 به طور مثال) ابدی یم شیافزاسازی با پیشروی به سمت جلو ( ثابت است، لذا دوره بهینهجلو رو به

 (.مثال

 
 Walk Forwardانتخابی از نوع  استراتژیتنظیمات داده در  -7-7شکل 

 قاب تنظیمات اجرا 7.1.4

تواند در محاسبه سود/زیان لحاظ شوند و ها میکند. کمیسونتنظیمات اجرا رفتار زمان اجرای تحلیل را مشخص می

توان یرا م( 2)لغزش Slippage نیهمچن( پیکربندی کرد.  Commissions-Configure <را از طریق نوار منوی کنسول ) آنتوان می

عرضه/ تقاضا  یکنون متیکم حجم ممکن است سفارشات بازار با ق یبه سفارشات بازار فعال نمود. در دوره ها ییپاسخگو یبرا

پر خواهند  ،عرضه/ تقاضا متیاز ق یسوا ،هاکیاز ت ینیدارد که سفارش با تعداد مع نیپارامتر فرض بر ا نیابا انتخاب  اپر نشوند. لذ

 شد.

                                                           
 اصطلاحاً ایجاد لنگر در یک تاریخ مشخص از زمان. - 1

در  یدقصد دار به طورمثال افتد.یاکثرا در گپ ها اتفاق م Slippage. در بازار سهام یکنون یواقع متیشده و ق ینیب شیپ متیق نیاختلاف ب -لغزش - 2

قیمت بالاتر  آندر  دیو خر شودیشما در گپ قرار گرفته و بازار بالاتر باز م دیخر متیق شود،یم جادیکه ا یبا گپ بزرگ ی، ولدیداشته باش دیخر ینیمع متیق

 .بسیار ناچیز شده و از بین برودمعامله  واردیبه ر سکیر شودباعث می و ردیگیصورت م
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 تنظیمات اجرای آزمون -8-7شکل 

 ساز قاب تنظیمات بهینه 7.1.5

 انتخاب کنید، در قاب بعدی، به عنوان آخرین صفحه، Walk Forwardیا  Optimizeاگر نوع تحلیل را 

Optimizer Settings  .را خواهید دیدMotiveWave کند:ز را پشتیبانی میسافعلاً دو نوع الگوریتم بهینه 

1. Exhaustive را برای یافتن نتیجه بهینه ارزیابی خواهد  استراتژیاین الگوریتم همه ترکیبات تنظیمات  –( 1)کامل

اگر تعداد ترکیبات به طور نسبی کم باشند، پیدا خواهد کرد.  استراتژیکرد. این الگوریتم تنظیمات بهینه را برای 

 خواهد بود.این انتخاب گزینه خوبی 

2. Genetic ( 2)ژنتیک– ( از روش انتخاب طبیعیNatural Selection برای یافتن یک ترکیب بهینه استفاده )

را ارزیابی کند. برای جزئیات بیشتر در  استراتژیکند، بدون این که بخواهد همه ترکیبات احتمالی تنظیمات می

 به نشانی زیر مراجعه کنید: Wikipediaخصوص نحوه کار این الگوریتم به دایره المعارف 

https://en.wikipedia.org/wiki/Genetic_algorithm 

 Geneticیا  Exhaustiveسازی  بهینه 7.1.5.1

 یسازهای بهینهالگوریتم هاآنترین و پرکاربردترین سازی وجود دارد. معروفبهینه هایاز الگوریتم انواع بسیار زیادی

 شما نظر مورد نتایج برای سازی بهینه نوع کدام که فهمید باید فقطسازها مزایایی دارند. کامل و ژنتیک هستند. هر دوی این بهینه

 .است تر مناسب

                                                           
باشند، زمان  ادیمسأله ز یها. اگر حالتندیگویکامل م یبه جواب را جستجو دنیرس یممکن برا یهاحالت یتمام یبررس -الگوریتم جستجوی کامل  - 1

 .خواهد بود ادیهم ز تمیالگور

و اصول  یشناسستیمانند وراثت، جهش ز یفرگشت یشناسستیز یهاکیاست که از تکن یتکامل یهاتمیاز الگور ینوع خاص - کیژنت یهاتمیالگور - 2

 .کندمیالگو استفاده  قیتطب ای ینیبشیجهت پ نهیفرمول به افتنی یبرا نیدارو یخابانت

https://en.wikipedia.org/wiki/Genetic_algorithm
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 سازی کامل بهینه  7.1.5.2

را  استراتژی های¬ورودی محتمل ترکیبات همه، 1ممکنعملکرد  مطلق راه حل بهترین یافتن جهت کامل سازیبهینه

کند. همه ترکیبات محتمل را بررسی میسازی کامل زمان بسیار زیادی را صرف خواهد کرد، زیرا اجرای یک بهینه کند.جستجو می

به طور  این الگوریتمزمان مورد نیاز برای اجرای سازی کامل زیاد هستند، های الگوریتم بهینههنگامی که تعداد پارامترها یا ورودی

 یابد.چشمگیری افزایش می

یا به  کنید،را محدود های الگوریتم توانید تعداد پارامترها یا ورودیسازی کامل، میبهینه اجرایکاهش مقدار زمان  جهت

 .کنیدسازی ژنتیک استفاده از الگوریتم بهینهسازی کامل جای بهینه

 سازی ژنتیک بهینه 7.1.5.3

 استراتژیسازی بر مفهوم تکامل زیستی یا انتخاب طبیعی است. در ارتباط با بهینهسازی ژنتیک مبتنی الگوریتم بهینه

ها، کند. از میان انتخاب شدهها آزمون را شروع میسازی ژنتیک با انتخاب تصادفی تعدادی از ترکیبات ورودیمعاملاتی، بهینه

 زمانی تا سپسمابقی ترکیبات کنار گذاشته خواهند شد. را داشته و  2شود که کدام یک از این ترکیبات بهترین پتانسیلمشخص می

با  ترکیبی به آزمون سایر نامزدهای  ،استنرسیده هاحاصل از پارامترها یا ورودی 3عملکرد حلراه (ینبهتر - -تریننزدیک) به که

 .دهدمی ادامه ”بهترین پتانسیل“

 عملکرد مطلق حل راه بهترینتواند به کند بنابراین نمیبررسی نمیسازی ژنتیک همه ترکیبات احتمالی را از آنجا که بهینه

به طور قابل توجهی کاهش  حل عملکردبهترین راه -تریننزدیکدست یابد، ولی زمانی مصرفی این الگوریتم برای دستیابی به ممکن 

 یابد.می

تواند بهترین گزینه باشد. هر چه اندازه ورودی میسازی با تعداد زیادی پارامتر یا سازی ژنتیک برای اجرای یک بهینهبهینه

سازی لازم است. اما اگر ها( بزرگتر باشد، مدت زمان بیشتری برای اتمام بهینهنمونه )تعداد ترکیبات حاصل از پارامترها یا ورودی

 ار باشد.سازی ژنتیک ممکن است از دقت کمتری برخورداندازه نمونه خیلی کوچک باشد، نتایج حاصل از بهینه

                                                           
1 - Absolute Best Possible Performance Solution 

2 - Best Potential 
3 - Close-To-Best Performance Solution 
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 سازتنظیمات بهینه -9-7 شکل

 استراتژیتحلیل  7.2
مشاهده کنید  استراتژی سازتوانید نتایج حاصله را در قسمت بهینهکنید، میرا ایجاد کرده و اجرا می استراتژیوقتی تحلیل 

ها، در بالای پنجره است. با انتخاب هر یک از نمونه ه)تصویر زیر(. تحلیل حاوی یک یا چندین نمونه اجرایی در جدول خلاص

 شود.تر حاصل از الگوریتم در جدول پایین پنجره ظاهر مینتایج جزئی

 
 استراتژیمتریک تحلیل  -10-7 شکل

 شده اجرا معاملات ازبصری  نمایش برگه ایندهد. را نشان می استراتژیتحلیل  Chartای از برگه تصویر زیر نمونه

 .دهد می نشانبراساس مثال فوق را 
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 استراتژینمودار تحلیل  -11-7 شکل

 Reportتوان در لیست کشویی قابل مشاهده است. انواع گزارشات موجود را می Reportsچندین گزارش بصری در برگه 

 یافت.

 
 استراتژیگزارشات تحلیل  -12-7 شکل

کند. هر سطر در این بندی میی و ...( گروهمعاملات را براساس دوره انتخاب شده )ساعتی، روزانه، هفتگ Periodsبرگه 

 دهد.جدول اطلاعات خلاصه را نشان می
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 استراتژیهای زمانی در تحلیل تفکیک دروه -13-7 شکل

 آندهد. یک معامله شامل ورود به معامله و زمان خروج از همه معاملاتی که رخ داده است را نشان میTradesبرگه 

 دهد تا سود/زیان حاصل از هر معامله را رصد کنید.معامله است. این برگه به شما اجازه می

 
 Tradesدر برگه  استراتژیرصد معاملات تحلی  -14-7 شکل

 دهد.همه سفارشات پر شده را نمایش می Executionsبرگه 
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 Executionsدر برگه  استراتژیتحلیل  شاهده همه سفارشات پرشده حاصل از-15-7 شکل

 



 

 

 

 

 

 

 

 

 

مالی  ابزارهای – هشتمفصل 

 سفارشی
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 مالی سفارشی ابزارهای 8
MotiveWave سه  مالی سفارشی مبتنی بر دو یا چند ابزارمالی موجود ایجاد کنید.دهد نوعی ابزارهایبه شما اجازه می

 نوع ابزارمالی سفارشی وجود دارد:

1. Spread – دهد.تفاوت میان دو ابزارمالی را نشان می 

2. Ratio – دهد یم شی، نسبت را نماگریابزار به ابزار د کی متیق میبا تقس. 

3. Index - دیکن بیشاخص ترک کیرا در  شتریب ای ابزار-2 متیدهد ق یبه شما امکان م. 

 را انتخاب کنید: File -> New -> Custom Instrumentاز نوار منوی کنسول  برای ایجاد یک ابزارمالی سفارشی

 
 منوی ابزارمالی سفارشی -1-8شکل 

ای برای ایجاد یک ابزارمالی سفارشی باز خواهد شد. نیاز است که نامی منحصر به فرد به با انتخاب منوی فوق، پنجره

(. در مطابقت داشته باشد یکاریموجود در فضا مالیابزار یک از چیبا هتواند نام نمیعنوان نماد ابزارمالی جدید وارد کنید ) این 

 رییهر تغ یرا برا مقدارحداقل  ،Minimum Tick. فیلد ( را داریمUS Dollarمثال زیر قصد ایجاد یک شاخص سفارشی )شاخص 

 کند. یمشخص م مالیابزار متیدر ق
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 صفحه اول –ایجاد یک ابزارمالی سفارشی  -2-8شکل 

. برای اطلاعات کند یم یریاندازه گ یخارج یاز ارزها یادلار را در مقابل مجموعه یارزش نسب US Dollarشاخص 

مراجعه  https://en.wikipedia.org/wiki/U.S._Dollar_Indexبه آدرس:  Wikipediaبیشتر به تعریف شاخص دلار آمریکا در 

نمود استفاده  کیوزن به هر  انتساب یبرا Exponent نهیو از گز گرفتهجفت ارز مختلف را در نظر  6 دیحالت با نیدر اکنید. 

 اید معکوس شوند(:ب GBP/USDو  EUR/USD :نکته)

1. EUR/USD –  معکوس شده( )یورو دلار( %57.6وزن( 

2. USD/JPY –  ین ژاپن( %13.6وزن( 

3. GBP/USD –  معکوس شده( )پوند انگلستان( 11.9وزن( 

4. USD/CAD –  دلار کانادا( %9.1وزن( 

5. USD/SEK –  کرونا سوئد( %4.2وزن( 

6. USD/CHF –  فرانک سوئیس( –درصد  3.6وزن( 

 شوند )دلیل این عدد را در لینک فوق بخوانید(.ضرب می 50.14381هم ضرب شده و سپس بر این مقادیر در 

 
 صفحه دوم –ویرایش ابزارمالی سفارشی  -3-8شکل 

 یورود یهامتیق یسانبه روزردهد. های شاخص سفارشی که در مثال بالا ایجاد شده است را نشان مینمودار زیر شمع

 .شودشده و در نمودار نمایش داده می شده محاسبه فیابزار تعر یکه برا یبا استفاده از فرمول زین

https://en.wikipedia.org/wiki/U.S._Dollar_Index
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 نمودار شاخص )ابزارمالی( سفارشی دلار آمریکا -4-8شکل 

 <- Configureویرایش و مدیریت نمود ) Manage Instrumentsتوان از پنجره مالی سفارشی را میابزارهای

Instrumentsسازی جدول براساس ستون کاری مرتبمالی در فضای(. آسانترین روش برای نمایش همه ابزارهایType  )صعودی(

( دوبار کلیک کنید، پنجره Customدهد )با برچسب های جدول که ابزارمالی سفارشی را نشان میاست. اگر روی یکی از ردیف

Custom Instrument Wizard دهد.باز شده و به شما امکان ویرایش ابزارمالی را می 

 
 Manage Instrumentsپنجره  -5-8شکل 

 

 پایان.
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